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Changes or modifications not expressly approved by Brother International Corporation could void the user’s authority to
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WARNING - FOR YOUR HEALTH

To Avoid repetitive motion injuries when using this keyboard, we recommend the foliow-
A ing steps. Maintain a comfortable, straight wrist position when typing. Take breaks, at

least every hour, to stretch hands and arms. Report any pain or other symptoms to your

physician.
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Getting Started

This chapter provides general information about your Color Inkjet Desktop
Publisher and its software. The topics covered are:

s Parts

* Precautions

* Setup

* Paper Feeder

* Inkjet Cartridge

« Diskettes

* Keyboard

e Operation Overview

¢ Supplemental Programs

The remaining chapters describe each of the programs available on the
Desktop Publisher. The Appendix provides clip art samples, technical data,
and troubleshooting charts. A Glossary is included that defines terms used
throughout the manual.

How to Use This Manual

Information in this column
describes helpful hints,
restrictions, and ways to avoid
difficulties.

Notes are located in the left-hand column. They provide facts that help you
use your Desktop Publisher more efficiently. An example note is located to
the left of this paragraph.

Please pay close attention to the CAUTION and WARNING notices in this
manual. They alert you to potential damage to your Desktop Publisher or
danger to yourself. The examples below show you what the CAUTION anc
WARNING notices look like.

CAUTION:
Failure to pay attention to caution notices can result in damage to the
equipment or loss of valuable data in the memory or on the diskette.

WARNING:
Warnings are for your safety. Failure to pay attention to warnin
information can be dangerous to you and others.
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Parts of Your Desktop Publisher

Model DP-540CJ & DP-550CJ

Latch

LCD contrast control

Modem connector

DC connector

Sub-paper supporter
LCD screen

Paper supporter

Keyboard

Diskette eject button

Disk drive
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Model DP-530CJ

Top cover
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DC plug

DC connector

Sub-paper supporter

LCD screen

Paper supporter

LCD contrast control
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Diskette eject button

Disk drive
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Model DP-5040CJ

Top cover

8
g
c
3
;
=

Monitor connector

Power switch

DC connector

DC plug

Sub-paper supporter

Paper supporter

3
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=
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.
(=]
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Keyboard

Diskette eject button

Disk drive
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Monitor (model DP-5040CJ only)

Power cord
Contrast control Power light
Brightness control . Monitor stand
Power switch Signal cable
Optional Modem (all models)
Data cable

Data cable

Modem telephone cord

Modem telephone cord
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Precautions

WARNING:

Do not try to take apart or repair this equipment yourself. Service

should be performed by authorized Brother service personnel only.
“ Warranty will be voided if you take the unit apart.

WARNING:

If the glass screen appears to be cracked, do not touch it. You may cut
yourself, Carefully wrap the unit in its box and take it to authorized
Brother service personnel only.

CAUTION:

Do not pull on the power cord. To disconnect it, always grasp the
plug itseif.

Avoid direct exposure of the equipment to sunlight and other
sources of heat, excessive moisture, or dust.

If you spill any liquid onto the equipment, immediately unplug the
system and consult authorized Brother service personnel only.

Do not use sprays in the vicinity of the Desktop Publisher.
Aerosols are extremely harmful to the disk drive.

Unplug the equipment during a thunderstorm.
Do not place heavy objects on the keyboard.

Keep the back and sides clear of obstructions to prevent
overheating.

Use only a soft, dry cloth to clean the equipment (do not use
chemicals, solvents, or detergents).

To avoid electrical interference, do not place the Desktop
Publisher close to a radio receiver or television. If the Desktop
Publisher is close to a television, the disk drive may not work
properly. For the same reason, avoid placing the monitor too
close to the Desktop Publisher.

If you turn the Desktop Publisher off, wait at least 10 seconds
before turning it on again. Failure to wait 10 seconds may disrupt
the start-up sequence, resulting in faulty operation and possible
hardware damage.

Do not turn the Desktop Publisher off while printing.

Do not touch any metal parts inside the printer unit. These parts
becomes hot in the printing process.

Make sure the inkjet cartridge (under the top cover) has moved
back to its leftmost position before you turn the power off. If you
notice that the cartridge has not moved to its leftmost position,
turn the power on again and let the cartridge move to the correct
position. Then turn the power off.
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Setup

* After installing the inkjet cartridge in the Desktop Publisher,
never move the inkjet cartridge from side-to-side with your

hands.

* Close the LCD cover gently until you hear the click when
transporting or storing the machine.

WARNING:
Do not plug your Desktop Publisher into an electrical outlet until you

have completely assembled it.

WARNING:
To prevent pinched fingers, keep fingers away from both bottom and

sides of the LCD screen when you change your screen’s viewing angle.

p-To connect the equipment (models DP-530CJ, DP-540CJ,
DP-550CJ):

1. Pull the cover latch toward you, and lift the screen display to open.

2. Connect the DC plug into the DC connector.

N

N\ =

Power switch

DC connector

DC plug
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Plug the AC adapter into an electrical outlet.

Press the power switch on the left rear side of the Desktop Publisher
to turn it on. If the Desktop Publisher does not respond, check the
AC adapter.

For the DP-530C] model, use the control on the right side of the LCD
screen to adjust screen contrast until the characters on the screen are
easy to read.

For the DP-540C] and DP-550C] models, use the control on the left
side of the machine to adjust the screen contrast until the characters
on the screen are easy to read.

If you do not press any key for five minutes, the screen changes to a
“screen saver” to protect the screen. Press any key to remove the
screen saver. To return to the previous screen, press SHIFT or CODE.

Attaching the Monitor Stand (model DP-5040CJ only)

WARNING:

Do not try to take apart or repair this equipment yourself. Service
should be performed by authorized Brother service personnel only.
Warranty will be voided if you take the unit apart.

-«

Before making electrical connections, attach the monitor stand to the
monitor as shown below.

p-To attach the monitor stand to the monitor:

1.
2.

4.

Carefully set the monitor on its side as shown below.

Align the hooks on the monitor stand with the matching slots in the
base of the monitor.

Slide the monitor stand toward the front of the monitor until the
stand clicks into the locked position.

Set the monitor on its stand.

You can now tilt and rotate the monitor.

(T

34—'-5|T"""'7T

i) o)D

O

11~__——-/

~—9Y Il
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Connecting the Equipment (model DP-5040CJ only)

CAUTION:

Before plugging the Desktop Publisher or monitor into an
electrical outlet, connect the monitor and the modem to the
Desktop Publisher.

CAUTION:

To prevent damage to the monitor, turn off the monitor when you
‘are not using the Desktop Publisher.

Connecting the monitor

pTo connect the monitor:

1. Push the monitor signal cable connector into the monitor connector.
The monitor connector is located on the left side of the Desktop
Publisher,

2. Tighten the monitor signal cable connector’s screws into the monitor
connector to secure the monitor signal cable.

— & P To connect the power:

1. Connect the DC plug into the DC connector.

2. Plug the monitor power cord and the AC adapter power cord into an
electrical outlet.

3. Press the power switch to turn on the monitor. If the power light
does not glow, check the power cord.

4. Press the power switch located on the left side of the Desktop
Publisher to turn it on. If the system does not respond, check the AC

—_ : adapter.

5. Adjust the screen brightness and contrast with the control knobs on
the front of the monitor until the characters on the screen are easy to
read. If you do not press any key for five minutes, the screen changes

You can reverse the display from to a “screen saver” to prolect the screen. Press any key to remove the
white to black and black screen saver. To return to the previous screen, press SHIFT or CODE.
to white by pressing
CODE + SHIFT +R.
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Connecting the Optional Modem

CAUTION:
Before plugging the Desktop Publisher into an electrical outlet,

connect the modem to the Desktop Publisher.

pTo connect the optional modem:
1. Push the modem data cable into the modem connector and tighten
the screws.

Forvmodels without monitor: o0 ‘ For model DP-5040CJ:

A oy

Fam

Modem connector
: ( ~—

S~

Aﬁeﬁmr
L

2. Insert one end of the modem telephone cord into the auxiliary socket
of a telephone or into a telephone outlet. Insert the other end into

the socket on the modem.

Monitor connector
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Paper Feeder

If you use the trasparency or
iron-on transfar paper in high
temperature or high humidity
conditions, place a regular sheet
of paper on the back surface of
the transparency or iron-on
transfer paper before loading
them into the paper feeder.

A paper feeder is built into your Desktop Publisher. The paper feeder

allows you to load up to 30 sheets of letter or A4-size paper for automatic
feeding.

p-To set up the paper feeder:

1. Flip open the paper support on the back of the machine and pull up
the sub paper support.

2. Pull the paper release lever on the left side of the printer toward you
as shown above. To print thick (24 lbs.) paper, labels, transparency,
iron-on transfer paper, or envelopes, pull the lever on the right side
of the printer toward you as shown below:

3. Pick up no more than 30 sheets of letter or A4-size paper.
4. Fan the paper before loading as shown in the illustration on the left.
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5. Load the paper into the paper feeder.

Paper recommendations: 6. Align the paper with the right tab and slide the left tab over until it

high quality bond, 16-24 Ib.
Paper does not feed properly if touches the edge of the paper.

there is too much paper in the
paper support.,

Do not exceed the 30-sheet
limit of letter or A4 paper, or the
5-set limit of COM10 or DL
envelops.

Avoid using glossy or sfick
paper and envelops with a
sticky %eal in the paper support,
because it can cause paper
jams.

Up to 15 printed sheets can be
stacked in the machine.
Remove all paper from the
machine when you reset the
paper. A

Use only ons type of paper at
a time.

7. Tap the left and top edges of the paper stack to align the edges.
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Up to 10 sheets of letter- or
Ad-size paper,orup to 5
envelops, can be stacked in the
paper tray.

Pult the sheets toward you as
shown below until the edge of the
paper exits the machine
completely.

Be sure to store the handle firmly
in its ofiginal position while
printing. Otherwise, the handle
will obstruct the path of the paper
and cause it to jam.

8. Push back on the paper release lever (on the left side of the paper
feeder) to hold paper tightly against the rollers.

9. The paper exits from under the keyboard when printing is

completed.

If you use small paper or envelopes, lift up the machine gendy and

pick up the paper.

o/
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If the paper is jammed in the machine, remove the paper from the
paper support (after pulling the paper support lever toward you), or
open the top cover and remove the jammed paper. If it is still
difficult to remove, open the paper tray as shown below:

P To eject paper from the paper feeder:

Press CODE + SHIFT + HELP. The paper ejects from the front of the
Desktop Publisber.

About Landscape Printing

This machine has landscape printing capability. Select Letter or A4
Landscape in the Page Setup mode (see page 57) when you wish to print
the information in this way. The machine automatically switches from
Portrait to Landscape mode and back again according to the Page Setup
settings.
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Inkjet Cartridge

4

Use only Brother inkjet
cartridges.

Use a black cartridge for black
text and save the color cartridge
for color printing only. The
system delects whether you are
using black or color ink; you do
not need to change any setling
when you change cartridges.

WARNING:
Keep used and new inkjet cartridges out of reach of children. Avoid
contact between cartridge and face, eyes, skin, and clothing.

Your Desktop Publisher uses a replaceable inkjet cartridge that contains
both the print head and ink. Replace the cartridge after approximately
1,000,000 characters (estimate based on using normal text in 12 point,
Brougham font with monochrome printhead).

Follow these precautions to ensure maximum life of your inkjet cartridge:

To prevent a cartridge from drying out, never open the sealed pack

~until you are ready to install the cartridge.

Install the cartridge immediately after you remove the tape from it. If
you set the cartridge aside for an extended period, the cartridge head
may dry out.

The head of the cartridge is covered with wet ink. Never touch the head
of the cartridge and never let it touch any other surface.

Store the used inkjet cartridge in the cartridge holder to prevent drying.

To prevent leakage from the print head, do not shake the cartridge after
it has been removed from its pack.

Store the new inkjet cartridge in the same environment as the Desktop
Publisher.

Do not expose cartridges to direct sunlight. Store them at a temperature
lower than 40° C (104° F).

To transport the Desktop Publisher by air, take out the inkjet cartridge
and install a new one at your destination.

To move the unit, handle it carefully. Do not jar or turn it sideways with
an inkjet cartridge in place.

We recommend that you use cartridges within one year of installation to
assure high print quality.
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Installing/Replacing an Inkjet Cartridge

In this section, you will learn how to install an inkjet cartridge and replace
a used one.

P-To install the first inkjet cartridge:

When you set up your Desktop 1. Turn the Desktop Publisher on.

Publisher for the first time, you

need to install the inkjet 2. Press CODE+ INK CHG . The inkjet cartridge bracket moves to its ink
cartridge. change position (right side). Do not move the cartridge bracket

manually from side-to-side. 7his message appears:

Proceed to change the ink cartridge.

After changing the ink cartridge, press RETURM.

3. Pull the LCD screen display forward (models DP-530C]J, DP-540C],
and DP-550CJ).

Place the print head firmly in the
cartridge (as shown on the next
page) to prevent the ink from
drying out. Dust can also get
inside the cartridge and cause
damage if the print head is not
placed securely in the cariridge.

You have 5 minutes to install or
change the inkjet cartridge before
the bracket automatically retumns
to the left-hand position.

5. Tear open the inkjet cartridge pack and remove the new cartridge.

6. Carefully remove the protection tape from the print head before
installing. Do not shake the inkjet cartridge after the protection tape
is removed. Do not remove the metal contacts from the cartridge.

Protection tape
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f;zl;; ngt ;‘g nl;’; :”:"; ﬁ’fzﬂ head 7. Slide the ink cartridge into the inkjet cartridge bracket so that the
cartridge, lettering is upside down.

You will not be able to print if the

wilf nc 8. Squeeze the inkjet cartridge bracket and cartridge together until the
cartridge is not correctly locked.

cartridge snaps under the latch on the bracket.

9. Close the top cover.

10. Close the top cover and lift the LCD screen to normal position.
(models DP-530C], DP-540CJ, DP-550C])

11. Lift the LCD screen to normal position.
12. Press RETURN . The inkjet cartridge is ready to use.

P To replace a used inkjet cartridge:

1. Press CODE+ INK CHG . The cartridge moves to the right, which is the

ink change position. Do not move the cartridge manually from
side-to-side. This message appears:

Proceed to change the ink cartridge.

After changing the ink cartridge, press RETURN.
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You have 5 minutes to install or 2. For models DP-530C], DP-540C], and DP-550C], pull the LCD

change the inkjet cartridge before :
the bracket automatically returns display forward.
fo the right-hand position.

3. Open the top cover.

4. Grasp the inkjet cartridge as shown below and push backward (1).
Then pull the cartridge straight up (2). To avoid getting ink on
your hands, do not touch the bottom of the cartridge.

To protect the head from dust or
from drying out, squeeze the
inkjet cartridge unti! you hear a
click.

5. Dispose of the old cartridge immediately, or store it in the cartridge

holder as shown on left.
6. Tear open the inkjet cartridge package and remove the new cartridge.
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7. Care.fully remove the protective tape before installing. Do not shake
the inkjet cartridge after the protective tape is removed. Do not
remove the metal contacts from the cartridge.

8. Slide the inkjet cartridge into the cartridge bracket.

Protective tape
You will not be abie to print if the 9. Squeeze the inkjet cartridge bracket and cartridge together until the
cartridge Is not correctly lockea. cartridge snaps under the latch on the bracket.

10. Close the top cover.
11. For models DP-530C], DP-540CJ, and DP-550C], lift the LCD screen
back into place.

12. Press RETURN. The inkjet cartridge is ready to use.
Cleaning the Print Head

From time to time, you may need to clean the print head. You should
clean the print head when

e the ink on the page looks splotchy or messy.
* blank spaces appear on the page.

To clean the print head automatically, press CODE + SHIFT + INK CHG . The
cartridge moves stightly to the right and then back to the left.
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If print quality does not improve
after cleaning the print head,
please remove the inkjet
carttidge and install it again, If
print quality is stilf not good, the
problem may be caused by dried
ink on the nozzles, contacts, or
the print cartridge bracket
contacts.

Do not use a paper towel for
cleaning because it can leave
tiny fibers that clog nozzles and
cover contacts.

Do not use a paper towel for
cleaning because it can leave
tiny fibers that clog nozzies and
cover contacts.

p-To clean the print nozzles and contacts:
1. Remove the inkjet cartridge. (See instructions on page 17)

2. Gently clean the entire copper-colored area, including the nozzles
and contacts with a clean cloth, dampened with water only.

To dissolve any dried ink, hold the damp cloth against the nozzles for

about three seconds. Gently blot and wipe dry.
3. Allow the copper-colored area to dry.
4. Reinstall the inkjet cartridge and press RETURN . Then press CODE +
SHIFT + INK CHG and close the cover.

If the Desktop Publisher is still not printing correctly, clean the
bracket contacts in the printer.

p-To clean the bracket contacts in the printer:

1. Press CODE + INK CHG to move the inkjet cartridge bracket to the
right side of the printer unit.

2. Without turning the Desktop Publisher off, unplug the DC plug from

the DC connector on the left side of the Desktop Publisher. (This
keeps the inkjet cartridge in the right-hand position.)

3. Turn the power switch off.

4. Remove the inkjet cartridge. (See page 17.)

5. Use a clean, dry cloth to clean the contacts on the inside of the inkjet

cartridge bracket.

Bracket contacts for A
the inkjet cartridge

6. Install the inkjet cartridge.
7. Plug the DC plug into the DC connector on the left side of the
Desktop Publisher.

8. Turn the power switch on.

9. Press CODE + SHIFT + INK CHG
If print quality does not improve after this cleaning process, replace the
inkjet cartridge. If print quality still does not improve, your printer may
require service. Contact your local authorized Brother service personnel
only.
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Diskettes

shutter Your Desktop Publisher uses both MF-2HD (High Density) and MF-2DD
(Double Sided/Double Density) diskettes. The MF-2DD have half the
capacity of the MF-2HD. We recommend that you use Brother diskettes.

The slightest damage, such as a scratch or a small amount of dust on a
diskette, can easily spoil an entire file and make it unreadable. The
protective case of the 3.5 inch diskettes prevents, to some extent, damage
to the sensitive diskette surface. (The metallic shutter automatically opens
and exposes this sensitive surface only when the diskette is inserted into
the drive.) However, additional precautions must be taken to ensure
reliable maintenance of your files.

& 0

CAUTION:
» Never open the shutter of the diskette.

+ Never touch the surface of the material inside of the diskette.

« Do not use magnetic materials near the diskette.

B>

+ Never expose the diskette to extremely high or low temperatures.

Inserting and Removing a Diskette

CAUTION:
Never remove a diskette while a screen message or the LED

indicates that a disk operation is in progress.
To insert a diskette: Insert the diskette as shown in the illustration below.
If you insert it the wrong way, you will feel some resistance.

%

To remove a diskette: Press the eject button,

>

>

Insert
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Initializing (Formatting) New Diskettes

CAUTION:
Initializing a diskette erases all information on it.

Diskettes must be formatted before they can be used. Some diskettes are
already formatted as IBM compatible when you buy them. However, if you
buy unformatted diskettes, your Desktop Publisher can format them to be
IBM compatible. The diskettes you use on a Desktop Publisher can also be
used on a personal computer. This Desktop Publisher can read and write
diskettes formatted on a personal computer in the DOS 1.44 Mb
(megabyte) format and the DOS 720 kb (kilobyte) format.

When you insert a diskette and try to save a file on it, the Desktop
Publisher checks the format of the diskette. An error message tells you
what to do if the diskette matches any of the following conditions:

* The diskette is unformatted (new).

* The diskette is formatted, but not with an M5-DOS-compatible format.

P To initialize a diskette:
1. Insert a diskette into the disk drive.

2. Create your document and press MENU to show the menu bar;
choose Save File from the File menu. 7his message appears:

Unformatted or damaged disk!
Do you want to initialize disk?
All data on disk will be deleted if initialized.

Iize

L cursol to select and press RETILIRDP.
[¥ ES] R

3. Select YES to initialize or NO to exit; press RETURN . If you select
YES, this dialog box appears:

<< FORMAT TYPE >>

SHEI Cris
2D0 DISK 720KB

Use cursor lo select and press RETURRNL

4. Select the type of format that matches the diskette and press RETURN
to initialize the diskette. This dialog box appears:

< < INITIALIZE DISK > >

FORMAT TYPE: 1.44MB
INITIALIZED %:

Y 50 100
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Write-Protecting Your Diskettes

All 3.5 inch diskettes have a switch that protects their contents from
accidental erasure. When the switch is in the READ ONLY position, you
cannot erase old information or store new information on the diskette.
Slide the switch to the READ ONLY position to protect a diskette
Ny <, containing valuable information. (The switch is in the READ ONLY position
<, when it leaves a hole in the diskette cover that you can see through.) You
can slide the switch back to the WRITE position when you want to change
files or add new files to it.

.."((.,

Write/Read

If you have a diskette in the READ ONLY position, this dialog box appears:

Write protected dish!
Realease the protection or insert another disk and retry.

se cursor to salect and press RETURNL

[FRETE]) [CANCEL]

Backing Up a Diskette

The best insurance against losing important information is to make
backups (duplicate copies) of important files. To learn how to make
backups, see Making 2 Backup Copy of a Diskette on page 143.
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Keyboard

Your keyboard contains both the character keys of a standard typewriter
and special function keys. Many keys also have second or third functions
that can be accessed when you press the key combined with another key.
The plus sign (+) is used with key names to show these key combinations
in instructions. When you see these key combinations, press and hold
down SHIFT or CODE; then press the second key. For example, SHIFT + A
means to press and hold down SHIFT, and then press A.

Character Keys and Arrow Keys

The character keys are the keys found on the standard keyboard, and the
arrow keys are the keys for moving around in your text.

[ — )
%ﬁ 9{)0' - M

[

(=} ol P EI] + [
+ ]

>

H [+ x2JL =] I

N M , .Y 2 (OK suier

L3
>,

)

The character keys and some
function keys automatically
repeat if you hold the key down.
This is useful when you want to

“

type something like “~———— 3

Pressing SHIFT when in the
Caps Lock mode alternates
between SHIFT LOCK and Caps
Lock.

Letter keys. Pressing the key alone gives the appropriate lowercase letter.
Pressing the same key while holding SHIFT down gives the appropriate
capital letter (SHIFT + A = “A™).

Other character keys. Pressing the key alone gives the character
indicated on the middle of the key (1 = “1”). Pressing the same key while
holding down SHIFT gives the character indicated on the upper-left corner
of the key (SHIFT + 1 =*!").

Special characters. Characters indicated in green on some keys can be
obtained by pressing CODE + the key (for example, CODE + W = “<”),

Shift Lock mode. You can type capitals and the special characters above
the number keys without holding down SHIFT. If you press SHIFT LOCK,
the SHIFT indicator is highlighted at the right of your screen. Now all the
characters you type are uppercase, or the special characters above the
number keys appear (A = “A,” 1 = “1"). To release this mode, press SHIFT.

Caps Lock mode. When you want to type only capital letters and numbers
like “ACCT. NO. BC104,” press CODE + CAPS. The SHIFT indicator at the top
of the screen changes to CAPS (highlighted). Caps Lock mode turns on so
that you enter only capital letters. To release this mode, press CODE + CAPS
again.
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Keypad Keys

Arrow keys. Pressing T, {, «, and — allows you to move the text cursor
one position in the direction of the arrow on the key.

These keys can be used like a calculator keypad when the Numeric Lock

mode is active.
*
HE HD fo e I I I l
NUM-L] CALC INK CH

vlal] 1 (5]} ofs]J P [
J kLB : ™
3 RETURN
M[D BY'0
a U

[

Function Keys

Numeric Lock mode. When you need to type numbers only, press CODE
+ NUM-L to lock the keyboard in the number mode. The NUM indicator at
the top of the screen is highlighted.

When the NUM indicator is highlighted, you can type the characters in the
black boxes on the keys. (See illustration above.)

To release the Numeric Lock mode, press CODE + NUM-L again.

In addition to the normal character keys of a standard typewriter, your
keyboard features a number of function keys.

TAB
PIND

TSTYLER FONT A COLOR)SYMBO[ E CHA NUM-L L CALC NK CI

CANCEL] MENU | HELP
PCLIP | CCLIP_AP BREA

o]

Illlljﬁfolflj I fI 1J

=l

DELETVE JWORD QU
LINE OUT,

RETURN . This is the “action” key. When selecting from a menu or
answering a question from the Desktop Publisher, pressing RETURN
allows you to continue.

CANCEL. This is the “exit” key. When selecting from a menu or answering
a question from the Desktop Publisher, pressing CANCEL allows you to
return to the previous step. Each time you find yourself in the middle of an
operation you want to stop, press CANCEL.
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MENU. This key allows you to see the menu bar at the top of the screen.
Once it appears, select the function you want to start.

CODE. You can use functions labeled in green on the keyboard by
pressing CODE. To start these functions, hold down CODE and then press
the function key.

Most of the character keys on your keyboard can start a function when
pressed together with CODE. For example, when you press CODE + G, the
GO TO function is turned on. GO TO is printed in green at the bottom of
the key.

Many functions, however, are not indicated with green letters. For
example, CODE + J turns the Justify function on and off in the Word
Processing program. Pressing CODE + HELP gives you a list of these
short-cut functions and an explanation of function keys.

Most noncharacter keys have two names: the upper name indicates the
function that starts when you press the key alone, and the lower one
indicates the function that starts when you press the key together with
CODE (example: HELP and CODE + P BREAK).

Selecting Programs

Main Menu

When you turn on the Desktop Publisher modet DP-530(], this Main
Menu appears:

Addressbook

<5 1

Drawing g:g“"g

Application

When you turn on the Desktop Publisher model DP-540C], DP-550C], or
DP-5040C], this Main Menu appears:

‘ MAIN MEN

f Processing

il Auto Latler
i L ayout
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Program description

Starting a program

Function Menus

A short description of the different programs you can start from the Main
Menu follows:

Word Processing. Creates and edits documents, complete with tables and
graphics.

Spreadsheet. Creates and edits numeric tables and makes automatic
calculations.

Addressbook. Creates and edits lists, such as addresses and phone
numbers.

File Management. Organizes files on a diskette.

Disk Application. Starts additional programs that come with your Desktop
Publisher.

Drawing. Allows you to create many types of images composed of one or
more objects.

Greeting Card. Allows you to create many types of greeting cards.

Communication. With the optional modem, obtains access to commercial
data bases and electronic mail services.

Auto Letter Layout (DP-540C], DP-550C], and DP-5040C] only). Allows
you to automatically select a format for your business or personal letters.

Desktop Reference (DP-540C], DP-550C], and DP-5040CJ only).
Provides information about words (spelling, hyphenation, synonyms, and
jumble) and maintains our user dictionary.

There are two ways to start a program. Use the method you find most
comfortable.

Press the number key on the icon (1 for Word Processing, etc.).

OR

1. Press the arrow keys (¢, —, T, and ~L) to move to a program icon.
2. Press RETURN to start the program. The program menu appears.

All functions in the programs are found in menus. Press MENU to show the
menu bar at the top of the screen; then select a function to start it.

Accelerator keys. Each item of the menu has a single underlined
character. You can select items from the menu faster by pressing the
corresponding letter on the keyboard.
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Dual Display

Clip Board

Help Windows

Self Demo

Short-cut keys. With many functions, you can use short-cut keys. For
example, the short-cut keys for the Justify function are CODE + J. The
menu bar does not appear, but the justification function becomes active
immediately. The HELP screen gives the list of short-cut keys that can be
used in each mode.

While creating or editing a file in Word Processing, Addressbook, or
Spreadsheet, you can open another Word Processing, Addressbook, or
Spreadsheet file and work simultaneously on both files, even if the files do
not belong to the same program.

For example, while working on a Word Processing file, you can open a
Spreadsheet file and start working on it. For more information, see Open
File for Dual on page 40.

The clip board allows you to store a portion of a file temporarily and paste
(copy) it to a different location in the same or another file. If the clipped
data is inserted into a different program, the data automatically converts to
fit in the target file. For more information, see Clip Board on page 234.

Press HELP and a HELP dialog box lists short-cut keys available at that
time. After getting your information, press CANCEL to close the HELP
dialog box.

Press CODE + D to see and print out the main features of your Desktop
Publisher.
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Supplemental Programs

Conversion

Tutorial

Graphic Art Print

Frame Print

Games

Programs compatible with this system come on diskettes and can be
started by selecting the Disk Application icon on the Main Menu. The
programs on diskette that come with your Desktop Publisher are listed
below.

This program allows you to convert documents between different word
processing formats and your Desktop Publisher format. For more
information, see Conversion in the Appendix.

This program teaches you how to use Word Processing.

We recommend you look at these programs before you start using Word
Processing. See the next page for a sample of a document created with the
tutorial. For best results, refer to this sample document as you go through
the tutorial. To start the tutorial, see To use the Tutorial on page 160.

This program allows you to print black and white graphic art images and
color graphic art images. For more information, see Using Graphic Art Print
on page 155.

This program allows you to print various frames. For more information, see
To Print a Frame on page 158.

‘Two games are available for the Desktop Publisher. They are Blackjack
and Poker. For more information, see page 161.
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This page contains a sample document created with the tutorial program.
For best results in creating this sample, refer to this page as you go
through the tutorial.

Ml
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Published by The Springfield Homeowners Association

Springfield Welcomes Fred & Leslie Tanner

As you may have heard, the
Taylor house at 117 Elm has finally
been sold!

QOur new neighbors, Fred and
Leslie Tanner, said they fell in love
with the Taylor house the moment

Leslie, who studied intedior
design, hopes to start a small
consulfing practice out of her home
and offer her services (o local
residents and businesses.

Hex first project will be to tum the

By Amanda Becker

Jenny, who studied ballet and tap,
plans to try out for the cheerleading
squad. Craig, who won "Best Pre-
Teen Player” at the All Counly
Tennis Tournament, plans to try out
for the Springfield Elementary tennis

they saw it. family room of her home into a tearn.

Fred i3 an Executive Vice- combination sunroom/office. In Needless to say, we're sure the
President at Alliance Electronics in fact, she was already over to Drake's Tanners will be a welcome asset to
Middletown. Because he played Lumber Yard to order new windows our community.
college basketball, he plans to get and fixtures, For those of you who haven't met
involved with our high school team, Their two children, Jenny and them yet, be sure to keep Sunday,
the Springfield Sabers. Befter not let Craig, will be attending Springfield May 29th, open for the annual "Say
Coach Wilson hear about that! elementary starting this fall. Hello To Summer” barbecue.
Springfield Taxes Lowest In County
For Third Year In A Row By Don Addison
Every titne we step into a supermarket or department siore, it seems
as if the pnce of everything is always going up. TAX mucglsnPARAﬂ\aE ANALYSIS

Fortunately, the same can't be said of our property taxes which 10000
have remained the county's lowest for three years in a row.

Usually, low property taxes are accompanied by reductions in boao

municipal services like police, fire and garbage disposal. But thanks 0000
to the ingenuity of Mayor Joseéph Ash and the city council, our evel
of municipal services has actually increased over the last few years,

"It's a result of all of us working together to maintain the high 2000 4
quality of life that Springfield residents have come to expect.

Members of our municipal organizations are ail Springfield residents
and realize that they are an important part of Springfield's big

picture”, said Mayor Ash.

Sprrgfeld. Spring Glen Woodbridge  Delton
rax

TOWNSHP NAME

Mayor Ash continued by saying that a large part of the thanks also should go to our varicus committees and councils
for their initiative in creating money-raising events.
One particular case that came to mind was the library committee which raised over $25.000 in their annual *Cycle-

Thon™. As most of you probably remember, the "Cycle-Thon" took place last fall and had over 300 participants, each
with their own "Dollar-A-Milc" sponsor. Because all administrative and promotional costs were donated, all the monies
raised werse able to go directly to our library.

"Thanks to events like this, we are able to maintain our high level of services without having to increase taxes on our
residents”, concluded Mayor Ash.
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1 Word Processi ng

With Word Processing, you can create many documents, from business and personal letters to
student papers, newsletters, and fliers. Besides having a wide variety of basic features, Word
Processing includes some advanced features also, such as double column pnntmg, merge printing,
and dual-screen viewing (you see two files on the screen).

You may create your own Word
Processing file or use one
afready made for you. For details,
see To Open a Template File on
page 240.

If you see a message indicating
you have an unformatfed or
damaged diskette, replace the
diskette with another, or go lo
page 22 in Getting Started for
instructions on how to initialize a
diskette.

Remember that you can press
HELF to get on-screen help.

The particular version of Deskiop
Publisher you are using may not
have all the functions listed on
the Help Menu screen.

p-To create a new file:
1. From the Main Menu, press 1.

\ [F9

Spread-
AW

Addrm- \

[

HHENTEXT

2. Select *NEWTEXT by pressing RETURN. (Later, you will use the
arrow keys to select a file from the list of files and then press
RETURN.) The Input/Edit screen shown on the next page appears.

P To edit an existing file:
1. Insert the diskette with the file into the disk drive.
2. Press 1.

3. Use the arrow keys to select the file you want; press RETURN. 7he
Input/Edit screen shown on the next page appears.

pTo use the Help Menu:

Press the HELP key in the upper right-hand corner of the keyboard to see
the keyboard shortcuts and function explanations for each program. Press
CANCEL to remove the Help Menu from the screen,

[ 1 #NEWTEXT ]Hel |12 algu{l géjgjgahai-‘@j C{ HELP 77

by - Cr.ee B sl Zen b eaFde it | yord Processing files are craated, edited,
stor.d and erinted in the Word Processing
b slnn'r cuts »
CODE +
DENTERI CODE +

ANGE S\.REEN

DELETE
JUSTIFY:
MERGE CODE!

MOVE : hols}
RIGHT MARGIN FLUSH: CODE +
SOFT HYPHEN: CODE +
LINDERL INE ¢ CODE +
FU;&TIM EXPLANATIONS >

R-éaglt the abbraviated phrase data.
MB2

=}

a

1=

m

+
ZOIMILHOO T

~

Ends the current column in a muliti-column
format and moves to the besinning of the
next column.

Mewes the cursor immediately to any
desired page in the document.

P EREAK:

Frass T, 4 o coroil the screen. Hress HELF to shaw
Imenu cdreen. Press CANCEL to exil.

Slart typing Y our boxt.
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Using the Word Processing Input/Edit Screen

Scale__Ho....:....1}....-....2 ......... 3
Horizontal position
Vertical position —
Text area
: — Dead column Dead column —

Start byprng your text.

Status Line. The status line (across the top of the screen) shows your
current settings. Reading from left to right, each item is described below:

1 Page Number—Gives the page number where the cursor is placed.
2 File Name—Gives the name of the file you are using.

3 Font —Gives the font currently being used.
4

Font Size—Gives the font size (in points) and Font mode (double
width or double height).

Font Color—Gives the text color.

T

6 Type Styles—Highlighted (framed with a solid line) if active. The
available type styles, from left to right, are bold, underline, strike-out,
italic, outline, shadow, superscript, subscript, and shading.

7 Attribute Color—Gives the attribute color(underline, strike-out, and
shading).

8 Spell Check—Highlighted (framed with a solid line) when Spell Check
is monitoring your typing.

9 Auto Return or Justify—Tells you when you are in either the Auto
Return (AUTO) or Justify JUST) mode.

10 Insert or Overwrite—Tells you when you are in either Insert (INS) or
Overwrite (OVER) mode.

11 Numeric Lock—Highlighted (framed with a solid line) when the
keyboard is locked in Numeric mode. (The keypad keys will be active.
For more information, see page 25 in Getting Started.)

12 Capital Lock(CAPS)—Highlighted (framed with a solid line) when the
keyboard is in the capital letter (CAPS) mode or in Shift (SHIFT) mode.
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You can remove the scale from
your screen to provide more
space for your text.

See Scale Line ONYOFF on page
81.

For more information on moving
the cursor using arrow and code
key combinations, see page 36.

Scale. This scale helps you to determine the position of characters on a
page. The numbers indicate the position from the left edge of the paper.
Other symbols remind you of format settings: left margin [ [ ], right margin
[ 1], normal tab(4], center tab [3] leader tab [{], and decimal tab [4].

Text Area. Most of this screen is your work area; however, it only shows
part of your document at a time. To see the rest of your document, you
must use arrow keys (or combinations of arrow keys and the code key) to
move the viewing area up, down, left, and right. The only parts of the
screen you cannot use are the dead columns (left and right edges of the
screen). The Desktop Publisher reserves the left edge for the Format
Change symbol [E], Chart symbol [C], Line Framing symbol [L], and the
right edge for the symbol that shows the cursor’s position. The solid box
at the right edge of the window indicates the cursor's line position.

Other symbols appear in the text to remind you of the format functions
that you used, but these symbols do not print. Symbols can be turned on
or off. For more information, see Function Mark ON/OFF on page 81.

A word processing file cannot exceed approximately 70,000 characters

(70 kb). To find out how much space you have remaining in the file, press
MENU. A box showing the remaining memory available for the file
appears. If the file becomes full while typing, you get this message:
“Memory full! Press any key to continue.” This means that the internal
memory is full, and you need to save this file on a diskette and open a
new file before you can continue writing your document.

Before saving the file on a diskette, press BACKSPACE or DELETE to
erase the last characters typed to make some memory available. You
should repeatedly press BACKSPACE or DELETE until you no longer get
the Memory Full message. Then you can save the file and open a new file
to continue writing your document.
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Using Basic Typing Features

Tty creating a short, simple
document and save it on a
diskette. For information on
saving a file, see Saving a File on

page 42.

You may also try to print your
document. For information about
printing, see To Print a Document
on page 83.

Word Wrap

Hyphen

After the text is typed and the
document formatted, you can use
Hyphen Scan to insert soft
hyphens automatically. For
information, see Hyphen Scan on

page 48.

You cannot enter a soft hyphen at
the end of a line of text.

Types of Spaces

Type your text just as you would on a typewriter. The text appears in the
window instead of being printed on paper.

If you make a mistake, press BACKSPACE or DELETE to erase the
mistake,

Word wrap allows you to type sentences in a paragraph continuously
without entering a paragraph break symbol [¢!]. When a word is going to
extend beyond the right margin, the word moves to the next line
automatically.

Normal hyphen. Typing a hyphen “-” in a word entered at the right
margin automatically sends the characters after the hyphen to the next
line. If the document is edited and the hyphenated word fits on the line,
the hyphen does not disappear.

Permanent hyphen. Use permanent hyphens for words that always
require a hyphen (e.g., mother-in-law). Permanent hyphens are entered
by pressing CODE + [-] and appear as [H}. If a permanent hyphen is used
in a2 word, it is treated as a normal character.

Soft hyphen. If word wrap moves a long word to the next line and you
want to hyphenate that word, insert a soft hyphen by pressing CODE + S.
The soft hyphen shows in the window as a dotted hyphen [-=]. The part
of the word before the soft hyphen returns to the end of the previous line
if it can fit. If the document is reformatted so that the entire word can fit
on the same line, the soft hyphen disappears. If you think your document
may change, use a soft hyphen.

Soft spaces. Enter soft spaces by pressing the SPACEBAR. Soft spaces
separate words the same as pressing the spacebar on a typewriter. When
your sentence reaches the right margin, word wrap moves all of the words
that come after the last soft space to the next line. In Justify mode, the soft
spaces are adjusted to produce an even right margin. (See To Justify Text

on page 45.)
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Paragraph Break

Page Break

Permanent spaces. Enter permanent spaces by pressing CODE +
SPACEBAR. They are word separators that link words together. Permanent
spaces protect words from being separated on different lines. A
permanent space appears as the symbol [ii] and is considered part of the
two words it links. If two words separated with a permanent space are
entered at the right margin, they automatically move together to the
beginning of the next line.

At the end of each line of text, Word Processing automatically moves the
cursor to the beginning of the next line. This type of return is called a
soft return.

To mark the end of a paragraph, press RETURN. The cursor jumps to the
next line. A Return symbol [¢], called a hard return, appears in the text.

The Desktop Publisher automatically divides text into pages according to
your specifications. The place of these automatic page breaks is flexible
and readjusted for you by the Desktop Publisher if you change the text. In
the window, a page break appears as a horizontal line with a page
number.

You can also force the Desktop Publisher to start a new page at any point
by pressing CODE + P BREAK. This inserts a Page Break symbol [¥] in the
text and creates a new page with the cursor positioned at the beginning of
the first line on the new page. '

Tab and Paragraph Indent

For information about paragraph
indent, see Using a Tab to Create
a Paragraph Indent on page 54.

Tab. When you press TAB, the cursor moves to the next tab and a Tab
symbol [?] appears. There are different types of tabs. For information on

‘setting tabs and using them, see To Change Margins & Tabs on page 53.

Paragraph indent. When you press CODE + P IND the cursor moves to
the next tab and a Paragraph Indent symbol [ appears. That place
becomes a temporary left margin. The cursor automatically returns to that
place, and the entire paragraph is indented until you press RETURN to
mark the end of the paragraph.

Typing Different Characters

Special characters on the keyboard. Most letter keys on the keyboard
can be combined with CODE to start operations. A few keys, however, are
available to type special characters. These keys have the characters printed
in green on the key (example: § on the Z key). To type such a character,
press CODE + the character key.

Symbols. Press CODE + SYMBOL to see the Symbol dialog box:
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For a complete list of extra
characters and symbols, see the
Extra Character Table in the
Appendix.

<< SYMBOL >>

n-r-vo*ﬁoo-::«oo‘,svv

iPress «, -, t, 4 lo select a letler and press RETURN.

Use the arrow keys to select a symbol; press RETURN to put the symbol in
the text.

Extra characters. Press CODE + E CHAR to see the Extra Character dialog ~
box:

<< EXTRA CHARACTER »>

|E130123456789

Press +, 4, t, 4 'o seleci a letter and press RETURN.

Use the arrow keys to select an extra character; press RETURN to put the
character in your text.

In addition to the arrow keys, the following keys also move the cursor
quickly through the Symbol and Extra Character dialog boxes:

Keys Cursor Movement

CODE + « To the beginning of the line

CODE + - To the end of the line

CODE + T To the beginning of the previous line
CODE + 1 To the beginning of the next line

Moving the Cursor Using Arrow Keys

-
EXPR D

When you spot a mistake in the
line you are typing, move the
cursor back to the mistake,
correct the mistake; then press
CODE + RELOC to retumn to
your previous typing position.

To change text, you must first know how to move the cursor in the
document.

Moving one space at a time. The arrow keys T, 1, «, and = move the
text cursor one space in the direction of the arrow. :

Moving left and right. CODE+ EXPR moves the cursor to the left margin.
CODE + RELOC moves the cursor to the end of the line.

Moving one paragraph. SHIFT + « or SHIFT + —» moves the cursor to
the next return, page break, or Column End symbol in the direction of the
arrow on the arrow key.

Searching for a Format symbol. SHIFT + T or SHIFT + | moves the
cursor to the left margin where the Format symbol appears.

Moving one window at a time. CODE + PRE S moves the cursor back to
the previous window, and CODE + NEXT S moves it forward to the next
window.

Moving to a specified page. CODE + GO TO moves the cursor to the
beginning of any page in the document. After pressing these keys, a dialog
box appears:
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Besides these methods for
moving the cursor, you can also
use the Search function to focate
a specific word, phrase, or title in
your document. For more
information, see To Search for
Text on page 45.

Search Color Function

CODE + PRE S and CODE +
NEXT S are available for the
Search Color function only in the
GO TO mode.

The Search Color function can
search for the color of characters.

The Color Mark ON/OFF option
aflows you to recognize the
colored characters. For
information about Color Mark
ON/OFF, see page NO TAG.

If you cannot locate a color, the
machine beeps, and the following
message appears:

“Other color(s) not found.”

GO TO PAGE:
Type page number and press RETURN or use arrow keys to

move to page lop, next page top, top or end of file.

Type the page number; press RETURN. 7he cursor moves to that
bage.

Instead of typing a page number, you can also press an arrow key.
The dialog box disappears, and the cursor moves as indicated in the
following table:

Arrow Key Cursor Movement
CODE+G + 1 To the beginning of the current or previous page
CODE+G+! To the beginning of the next page
CODE + G + « To the beginning of the document
CODE+G+— To the end of the document

To use the Search Color function, press CODE + GO TO to open the Go To
dialog box; then press CODE + PRE S or CODE + NEXT $ to search for the
color of characters in the document.

e CODE + PRE S moves the cursor to the first character of a color block.

If the cursor is located in the middle of a color block, pressing CODE +
PRE S moves the cursor to the first character of the same color block.

Example: The sequence of characters, 1234567890, is
divided into two colors, where 12 3 4 5 are red and 6 78 9 0 are
blue. If the cursor is located at 9, pressing CODE + PRE $ moves
the cursor to 6 (the first character in the blue color block).

If the cursor is located at the first character of a color block, pressing
CODE + PRE S moves the cursor to the first character of a previous
color block.

Example: In the same color sequence as in the above example,
but now with the cursor located at 6 (first blue character), pressing
CODE + PRE S moves the cursor to 1 (the first character in the red
color block).

* CODE + PRE S searches from the cursor location to the top of the page.

If the cursor is already at the top, it searches to the top of the previous
page.

s CODE + NEXT S moves the cursor to the first character of the next color

block.

Example: If the sequence of characters, 1234567890, is
divided into two colors, where 123 45 arered and 6 789 0 are
blue and the cursor is located at 1, pressing CODE + NEXT $§
moves the cursor to 6 (first blue character).

¢ CODE + NEXT S searches from the cursor location to the top of the

next page.
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Inserting Text

Deleting Text

It is not possible to delste a
Return symbol [ ] if the two
paragraphs have different
formats.

Using the File Menu

Zreate Mew File
Open File
Save File

Close File
Eile Management

Open File for Dual

Tips for Using Files

You can add text in the middle of a document either in Insert or in
Overwrite mode.

Insert mode. The characters you type are inserted at the cursor, and the
rest of the line moves to the right automatically.

Overwrite mode. As you type, your new information replaces the
existing text.

To change between the Insert and Overwrite modes, press INSERT. The
indicator on the status line changes accordingly to or@.

Deleting a character. Press BACKSPACE to delete one character to the
left of the cursor. Press DELETE to delete the character at the cursor
position.

Deleting a word. To delete a word, position the cursor on the space
immediately following the word and press WORD OUT.

Deleting a line. To delete a line, position the cursor anywhere after the
last character of the line and press CODE + LINE OUT.

Deleting a block of text. You can delete any amount of text by using
Block/Delete. For more information, see To delete a block of text on page
60.

Use the File menu to open, save, close, delete, or rename your files;
initialize disks; and return to the Main Menu.

» Create New File. Opens a new file in the program that is currently
selected.

* Open File. Saves the current file to diskette and opens another.
* Save File. Saves the current file to diskette without closing it.

* Open File for Dual. Opens a second file. Both the first and second
files appear in the window.

* Close File. In Single mode, saves the file and returns to the Main
Menu. In Dual mode, saves and closes current file.

» File Management. Opens the File Management window.
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CAUTION: _

Do not remove a diskette while the Desktop Publisher is saving a
document to the diskette or while the Desktop Publisher is reading
a document from the diskette. It could permanently damage the
diskette or cause you to lose information.

* You can open two files at the same time, without the files having to
belong to the same program. We will call these files the first and the
second file. The first file is opened with Create New File or Open File;
the second file is opened with Open File for Dual.

When you are working in Dual Display, you cannot use Open File for
Dual to open a third file. You must close at least one of the files before
you can use Open File for Dual.

* File operations are identical in Word Processing, Spreadsheet, and
Addressbook. While working with one program, you can use Open
File or Open File for Dual to open a file belonging to the same
program or to a different program.

* To save the current file, use Save File or Close File.

* You can organize your files in File Management; however, File Copy,
Disk Copy, List Print, and Convert are not available. For information,
sce File Management on page 142,

pTo create a new file:

Create New File opens a new file 1. Press MENU to see the menu bar; select Create New File from the
in the program currently selected. File menu. If the current file has not been saved onto the diskette,
your Desktop Publisher asks if you want to save it.

2. Select YES, NO, or CANCEL. Press RETURN.

* YES. Shows the Save File dialog box. For information, see Saving a
File on page 42.

* NO. Closes the current file without saving that file.
* CANCEL. Cancels the function and returns to the previous screen.

p-To open a file:
Open File opens a Word 1. Press MENU to see the menu bar; select Open File from the File
Processing, Spreadsheet, or menu. If the current file has not been saved onto the diskette, your

Addressbook file. . . .
resshook e Desktop Publisher asks if you want to save it.

2. Select YES, NO, or CANCEL. Press RETURN.
* YES. Shows the Save File dialog box. For information, see Saving a
File on page 42.
* NO. Closes the current file without saving that file.

* CANCEL. Cancels the function and returns to the previous screen.
Save and close or just close the file, and the list of files appears:
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If you get a message indicating you
have an unformatted or damaged
diskette, replace it with another, or
go fo page 22 in Getting Started for
information on how to initialize a
diskette.

Open File for Dual

For copy and paste operations,
see Clip Board on page 234.

Waord - -
[ s\ [FOR \ [P\

K¥NEWTEXT LETTERL .WPT LETTER1O.WPT ['
LETTER11.WPT LETTERZ .WPT LETTER3Z .WPT
LETTERG .WPT LETTERS .WPT LETTERS .WPT
LETTER? .WPT LETTERE .WPT LETTERS .WPT

-l

The file list can show three indexes: Word Processing, Spreadsheet, and
Addressbook. The list of files for the program you are currently using
appears before the other indexes with its title bighlighted, and this
message appears:

iSelect mode and press J to select a file. 1

3. To select, press - or — to highlight a title; then press 4. The cursor
moves inside the file list and bighlights the file name in the upper left
corner. This file name is either KNEWTEXT, SkNEWDATA, or
SkKNEWBOOK, each allowing you to start a new file. This message

appears:

Select a file and press RETURN. Press CANCEL to select
mode .

4. Press the arrow keys «, —, T, |, CODE + T, or CODE + { to select a
file. Then press RETURN to open the file.

OR
Press CANCEL to move the cursor back to the title of the list.

P To save the current file without closing:
1. Press MENU to see the menu bar; select Save File from the File
menu. The Save File dialog box appears, with the file name given at
the top. For more information, see Saving a File on the next page.

2. Press RETURN. The file is saved to diskette.

Open File for Dual opens a second file in addition to the file you are
currently using. In this way, you can easily compare the two files or
transfer parts of one file to the other.

Firat Document

Second Document
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See Change screen on page 81. When a second file is opened, choose Change Screen from the screen
menu to move between the two files.
P> To open two files at once:
1. Press MENU to see the menu bar; select Open File for Dual from the

File menu. The list of files appears. This list can show three indexes:
Word Processing, Spreadsheet, and Addressbook. The list of files for
the application you are currently using appears before the other
tndexes, bighlighting the title of the currvent program. This message

appears:
{Select mode and press ! to select a file. j

2. Press « or — to select a title; then press 4. The cursor moves inside
the file list and bighlights the file name at the upper left corner. This
file name is either X NEWTEXT, KNEWDATA, or SkNEWBOOK, which
allows you lo start a new file. This message appears:

Select a file and press RETURN. Press CANCEL to select
mode .

3. Press the arrow keys «—, —, T, {, CODE + |, or CODE + T to select a
file and press RETURN to open the file.

OR
Press CANCEL to move the cursor back to the title of the list.
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Close File

Saving a File

If you get a message indicating
you have an unformatted or
damaged disk, replace the
diskette with another or go to
page 22 in Getting Started for
instructions on how fo initialize a
diskette.

Close File allows you to return to the Main Menu after saving the file.

Press MENU to see the menu bar; select Close File from the File menu.
This dialog box appears:

Save current file bafore closing?

Use cursor to select and press RETURNL
= (NO] {CANCEL]

* If you select YES, the Save File dialog box appears. See Saving a
File below.

Type in the file name and press RETURN. 7he current file is
saved and the Main Menu appears.

* If you select NO, the current file is deleted and the Main Menu
appears.

¢ If you select CANCEL, you return to the current file.

When Create New File, Open File, Close File, or Save File is selected from
the File menu, the Save File dialog box (shown above) appears.

If you try to open another file using Create New File or Open File,
Desktop Publisher asks if you want to save your current file. If you select
YES, the Save File dialog box appears.

L< SAVE FILE »>

FILENAME: B .wrT

! Existing File(s) \ |

LETTER1 .WPT LETTERLO.WPT
LETTER2 .WPT LETTER3 .WPT
LETTER4 .WPT LETTERS .WPT
LETTERE .WPT LETTER? WPT
LETTERE .WPT LETTERS .WPT

* If you have been working on a new file, the file name is empty and
you must type a file name. (See File name conventions below.)

* If your file has already been saved on the diskette, its file name
appears.

You can press RETURN to save the file with changes.
OR
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You can also type a new file name to keep both the original and
modified versions in separate files.

* The correct file name extension appears in the file name entry field
(such as WPT for Word Processing, SPR for Spreadsheet, or MRG for
Addressbook), and a list of the files from the same application appears.

File Name Conventions

* A file name consists of up to eight characters (2 beep sounds if you try
to enter more). The file name is followed with a period and a
three-character extension that is automatically created by the system.
You cannot change the extension.

* The Desktop Publisher accepts only the following characters in file
names: upper- and lower-case letters of the English alphabet (A~Z and
a-z), digits (0 to 9), and the hyphen (-). All others are refused and
cause the Desktop Publisher to beep.

* The Desktop Publisher does not distinguish between upper- and
lower-case letters. All letters are converted into capitals.

File Management

m Dizk Press MENU to see the menu bar; select File Management from the File
Ooe D'=J»=E - menu. Press RETURN. Press MENU again to use the File menu to delete or

Rename rename files.

Exit
=2 * File Delete. Erases files from the diskette.
* Rename. Changes the name of a file.

* Exit. Exits from File Management back to your document.

Use the Disk menu to delete all files,initialize diskettes, and view diskette
contents.

* Delete All Deletes all unprotected files on the diskette.

Initialize Disk * Initialize Disk. Prepares the diskette to accept Word Processing files,
Directory Read Spreadsheet files, etc.

'

* Directory Read. Reads the list of files on a diskette when this has not
been done automatically.

Press CANCEL as many times as needed to return to the Input/Edit screen.

For more information, see File Management on page 142.
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Using the Edit Menu

m Style Block Use the Edit Menu to change the appearance of your text, to create
headers and footers, or to set up merge codes that generate letters
Right Margin Flush automaticaily.
Justit .
é:::h * Centering. Centers text between the margins
S:E’::re * Right Margin Flush. Aligns text flush with the right margin
Footer ¢ Justify. Adjusts the space between words evenly so that the last
Hyphen Scan character of a line is aligned with the right margin
Merge Code
* Search. Searches the document for a specified string of characters
* Replace. Searches the document for a specified string of characters and
replaces it with another string
* Header. Defines a block of text at the top of a page
» Footer. Defines a block of text at the bottom of a page
* Hyphen Scan. Scans the text for unhyphenated words that can be
divided
* Merge Code. Inserts merge codes that will be replaced automatically
with information from an Addressbook file during printing
pTo center text:
The Centering fuﬂcﬁ;n centers a 1. With the cursor on the line to be centered, press CODE + F. A
fine of text between the margins. :
You can use it to center the fext C.entmng symbol [ +|] appears. The cursor moves o the center of the
being typed or that has already line.
been typed. 2. Type the text; then press RETURN. The text is centered,
Use one of the following methods to undo centering:
* Delete the Centering symbol [[+]].
s Press CODE +F a second time.
* Press CANCEL.
* Select Centering from the Edit menu a second time.
P To align text Right Margin Flush:
Right Margin Flush aligns text 1. With the cursor on the line to be aligned, press CODE + R. A Right
flush with the right margin. You Margin Flush symbol [ appears. The cursor moves to the right
can use it to align the text being margin
yped or the text that has already )
been typed and formatted. 2. Type the text; then press RETURN. The text is aligned with the right
margin.

Use one of the following methods to undo the margin formatting:
e Delete the Right Margin Flush symbol [<].

* Press CODE + R a second time.
* Press CANCEL.

s Select Right Margin Flush from the Edit menu a second time.
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You can adjust the width of blank
spaces between words so that
the last character of each line is
exactly on the right margin.

Any line that ends in a [ ]
symbol cannot be justified.

The Search function allows you to
search for a specified string of
characters. Both Spreadsheet
and Addressbook use this
function in a similar way.

pTo justify text:
1. With the cursor on the paragraph to be justified, press CODE + J.
The AUTO indicaior on the status line changes to JUST.

2. To cancel the Justify mode and resume normal typing or to undo
justified text, go to step 1. The JUST highlighting changes to AUTO.

When you switch the Justify mode on (or off), a Format Change symbol
[ E] appears in the dead column at the beginning of the paragraph. The
Justify mode remains on (or off) from that point to the end of the
document or up to the next Format Change symbol.

pTo search for text:

1. Press MENU to see the menu bar; select Search from the Edit menu.
The Search dialog box appears:

<< SEARCH >
SEARCH:
|
START POSITION: CURRENT
SEARCH:
WHOLE WORD CHECK OFF
CASE CHECK QFF

Type SEARCH word(s) and press RETURN. I

2. Type the string to be searched (50 characters maximum).

3. Press T and 4 to move the cursor to a setting. Press SPACEBAR to
select other settings.

* START POSITION:
CURRENT—Scans the text from the current cursor position.
TOP OF FILE—Scans the text from the beginning of the file.

* SEARCH: WHOLE WORD CHECK

OFF—Stops scanning if the string is found even inside a word.
(For example, “the” will be found in “these”).

ON—Stops scanning only when the string is a word by itself.

* SEARCH: CASE CHECK

OFF—Turns off the system’s ability to distinguish between
upper- and lower-case letters. (For example, if the string is
“the,” the system stops at “tHe,” “THE,” etc.)

ON—Stops only at strings in exactly the same case.

4. Press RETURN when you have made your selections. The Desktop
Publisher starts searching. If an occurrence of the string is found, it is
highlighted and a dialog box appears:
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Continue search?

Use cursor to select and press RETURN. H
{NC] [CANCEL]

5. Select YES or press TAB to start searching again, or select NO to
stop. The cursor is positioned on the last searched word if NO is
selected. Select CANCEL to end the operation. The cursor returns to
the original position. Wher the string cannot be found, this message
appears:

,WOrd{S) not found. I

p-To replace text:

The Replace function searches 1. Press MENU to see the menu bar; select Replace from the Edit menu.
for a specified string of The Replace dialog box appears:

characters and replaces that
string with another stting.

<< REPLACE >»

SEARCH:

REPLACE:

START POSITION: CURRENT
REPLACEMENT MODE: MANUAL
SEARCH:
WHOLE WORD CHECK QFF
CASE CHECK OFF

Type SEARCH 8 REPLACE wordis) and press RETURN.

2. Press T and | to move the cursor to a setting.

3. Type the search and replace strings (50 characters maximum). Press
the SPACEBAR to select other settings.
* START POSITION:
CURRENT—Scans text from the current cursor position.

TOP OF FILE—Scans text from the beginning of the file,

* REPLACEMENT MODE:
MANUAL—Sets the system to ask whether or not to replace
each time a string is found.

AUTO—Replaces all occurrences of the string automatically.

s SEARCH: WHOLE WORD CHECK
OFF—Stops scanning if the string is found, even inside a word.
(For example, “the” will be found in “these”).

ON—Stops scanning only when the string is a word by itself.

¢ SEARCH: CASE CHECK ‘
OFF—Turns off the system’s ability to distinguish between
upper- and lower-case letters. (For example, if the string is
“the,” the system stops at “tHe,” “THE,” etc.)
ON—Stops only at strings in exactly the same case.
4. Press RETURN when you finish. The Desktop Publisher starts
searching. In AUTO mode, this message appears after all replacements
are made:

[Completed. |
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The Header/Footer functions print
a line of text at the top (header)
or bottom (footer} of each page of
the document.

If you print a header or footer in
36 point type, the page margin
cannot be less than 1.17 inches.
To change the header/footer
margin, see To Set Page Size
and Margins on page 57.

Before printing your document, do
not forget to select YES or NO for
header or footer at the Word
Processing Print Menu. For
information, see To Print a
Document on page 83.

In MANUAL mode, when an occurrence of the string is found, it
appears inversely, and a dialog box appears:

Replace?

Use cursor to select and press RETURN i
=S (NO) [CANCEL])

5. Select YES to replace that occurrence and start searching again.
Select NO or press TAB to start searching again without replacing.
Select CANCEL to end the operation. The cursor returns to the
original position. When the string cannot be found, this message

appears:

JWord(s) not found. ]

pTo put in headers and footers:

1. Press MENU to see the menu bar; select Header or Footer from the
Edit menu. The Header or Footer dialog box appears:

2. Type header and/or footer text to appear on every page. You can
use centering, right margin flush, attributes, font type and size, color,
margin settings, and tabulation without affecting the layout of the
document. However, text must fit on a single line.

3. When finished editing, press MENU to see the menu bar; select Exit
from the Edit menu.

Editing Headers and Footers

_Bl  sye

Right Margin Flush
Header

Footar

Auto Page Numbering
Exit

Use the following functions from the Edit menu to make changes to the
appearance of header/footer text:

¢ Centering. Centers header/footer between the margins

¢ Right Margin Flush. Aligns header/footer flush with the right margin

Header. Opens the Header mode during the Footer mode
* Footer. Opens the Footer mode during the Header mode

* Auto Page Numbering. Numbers pages in your document
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To access Auto Page Numbering * Exit. Exits from the Header or Footer mode to the document File
from the Edit menu, you must be menu
in the Header or Footer screen.

For information on Centering, Right Margin Flush, and Header/Footer, see
page 44.

pTo put in Auto Page Numbering:

1. Press MENU to see the menu bar; select Auto Page Numbering from
the Edit menu. This dialog box appears:

You can number pages in your
document automatically.

START NUMBERING WITH PAGE NUMBER:

Type number and press RETURN.

2. Type the number of the first page. Press RETURN. The number
appears between double quotation marks.

OR

Automatically number pages in your document by including a
number between double quotation marks. For example, if your
header or footer is Page “1,” the first printed page shows Page 1, the
second shows Page 2, and so on.

Use the Style menu to change the appearance of your header or footer
text.

Type Style Changs
Font & Size

Color

Margins & Tabs

Type Style Change. Switches attributes on or off

Font & Size. Select font type, size, and mode

Color. Selects color of characters and attributes

* Margins & Tabs. Set left and right margins and tabs

When the text cannot fit on a single line, a dialog box appears:

Ciata will be truncated!
Ok to change margins?

Use cursor to select and press RETURN.

[ EE] [NO]

Select YES or NO; then press RETURN.

* YES. Changes the margin and truncates (cuts off) text that exceeds
the right margin

* NO. Does not change the margin
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Hyphen Scan

A hyphen inserted with Hyphen

' Since word wrap automatically transfers a word that cannot fit in the
Scan is treated as a soft hyphen.

When reformatting, if a word current line to the next lit.le, excessively long blank spaces may appear in
containing 2 soft hyphen fits your document resulting in a poor layout.

within the margins, the soft

hyphen is deleted, Hyphen Scan automatically detects such long blank spaces and gives you a

chance to hyphenate long words. It allows you to type your text without
inserting any hyphens manually (except permanent hyphens).

pTo scan for hyphens:

1. Press MENU to see the menu bar; select Hyphen Scan from the Edit
menu. The Hypben Scan dialog box appears:

<< HYPHEMN SCAN >>

HY PHEMNATION HOT-ZONMNE: B
[2 (0.EINCH) ~ 9 (0.9INCH]]

START POSITION: CURRENT

Type number and press RETURRNL

2. Press T and { to move the cursor to a setting,

3. Type the number for the hot-zone width (2-9). Press the SPACEBAR
to select the start position setting.

* HYPHENATION HOT ZONE:
2 through 9—Defines the width of the hot-zone.

¢ START POSITION:
CURRENT—Scans text from the current cursor position.
TOP OF FILE—Scans text from the beginning of the file.

4. Press RETURN when you finish. The Desktop Publisher starts scanning
the document. If a word leaves a blank space that is wider than the
specified Hypbenation Hot-Zone, the Hypbenation dialog box appears:

OHK to hyphenale?
< HYPHENATION >

prepara-tory

Use cursor to select and press RETURM.
Press SPACE to change hyphen position.

[CANCEL]

5. The dialog box shows a possible hyphen position for a long word.
Press < and — to select the following items; then press RETURN.
(You can also press TAB instead of selecting NO.)

* YES. Hyphenates the word as shown and resumes scanning.

* NO or TAB. Resumes scanning without hyphenating that word.

* CANCEL. Cancels the function and returns to the original cursor
position.

6. To change the hyphen position, press the SPACEBAR while showing
the Hyphenation dialog box. The bypben position changes within the
range of possible bypben positions.
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Use the Merge Code function to
send a similar lefter to numerous
addresses, with each letter
having a different name and
address but the same contents.
This function prints the same
letter continuously, while
automatically inserting changing
information (such as names and
addresses) into the document at
the same position.

Type the label name exactly as it
appears in the Addressbook file.
You can use the dual screen
function to see the Addressbook
fite if you do nof remember the
label names.

p-To merge text from two documents:
1. Create a file containing the information to be inserted in the letters

(the Addressbook file). For information, see Addressbook on page
127. The information to be inserted in a single letter is called a
record. A record is made of labels that correspond to different
pieces of information needed to insert in a single letter (Name,
Address, etc.). Organize your Addressbook file logically, with the
same label in each record containing the same type of information.
Addressbook allows you to mark records for merge printing.

. Create a Word Processing file containing the text that is common to

all the letters (the master document). Wherever variable information
is to be inserted in that text, insert a Merge symbol using the Merge
function described in this section.

. Print the Master Document. The text prints as usual until a2 Merge

symbol is encountered. At that point, the program compares the
label name that you have inserted with the merge symbol and
automatically replaces the Merge symbol with the information
contained in the corresponding label of the first marked record.

When the whole document prints, the Desktop Publisher checks the
Addressbook file to see if there are more marked records. If there
are no more records, merge printing is completed. Otherwise
printing of the Master Document starts again using the next marked
record of the Addressbook file. The process repeats until all records
of the Addressbook file have been used.

pTo insert merge symbols in your document:

1.

Position the cursor in the text where the merged information
belongs.
Press CODE + M. The Merge Code dialog box appears:

<< MERGE CODE >>

LABEL NAME:

Type label name and press AETURMN.

Type the name of the label (12 characters maximum) corresponding
to the Addressbook information you want inserted at this point.
Press RETURN. The label name is entered as it appears in the
Addressbook.

Type Last Name, First Name, or one of the other label names at the
Merge Code dialog box. The label name, surrounded by merge
symbols (M), appears in the text.

If necessary, set the font type, size, and color as well as the attributes
for the label name. During merge printing, the merged information
uses those settings.

After inserting all merge symbols, you can start merge printing. For
information, see To Print 2 Document on page 83.
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Using the Style Menu

ma Block «

Tepe Style Charige

Font & Size
Color

Margins & Tabs
Line Spacing
Multi-Column
Copy Farmalt
Delete Formatl
Page Setup

Margins & Tabs, Line Spacing,
and Multi-Column are applied
from the paragraph the cursoris
on to the end of the document, or
to the next Format Change
symbol.

Page Setup applies to the entire
document,

To change the type style of
previously typed text, use the
Block Menu on the menu bar. For
details, see Using the Block
menu on page 59.

Underline is an exception to the
rule in step 2. Pressing the
SPACEBAR once tumns
Continuous Undetline on,
Pressing it again tums Word
Underiine on, and pressing it
once more tums underiine off.
With Continuous Underline,
everything is underined. With
Word Underiine, spaces between
words are not underiined.

Use the Style Menu to change the appearance of your document:
* Type Style Change. Switches attributes on or off

* Font & Size. Selects font type, size, and mode

* Color. Selects color of characters and attributes

s Margins & Tabs. Sets left and right margins and tabs
* Line Spacing. Sets the line spacing

* Multi-Column. Switches the multi-column layout on or off and sets
the column width, number of columns, and column spacing

* Copy Format. Copies a Format Change symbol for pasting into the
text to change the format from that point

* Delete Format. Deletes a Format Change symbol

» Page Setup. Selects paper size and orientation and sets top and bottom
margins as well as the space for the header and footer

pTo change type style:
1. Press CODE + T STYLE. The Type Style Change dialog box appears:

<< TYPE STYLE CHANGE »»

[ outume
] sHecow
[J suremscript
[ suescriet
[ sHaoma

BOLD

.4
a
[0 unoerLiNe
[
]

STRIKE QUT
ITALIC

ABC abc 123

'Press SPACE ta set on and press RETURN.
Press FONT or COLOR lo open respeclive menu.

2. Press the arrow keys to move the cursor to the attribute setting, and
press the SPACEBAR to turn the attribute on or off. While changing
settings, you immediately see the effects of your settings in the box
at the bottom of the window.

3. Press RETURN when you finish,
You can apply more than one attribute at the same time. There are,
however, a few exceptions:

* NORMAL. Automatically resets all other attributes to off

* The following attributes cannot be set together; the last setting
overwrites the previous one:
OUTLINE, BOLD, and SHADOW
UNDERLINE and SHADOW
SUPERSCRIPT and SUBSCRIPT
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To change the font and size of
previously lyped text, you must use
the Block menu on the menu bar.
For details, see Using the Block
Menu on page 59.

The size 24 point font is available
only for Model DP-540CJ and
DP-550CJ.

To change the color of previously
typed text, use the Block menu
on the menu bar. For details, see
Using the Block menu on page
59.

Only the following three attributes
can be colored: Underiine,
Strikeoutt, Shading.

To change type style from the
Color dialog box, press CODE +
T STYLE to open the Type Style
Change dialog box.

To change font & size from the
current Color dialog box, press
CODE + FONT to open the Font
& Size dialog box.

Use the following short-cut keys to change attributes without showing the
Type Style Change dialog box:

CODE + B turns bold on or off.

CODE + N underlines continuously, underlines each word, or
_ turns off underline.

If you want to change the font, size, and proportion of the character, press
CODE + FONT to open the Font & Size dialog box from the current Type
Style Change dialog box. If you want to change the color of the character,
press CODE + COLOR to open the Color dialog box directly from the
current Type Style Change dialog box.

pTo change font & size:

1. Press CODE + FONT. 7he Font & Size dialog box appears for all models
similiar to the one below:

<< FONT & SIZE %

SIZE: MQDE:
10 POINT
DOUBLE WIDTH
14 POINT DOUBLE HEIGHT
18 POINT
36 POINT

TYPE:
TENMNESSEE

HEL S KL

BROUGHAM ABC abe 123

TURM, Fress «, o move b another setting.
ecxhive meanu,

2. Press « and — to move from one column to the other. Press T and
! to select an option in each column. While setting font and font
size, you immediately see an example of the effect of your settings in
the box.

3. Press RETURN when finished.

pTo add color:
1. Press CODE + COLOURCOLOR. The Color dialog box appears:

<< SOLOR =>

CHARACTER: ATTRIBUTE:
[ELEZK]
BLUE
GREEMN
CYAN
RED
MAGENTA

YELLOW

MAGENTA
YELLOW

Press 1,4 o change setting and press RETURNMN.
Press +,-3 to move to another setting.

Press T STYLE or FONT to open respective
menu.

2. Use the arrow keys to move the cursor to a color setting.
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if any of the keys in the following
table are pressed to set tabs or
margins at a position where a tab
or margin has already been set, a
[F ] code appears and the text is
reformatted.

To change the margins of the
header, footer, or the beginning of
the text, select Page Setup from
the Style menu and press
RETURN without changing the
paper size.

To reset the other formats, press
M to reset to the default margin
setling in the Margins & Tabs
screen.

P To change margins and tabs:

1. Place the cursor on the line where the new format is to begin.
2. Press MENU to see the menu bar; select Margins & Tabs from the

Style menu. This screen appears:

Default Margin
e Dou v Ty

L (Leit) 3 Right) + (Tab) T (Ganter) 4 Recimadl 3 (Laadler)

—ELT

B - B N B R I L P L E I Y O S

NORMAL TAB
CENTER TAB

12340 (DECIMAL TAB)
......................... LEADER TapR

Move arrow and press character key to set.
Proecs DELETE to clear lab.

3. Move the cursor to any position using these keys:

Key Function
Moves the cursor 1/10 inch to the left.
Moves the cursor 1/10 inch to the right.

CODE + « Moves the cursor to the left margin or to 0.2 inches to the right if
the cursor was on the left margin.

CODE+— Moves the cursor to the right margin or to the right end if the
cursor was on the right margin.

SHIFT + « Moves the cursor 1/100 inch to the left.

SHIFT + —» Moves the cursor 1/100 inch to the right.

TAB Moves the cursor to the next tab or to the right margin if there
are no other tabs.

4. To set margins and tabs, use the following keys:

Key Margin/Tab Settings and Symbols

L Sets the left margin at the cursor [ [ ].

R Sets the right margin at the cursor [ ]].

T Sets a normal tab at the cursor [4 1.

C Sets a center tab at the cursor [T ].

E Sets a leader tab at the cursor [ ].

D Sets a decimal tab at the cursor [¥ ].

M Resets the left and right margins to the default setting.
DELETE Clears the tab at the cursor position.

CODE +D Clears all tabs.

A Format Change symbol [E] appears at the beginning of the paragraph
where the new format begins. The text reformats from that point to the
end of the document or to the next Format Change symbol.

5. Press RETURN when you finish.

Word Processing 53



Using tabs to create a table

You can create a table while typing. Pressing TAB moves the cursor to the
next tab to the right and shows a Tab symbol [—=]. Now type your text.

The way the text aligns with the tab depends on the type of tab you have
selected.

* Normal tabs. The text you type is left aligned with the tab.

* Decimal tabs. These tabs normally align numbers in a column so that
decimal points are vertically aligned. You can also use a decimal tab to
align any text to the right. The number you type is right aligned with
the tab, and the number moves to the left as you type. When you type
the decimal point, it appears at the tab position, and any further digits
that you type appear to the right.

* Center tabs. The text you type is automatically centered around the
tab.

* Leader tabs. When you press TAB, the next tab is a leader tab that
provides a string of periods that begin where you pressed TAB and
continue to the tab. If you type text from that point, it is left aligned
with the tab.

You can also insert Tab symbols in the already typed text to rearrange the
text into a table. Press INSERT you are not in the Insert mode. Move the
cursor just before the text you want to align and press TAB. The text is
aligned to the tab.

To undo a table format, delete the Tab symbols [-].

Using a Tab to Create a Paragraph Indent
Instead of pressing TAB to create a new tab, press CODE + P IND to create
a paragraph indent. The cursor moves to the next tab, and a Paragraph
Indent symbol [5\] appears. The tab becomes a temporary left margin (the
text you type wraps to the tab position). When you press RETURN to
mark the end of the paragraph, the cursor returns to the true left margin.
See the example below:

(" - N T T T e T ey =

E|To creale a paragraph indent, to create a paragraph indent, te create a paragraph indent, to

create a paragraph indent, to oreate a paragraph indent, to sreate a paragraph indent, to create

Ma paragraph indent, Io‘create a paragraph indent, to create a paragraph indent, to
parsasanh indantk bo or L sAar boicndant

saska s ko o s

Using a Tab to Create a Line Indent

To indent the first line of a paragraph, press TAB at the beginning of the
paragraph to move the first line to the first tab position.

(N I I T e e
+To create paragraph with an indented firsl lime, press TAB at the
Ibeginniag of the paragraph.4l
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The Multi-Column feature prints
your document in newspaper
style, with up to four columns of
equal width across the page.

The margins set far your
document must be smalf enough
to accommodate all of the
cofumns and the assigned space
between the columns. If the
margins are not small enough,
the prompt “Incorrect setting!”

appears.

P To adjust line spacing: ,
1. Place the cursor on the line where the new format is to begin.

2. Press MENU to see the menu bar; select Line Spacing from the Style
menu. Press RETURN. The Line Spacing dialog box appears:

<< LINE SPACING >>

LINE SPRACING:

Praess SPACE to change setting and press RETURRMN.

* LINE SPACING:

AUTO1—Sets the line spacing according to the size of the tallest
character on the line.

AUTO2—Sets the line spacing according to the tallest character
in a line, plus 1/12 inch.

AUTO3—Sets the line spacing according to the tallest character
in a line, plus 1/6 inch.

AJUTO1 AUTO2 AUTO3

12 points aa Ra aa

g: Ra ha
Aa Aa

36 points Aa Aa Aa
ia Aa Aa

a
AA Aa

3. Choose a setting and press RETURN. A Format Change symbol [€]
appears at the beginning of the paragraph. The text reformats from
that point to the end of the document or up to the rnext Format
Change symbol.

pTo type text using more than one column:

1. After typing your text, place the cursor where you want
multi-column to begin.

2. Press MENU to see the menu bar; select Multi-Column from the Style
menu. The Multi-Column dialog box appears:

<< MULTI-COLUMN >>

MULTI-COLUMN:

Press SFPACE to change seiling and press RETURMN.

3. Press SPACEBAR to change the setting; press RETURN when you
finish.

* MULTI-COLUMN:
OFF—Creates a single column.

ON—Creates up to four columns. If ON is selected, the
Mudti-Column dialog box changes as follows:
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<< MULTI-COLUMMN >3

MULTI-COLUMN: =1
MNUMBER OF COLUMNS [2~4]: 2
SPACE BET. COLUMNS: o]

[1 (0.1INCH] ~ 9 (0.8INCH)]

Press SPACE ta change selting and press RETURN.

;f’ J;O; jf: éi?s nl::’:?f:;:fzi’g on 4. Press T and { to move the cursor to a setting; type in the numbers,
those tabs that are with}n the Press RETURN when you finish.

width of the first column are used * NUMBER OF COLUMNS: Sets the number of columns.

and are applied to the next * SPACE BET. COLUMNS: Sets the space between columns.

column.
5. Press RETURN. A Format Change symbol [E] appears at the beginning
of the paragraph. The text reformats from that point to the end of the
document or up lo the next Format Change symbol.

p-To type text in multi-column pages:
We recommend that you first type 1. Set up the multi-column function as described above.

’a'z zrfiﬁ:ts;gz ffz;;ig‘f:;f’gi 2. Type your text for the first column. When the cursor reaches the end
editing and printing. Typing in the of the first column, it automatically moves to the top of the second
Multi-Column mode requires your column. When the cursor reaches the end of the last column, it moves

Desktop Publisher to perform to the top of the first column on the next page.

extensive reformatting with each .

fine you type. * To move to the next page before reaching the end of the current
page, insert a Page Break symbol [¥] by pressing CODE + P BREAK.

* To move to the next column before reaching the end of the current

one, insert a Column End symbol [{] by pressing CODE + COL
END. If columns of the current page end with a Column End
symbol, the cursor moves to the area beneath the columns so that
you can continue typing on the current page.

* If you delete a block that contains the Format Change symbol [E]
for the Multi-Column mode, this mode is canceled, but the
Column End symbols remain in the text.

¢ If you want to move the cursor to the next column, press CODE +
EXPR or CODE + RELOC. The cursor moves to the left column by
pressing CODE + EXPR when the cursor is on the left margin. The
cursor moves to the right column by pressing CODE + RELOC
when the cursor is at the end of the current line.

P To copy and paste formats tagged with the Format Change
symbol [F):
1. Move the cursor to the line that has the Format Change symbol you
want to copy.
2. Press MENU to see the menu bar; select Copy Format from the Style
menu. The arrow cursor appears at the right of the Format Change
symbol, and this message appears:

Copy?

Use cursor lo select and press ARETURN.
INOJ

3. Select YES to copy or NO to cancel. If you select YES, this message
appears:
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If you sefect this function when
the Format Change symbol is at
the very beginning of the file, the
position of the left and right
margin is set aufomatically and all
tabs are cleared.

lMove cursor to destination of copying and press RETURN. l

4. Move the cursor to the destination and press RETURN.

P To delete formats tagged with the Format Change symbol
[E):
1. Move the cursor to the line that has the Format Change symbol you
want to delete.

2. Press MENU to see the menu bar; select Delete Format from the Style
menu. The arrow cursor appears at the right of the Format Change
symbol and this message appears:

Deleta?

Use cursor to select and press RETURN. |

3. Select YES to delete or NO to cancel the function.

pTo set page size and margins:

1. Press MENU to see the menu bar; select Page Setup from the Style
menu. The Page Setup dialog box appears:

<< PRAGE SETUP >>

PAPER S1ZE & ORIENT ATION: 6.50
T
LETTER LANDSCAPE Lo
A4 PORTRAIT ]
A4 LANDSCAPE 5.00 [11.00
A5 PORTRAIT
OTHER 100

'Press t, 4 to change setting and press RETURN.

Press «, 3 to move to another setting.

2. Press T and | to select the paper size and orientation. This
determines the width and length of the paper.

3. Press — to move the cursor to the entry fields and T or 4 to move to
each setting; then type the values in inches. The text area is set
automatically.

4. Press RETURN to return to the Input/Edit screen and confirm your
settings.

* If the paper size is set to LETTER PORTRAIT, LETTER
LANDSCAPE, A4 PORTRAIT, A4 LANDSCAPE, or A5 PORTRAIT,
and the margin at the top of the text or header/footer is not a
default, this message appears:

CK to set margin size autormatically?
zelect and prezs RETLUIRNMN.
[NO]

Ilzg cursor ta

TEZ]
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YES. Automatically changes the margin settings and returns to
the Input/Edit screen.

NO. Returns to the Input/Edit screen without changing margin
settings.

* If the paper size is set to LETTER PORTRAIT and NO is selected,
or if more than 8.5 inch paper width is set in the OTHER option,
this message appears:

Check margin settings!
Laft margin must be more than 0.2inch.
Right margin must be less than 8.3inch.
FPress any key to continue.

If the paper is set to either LETTER LANDSCAPE or A4
LANDSCAPE and NO is selected, this message appears:

Check margin setlings!
At least 0.9inch is necessary for
koth left margin and right margin area.
Press any key to continue.

e If the text entered in the header or footer exceeds the range of the
margin due to the automatic margin change, the extra text is
deleted from the right end. Then, when the Header or Fooler edit
screen appears, the prompt “Data bas been truncated.” appears.

Word Processing 58



Using the Block Menu

Use the Block menu to change the location or appearance of a block of
text:

* Move. Moves a block of text to another location

Styla Graphics
* Copy. Copies a block of text to another location (The original location
Copy is left unchanged.)
Delele )
Copy to Clip Board * Delete. Erases a block of text
Basle from Clip Board
%ype g:y:e Eg;nge * Copy to Clip Board. Copies a block of text to the clip board
ypelyle
Font & Size * Paste from Clip Board. Pastes the contents of the clip board into a
Calog document
* Type Style Change. Changes the attributes of a block of text
* Type Style Add. Adds the attributes of a block of text
¢ Font & Size. Changes the font, size, and proportions of a block of text
* Color Changes the color of a block of text
pTo move a block of text to a new location in the document:
If graphics are marked, format 1. Move the cursor to the beginning (or the end) of the block you want
change or line framing are to move. Press CODE + E. This messdage appears:

included in the marked block, and

that information moves logether
with the text. Move cursor to end of block to be moved and press RETURN.

To jump to paragraph end, press SHIFT + ¢, SHIFT + —.

2. Move the cursor to the end (or the beginning) of the block. If you
want to select paragraphs of text, press SHIFT + « or SHIFT + —.
The cursor moves o the next return, page break, or Column End
symbol in the direction of the arrow key. As the cursor moves, the text
is bighlighted.

3. Press RETURN when a block is marked. This message appears:

[Move cursor to destination for blocked text and press RETURN. J

4. Move the cursor to the destination for the block and press RETURN.
The block is removed from its original location and placed at the new
location.

P To copy a block of text to a new location in the document:

1. Move the cursor to the beginning (or the end) of the block you want

If graphics are marked, format to copy. Press CODE + C. This message appears:

change or line framing are

included in the marked block, and
that information is copied together
with the text. To jump to paragraph end, press SHIFT + &, SHIFT + —.

Move cursor to end of block to be copied and press RETURN.

.2. Move the cursor to the end (or the beginning) of the block. If you
want to select paragraphs of text, press SHIFT + ¢ or SHIFT + —.
The cursor moves 1o the next return, page break, or Column End
symbol in the direction of the arrow key. As the cursor moves, the text
is highlighted.

3. Press RETURN when the block is marked. This message appears:

Word Processing 59



If graphics, format change, or line

framing are included in the
marked block, that information is
deleted together with the text.

Move cursor to destination for blocked text and press RE-
TURN. :

4. Move the cursor to where you want to place the block; press

RETURN. The block is copied to the new location without removing
the original text.

pTo delete a block of text:

1. Move the cursor to the beginning (or the end) of the block you want
to delete.

2. Press CODE + D. This message appears:

Move cursor to end of block to be deleted and press RETURN.
To jump to paragraph end, press SHIFT + <, SHIFT + —.

3. Move the cursor to the end (or the beginning) of the block. (If you
want to select paragraphs of text, press SHIFT + ¢« or SHIFT + —.)
The cursor moves to the next return, page break, or Column End
symbol in the direction of the arrow key. As the cursor moves, the text
is bighlighted.

4, Press RETURN when the block is marked. The system confirms with:

Delete?

cursor to select and press RETURMN.

35." Select YES to delete the block or NO to carnicel. Press RETURN.

Copy to/Paste from Clip Board

These functions work the same
way as in the Style menu. Type
Style Add works the same as
Tvpe Siyle Change. However,
using this function is the easiest
way o add attributes to a block of
text, because the current
attributes of the specified block of
text are already chosen when you
open the Type Style dialog box
from the Type Style Add feature.

For information on these functions, see Clip Board on page 234.

pTo change type style, font & size, and color:

1. Press MENU to see the menu bar; select Type Style Change, Type
Style Add, Font & Size, or Color from the Block menu.

2. Select the text by moving the cursor to the end of the block where
you want to add or change attributes; press RETURN.

3. Press the arrow keys to move the cursor to a setting to change font
& size and color, or press SPACEBAR to change type style; press
RETURN.

The following are differences between these options and those in the Style
menu: '

¢ You cannot use CODE + FONT, CODE + T STYLE, or CODE + COLOR to
start these functions in the Block menu. Pressing CODE + FONT when
the Type Style Change, Type Style Add, or Color dialog boxes appear
switches you to the Font & Size dialog box. Pressing CODE + T STYLE
switches you to the Type Style Change dialog box, and CODE +
COLOR switches you to the Color dialog box.

* The format change is applied to the selected block only.

* You can select the AS IS setting for each item in the Font & Size and
Color dialog boxes to keep the setting as it is.
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Using the Graphics Menu

Create Waw Chat

Line Framing
Copy Graphic

] Delele Graphic I

The Create New Chart function
allows you to create a new chart.
Five lypes of chart are available:
bar, line, pie, stacked bar, and
100% stacked bar charts.

If you try to insert a chart inside a
multi-column format or where a
[C] symbol or a [L] symbol
already exists, this message
appears: “Cannot insert at this
position! Multi-column, chart,
lineframing, or image data area.
Press any key fo continue.”

You can go to the previous
screen of the next screen by
pressing CODE + PRE S or
CODE+ NEXT S.

Use the Graphics menu to create and edit charts and frames,
* Create New Chart. Creates a chart

Edit Chart. Edits a chart

Copy Graphic. Copies a chart or frame

Delete Graphic. Deletes a chart or frame

p>To create a new chart:

1. Move the cursor to a line below where you want to insert a chart.

2. Press MENU to see the menu bar; select Create New Chart from the
Graphics menu. The Chart Format dialog box appears:

<< CHART FORMAT ==
TYPE: "
A
bk [Bo=| (@) |=Es]
BAR LIME PIE EEQC"ED
POSITION: LEET] CENTER RIGHT
FRAME: [Meld ] THIM THICK
SIZE: 4.0 ¥ 6.0INCH
LINK LINE: FF) oM

3. Press T and { to move from one item to the next. Press < and — to
select an option in each column.

e TYPE: Select BAR, LINE, PIE, STACKED BAR, or 100% STACKED
BAR to create the kind of chart you want. An icon shows an
example of each kind of chart.

* POSITION: Select LEFT, CENTER, or RIGHT to align the chart with
the left margin, to the center between margins, or with the right
margin.

* FRAME: Select OFF, THIN, or THICK to create no frame, a thin
frame, or a thick frame for your chart.

* SIZE: Select 2.0 X 3.0 inches or 4.0 x 6.0 inches to select one of
two sizes for your charts.

¢ Link Line: Select OFF or ON to show increases and decreases of
each item in a Stacked Bar or 100% Stacked Bar chart by adding
lines from the boundaries of items in one stack to equivalent ones
in the next stack. (Link Line can be selected only when Stacked
Bar chart or 100% Stacked Bar chart is selected.)

4. Press RETURN when finished. The following Chart Title dialog box
appears:

Creating a Bar, Line, Stacked Bar, or 100% Stacked Bar chart

If you select Bar, Line, Stacked Bar, or 100% Stacked Bar, the Chart Title
dialog box appears. with the folllowing settings:
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See page 63 for pie chart

instructions.
See Chart examples on page 63 ¢ TITLE: The title of - i
for ample ber 2nd e crerte o ! 3((3) téhr; I:C tt:; chart (example: Employees). The maximum
* X-AXIS TITLE: The title you want on the x-axis (horizontal axis).
The maximum length is 20 characters (example: Age).
* Y-AXIS TITLE: The title you want on the y-axis (vertical axis). The
maximum length is 20 characters.
p-To create Bar, Line, or Stacked Bar charts or 100% Stacked
Bar charts:
1. Type the title for your bar or line chart and titles for the X/Y axis
and press RETURN. This Chart Data dialog box appears:
[ << CHART DATA >>
LEGEND eAxis
Type data and press CODE + RETURN. o
If you need to delete while * LEGEND. The label you want for each row of information
32::”:"9 ;:;’;";:"""’ see Deleting (example: female, male). You can enter a maximum of five labels.

* X-AXIS. The information you want to appear on the x-axis, which
appears under each bar or line (example: under 30, 30-50, 50+).
You can enter 2 maximum of 12 items. After entering each item,
press TAB to enter another item.

¢ Inside the grid (under LEGEND and X-AXIS). The numeric
information, which appears as bars of relative heights. You can
enter 2 maximum of 12 sets (columns) of five different values.
Each value can contain up to 15 digits, a decimal point, and a
minus sign.

2. After entering your information in the Chart Title and Chart Data
dialog boxes, press CODE + RETURN. This dialog box appears
showing the chart you created with the information you entered:

Employees

3. Select an option and press RETURN.

* INSERT IN TEXT. Inserts the chart into your document. A chart
symbol [C] appears in the dead column. The title of the chart and
an icon showing the type of chart appear in your document.
When you print, the complete chart prints.

* PRE-STEP. Returns to the Chart Data dialog box.
* CANCEL. Cancels the function. This dialog box appears:
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The sample bar chart contains
three clusters of two bars, one
cluster for each age bracket.

With a stacked bar and 100%
stacked bar chari, the two bars of
each cluster are stacked one
above the other.

Creating a Pie chart

QK to delete all CHART DATA?

Use cursor lo select and press RETURN. |
[NO]

4. If you select YES, the Create New Chart function is canceled and
your information is lost. If you select NO, you return to the Chart
Format dialog box.

Chart examples: The following sample charts show the relative
proportion of employees of a company in three age brackets (under
30, 30-50, and 50+) and separately show the numbers of female and
male employees. Use the first row of the grid to show the number of
female employees (example: 32, 25, 30) and the second row to show
the number of male employees (example: 30, 28, 28).

Bar Stacked Bar

Employees. Employees

urnder 00 30-50 S0+ under 30 0-50 50+
Age Aqe
Wlamels Elmak Wiéeraie Emoiz

100% Stacked Bar Line

Employees Employzes

fe
Wremae Edmak —femak --mak

If you select Pie, this Chart Title dialog box appears:

<< SHART TITLE >>

Type title and press RETURN.

* TITLE: The title of the pie chart (example: Employees). The
maximum length is 30 characters.
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pTo create a Pie chart:
1. Type the title for your pie chart and press RETURN. This Chart Data

dialog box appears:

<< CHART DATA >>
LABEL |l
DATA 1
| Type data and press CODE + RETURN.

If you need to delete while * LABEL. The data you want in each portion of the pie (example: under
entering information, see Deleting 30, 30-50 504). You can enter a . f 12 label
data on page 65. ! ! ) maximum o .
* DATA. The numeric information, which appear as relative
percentages.

If you use the same example as the bar charts on the previous pages,
you cannot show the number of female and male employees
separately. Enter the sum of these numbers for each age bracket (62,
53, and 58).

2. After entering your information in the Chart Title and Chart Data
dialog boxes, press CODE + RETURN. The dialog box below appears
showing the chart you created with the information you entered:

XyZ
J¢ ©0.0%; bhn
Use cursor to select and press RETURN.
NSRRI (PRE-STEP] [CANCEL]

3. Press ¢« and — to select an option and press RETURN.
¢ INSERT IN TEXT. Inserts the chart into your document. A chart
symbol [€] appears in the dead column. The title of the chart and
an icon showing the type of chart appear in your document.
When you print, the complete chart prints.
* PRE-STEP. Returns to the Chart Data dialog box.
* CANCEL. Cancels the function. This dialog box appears:

OK to dalate all CHART DATA?

4. If you select YES, the Create New Chart function cancels and your
information is lost. If you select NO, you return to the Chart Format

dialog box.
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Deleting Data

Press CODE + D while entering information to delete only the input
information. This dialog box appears:

OK to delete all input data?

Use cursor to select and press RETURN.
(TES? (NO]

If you select YES, everything within the chart (the legend, x-axis item, and
all numeric information) is deleted, but the Chart Data dialog box remains
in the window. Select NO to return to the dialog box without deleting.

Final Points
* The numeric information can consist of a maximum of 15 digits
(maximum 5 digits after the decimal point).

* Numeric values greater than 10,000 or smaller than 1 are shortened
using these symbols:

10,000 10K (thousand)
10,000,000 10M (million)
0.01 10m (milli)
0.00001 10 (micron)

* Negative values are set as zero.

p-To edit a chart:

1. Move the cursor to the line with a chart (symbol C) you want to
edit.

2. Press MENU to see the menu bar; select Edit Chart from the Graphics
menu. The following screen appears:

Edit this CHART?

{Use cursor to select and press RETURN.
fYEE]

3. Select YES to edit the chart or NO to cancel the function. If you select
YES, the Chart Format dialog box appears. Proceed as you would
when creating a new chart,

p-To create lines and frames within your document:
1. Press MENU to see the menu bar; select Line Framing from the
Graphics menu. This dialog box appears:

<< FAAMING 5> NMove la miarl gosiion B RETURN, SPACE for line.
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The cursor is replaced with the cursor symbol [<].

2.. To draw a line, move the arrow to the start position for the line;
press RETURN. The previous message is replaced with:

Move to line end & RETURN to draw. DELETE to undo. 1

3. Press the arrow keys or TAB to move the cursor symbol [<] to the
end position for the line and press RETURN. (You can also press
DELETE to delete the line.)

Keys Cursor movement

T 5/60 inch

2

— 10/100 inch

—

SHIFT + T 1/60 inch

SHIFT + !

SHIFT + « 2/100 inch

SHIFT+ >

CODE + T Moves the cursor to the next frame line, left margin, or right

CODE + margin

CODE + «

CODE + >

TAB Moves to the next tab, right margin, right edge, or in
multi-columns, next column

s After the start position is set and the cursor is moved, a [+] sign
appears at that position.

* Move the cursor horizontally for a horizontal line, vertically for a
vertical line, or horizontally then vertically to draw 2 box whose
diagonal is defined by the start and end points.

* If you press [ . ] while moving the cursor horizontally or vertically
in the mode to set the end point, a [+] sign appears at the
position. When you set the end position, press RETURN and you
can draw any complex frame.

* You can set frame line thickness by pressing the SPACEBAR to
alternate between THIN or THICK.
4. Repeat steps 2 and 3 to draw all the lines.
* To change the thickness of an existing line, redraw it with the new
thickness.

* A frame cannot contain more than 23 rows or 30 columns. The
sample table below has four columns and three rows:

If you try to exceed the limit, this dialog box appears:
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Editing a frame

(e

Enlarge/Reduce
Deleta All
Exit

You cannot combine several

colors in the Line Framing mode.

if the frame exists in the file
before you set the color of the
frame, its color changes to the
new color.

The default color is black.

This function is available only

when the cursor is located on the

edge of the cell.

[L Crossed positions full! ]

Press any key to continue.

5. When the frame is complete, press MENU to see the menu bar; select
Exit from the Operate menu to return to the Input/Edit screen. A
Frame symbol (L] appears in the dead column. This symbol contains
the format information as well as the frame information. If there
aiready is a Format Change symboi where the Frame symboil is to
appear, the Frame symbol replaces the Format Change symbol. You
see the Frame symbol at the beginning of the paragraph the cursor
was on when you started the Line Framing function.

Use the Operate menu to color and edit frames.

* Color. Selects the color of frames

* Enlarge/Reduce. Enlarges or reduces frames
* Delete All. Deletes all the lines in a frame

¢ Exit. Finishes the Line Framing mode

To edit an existing frame, place the cursor anywhere within the frame text
area. Select Line Framing and continue as you would in creating a new
frame.

If you place the cursor outside the frame area and start the Line Framing
function, the Desktop Publisher assumes that you want to create a new
frame.

P To select the color of frames:
1. Press CODE + COLOR. The Color dialog box appears:

<< COLOR »>
BLACY,
BLUE
GREEN
CYAN
RED
MAGENTA
YELLOW

Press t,4 to change setting and press RETURN. |

2. Press the arrow keys to move the cursor to 2 setting.
3. Press RETURN.

p-To eniarge or reduce a frame:

1. Move the cursor to the right bottom corner of the cell which you
want to enlarge or reduce.

2. Press MENU to see the menu bar; select Enlarge/Reduce from the
Operate menu. This message appears:
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Cursor to adjust size & RETURN. CODE + T, L, —, —moves
cursor.

Use the following key combinations to enlarge or reduce frames:

Key Cursor Movement

«— educes the frame 1/15 Inch to the Te

- Enlarges the frame 1/1g inch to the right

T Reduces the frame 1/47 inch at the top

i Enfarges the frame 1/12 inch at the bottom

SHIFT + « Reduces the frame 1/gg inch to the left

SHIFT + — Enlarges the frame 1/gg inch to the right

SHIFT + Reduces the frame 1/5g inch at the top

SHIFT + 4 Enlarges the frame 1/gp inch at the bottom

CODE + « Moves the cursor to the next line without
changing the size '

CODE + - Moves the cursor to the next line without
changing the size

CODE+ T Moves the cursor to the next line without
changing the size

CODE + ! Moves the cursor to the next line without
changing the size

3. Press RETURN when finished.

pTo delete all the lines of a frame:
Press CODE + D. This dialog box appears:

Delata?

‘Use cursor to select and press RETURN. |
[VES] [NC]

Select YES to delete all of the frame information or NO to cancel.

p-To exit the Line Framing mode:
Press CANCEL.

pTo copy a chart or frame to another location:
1. Move the cursor to the line with a Chart symbol [C] or Frame symbol
[E] to be copied.
2. Press MENU to see the menu bar; select Copy Graphic from the
Graphics menu. The arrow cursor appears next to the [C) or [L]
symbol and this message appears:

Copy?

Use cursor to select and press RETURNMN.
ES] INO]

3. Select YES to copy or NO to cancel the function. If YES is selected,
this message appears:
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lMove cursor to destination of copying and press RETURN.

4. Move the cursor to the new location and press RETURN.

pTo delete a chart or frame:

1. Move the cursor to the line with a Chart symbol [C] or Frame symbol
[L] to be deleted.

2. Press MENU to show the menu bar; choose Delete Graphic from the

Graphics menu. The arrow cursor appears next to the [C) or [L)
symbol and this message appears:

Delete?
\UJse cursor (o select and press RETURN.
EZ] INO]

3. Select YES to delete the chart or line or NO to cancel.

If you select Delete Graphic or Copy Graphic when the cursor is not

located on the line with a Chart symbol [€] or Frame symbol [L ], this
message appears:

Format mark does not exist at this position!
Press any kay to continue.
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Using the Option Menu

Chack during Typing ONIOFF
Llser Diclionary Mainienance
Auto Latter Layout

Iype Thesaurus

Edit Thesaurus

Word Count

Total Word Count

Use the Option Menu to check spelling, maintain a user dictionary or
abbreviated phrase file, or to format a letter with an automatic layout.

* Abbreviated Phrase Maintenance. Edits, loads, and saves an
Abbreviated Phrase file

* Spell Check All. Checks spelling in a file
* Check during Typing ON/OFF. Checks spelling while typing

¢ User Dictionary Maintenance. Edits, loads, and saves a User
Dictionary file

* Auto Letter Layout. Pre-defines formats for your letters

* Type Thesaurus. Lists synonyms (another word with the same
meaning) for a word

* Edit Thesaurus (below Type Thesaurus on menu). Lists synonyms for
the word at the cursor in a file

s Word Count. Checks the document and shows in the window how
many words you have used.

s Total Word Count. Gives the total number of words in the document.

Abbreviated Phrase Maintenance

This function allows you to create, edit, print, load, and save an
abbreviated phrase file, which is your list of short, often used phrases.

The abbreviated phrase function helps you increase your typing speed
when you have to type the same phrases repeatedly. You can store the
phrases in the abbreviated phrase memory along with a short name for
the phrase.

For instance, you can store the phrase United States of America together
with the name USA. Once this has been done, all you have to do to enter
United States of America in your document is type USA and press CODE +
ABBR. USA is replaced automatically with United States of America. (If
you type a name that does not exist in the abbreviated phrase memory
and press CODE + ABBR, you hear a beep.)

The abbreviated phrase memory can be saved on diskette and then
retrieved from the diskette. You can create as many abbreviated phrase
files as you want, but you may have only one abbreviated phrase file on a
diskette.

Understanding the Abbreviated Phrase Memory

The abbreviated phrase memory is stored in the system for as long as the
Desktop Publisher is turned on. If you create phrases and would like to
use these phrases in other files you plan to create later, you need to save
the phrase memory onto a diskette.

To use the phrases that are stored on a diskette, you must load the file
into the memory of the system. For best results, follow these rules:
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* Each diskette can hold only one abbreviated phrase file. If you
save an abbreviated phrase memory onto a diskette that already

contains an abbreviated phrase file, then that file will be overwritten
by the new abbreviated phrase file.

¢ The memory of the Desktop Publisher can hold only one abbreviated
phrase memory at a time. If you create an abbreviated phrase memory
and then load an abbreviated phrase file from a diskette, the

abbreviated phrase memory in the system will be overwritten by the
file loaded from the diskette.

Creating and Editing an Abbreviated Phrase File

Delelte Al
FBrint

Load
Have

Exit

Press MENU to see the menu bar; select Abbreviated Phrase Maintenance

<< ABBREVIATED PHRASE >>

ts 1 Tom Smith
w 3 typewritar
[ jr3tsa o ckzoaz o=

To add, type phrase. To edt, press RETURN. For olher oplions, press MENUL

A list of the abbreviations and corresponding long pbrases in the current
abbreviated pbrase memory appears.

To add a new phrase. Type the abbreviation, press TAB to switch to the
long phrase area; then type the phrase and press RETURN.

OR

To edit a line. Select the line and press RETURN. The information
appears in the input area. Edit the information; then press RETURN again.

s Use only letters, extra characters, numbers, and periods for the
abbreviation.

For other operations. Press MENU. You can select the following options
from the Operate menu:

* Delete. Deletes an entry (press CODE + D). This message appears:
[Move cursor to delete and press RETURN.

Select the entry you want to delete and press RETURN.
* Delete All. Deletes all entries. This dialog box appears:
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QK to delete all phrases in abbreviated phrase rmemory?

Use cursor to select and press RETURNL

"ES)

Select YES to delete all words or NO to cancel.

¢ Print. Prints the current abbreviated phrase memory.

Insert a sheet of letter-size paper and press RETURN to start printing.
This message appears:

Use black ink cartridge to print this data at best

Printing....press CANCEL to stop printing.
cuality and speed. Check print menu settings.

You can stop printing at any time by pressing CANCEL. This dialog box
appears:

CHK to cancel printing?

Use cursor to select and press RETUWURMNL

ES] [NO]

Select YES to cancel printing or NO to cancel the function. See page 83
for more details.

* Load. (Loads an abbreviated phrase file from a diskette) Before
selecting Load, insert a diskette with an abbreviated phrase in the disk
drive. If an abbreviated phrase memory exists in the memory, this dialog

box appears:

Abbreviated phrase memory already exists in memory!
Overwrite?

Use cursor to select and press RETURN.

EZ] INO}

Select YES to overwrite the current abbreviated phrase memory or NO
to cancel the function. Remember that you can have only one
abbreviated phrase file in the memory. If the diskette does not contain
an abbreviated phrase file, this dialog box appears:

Insert disk with abbreviated phrase file you created and retry.

|Use cursor te select and press RETURN.

Insert another diskette and select RETRY or select CANCEL to quit.

e Save. (Saves the current abbreviated phrase memory on a diskette.)
Before selecting Save, insert a diskette in the disk drive. If the diskette
does not contain an abbreviated phrase file, the current abbreviated
phrase memory is saved immediately. If the diskette already contains
an abbreviated phrase file, this dialog box appears:

Abbreviated phrase memory already exists on diski
Ouerwrita?

U
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Spell Check All searches for
misspelled words or capitalization
errors from the beginning of the
file or from the current ctirsor
position; however, it does not
replace careful proofreading. It
has no way of knowing, for
example, whether words are
missing or whether a given word
is grammatically or syntactically
correct. If you type “teh” instead
of “the”, spell check aletis you,
but if you type “one” instead of
“on”, it does not consider it a
mistake.

Misspelled Words

Select YES to overwrite the abbreviated phrase file stored on the
diskette or NO to cancel the function. Remember that you can have
only one abbreviated phrase file on a diskette.

¢ Exit. Exits Abbreviated Phrase Maintenance.

pTo check spelling in text:

1. Press MENU to show the menu bar; choose Spell Check All from the
Option menu. The DICT indicator on the status line is bighlighted
and the Spell Check dialog box appears:

<< SPELL CHECK >>
START POSITION SET

Use cursor to select and press RETIUJRMNL

=SSR [TOF OF FILE] TCANCEL]

2. Press « and — to select and press RETURN.
* CURRENT. Starts Spell Check from the current cursor position
* TOP OF FILE. Starts Spell Check at the beginning of the file
* CANCEL. Exits Spell Check

While Spell Check scans your file, this message appears:

Working.... ]

If a misspelled word (a word not in the Spell Check dictionary or in your
User Dictionary) is found, this dialog box appears:

Spelling mistakaeal

< SUSPECT WORD >
boen

IUse cursaor to select and press RETURN.
{EREEE (SUGGESTION] [RETYPE] [ADD)])

[CANCEL]

Press ¢ and — to select and press RETURN.

* IGNORE. Leaves this word unchanged and resumes scanning. Use this
option for a2 word that is correct though not standard English and
when you do not want to add the word to your User Dictionary (a
name seldom used in your files, for example).
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* SUGGESTION. Gives a list of similar words. Press T and { to select the
correct word, and press RETURN to replace the misspelled word in
your file with the correct word automatically. If the word is not listed,
press CANCEL. If the system has nothing to suggest, press RETURN. In

both cases, you return to the Spell Check dialog box where you can
select another option.

<< SUGGESTION >
SUGGESTICMNI(S):

oo |
Ben

bon
boon

< SUSPECT WORD > 1
boen

Select word and press RETURNL.

* RETYPE. Allows you to enter a word when you think it is faster than
asking for a suggestion, or when the system does not suggest a word.
Type the correct word in the dialog box, and press RETURN to replace
the misspelled word in your file and continue scanning.

<< RETYFE »>>

< SUSPECT WORD >

Type word and press RETURMN.

e ADD. Allows you to enter the correct words not in the Spell Check
dictionary but which are correct and frequently used in your files. If

the word is accepted, it is inserted in your User Dictionary and this
message appears:

IWord added to user dictionary. l

If you have no User Dictionary, the Desktop Publisher creates one. If
the word cannot be added to the User Dictionary, the dialog box

shown below appears. Press RETURN to return to the previous dialog
box:

Speliing mistake!

< SUSPECT WORD >

linvalid for dictionary. Press RETURN.

Once a word is in the User Dictionary, Spell Check does not stop when
the word appears again.

* CANCEL. Stops Spell Check and returns to the document.

Redundant Words

If a redundant word (a word that is repeated, like “and and”) is found,
this dialog box appears:
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Capitalization Mistakes

Redundancy error!

< REDUNDANCY >

Use cursor to select and press RETURN.
RIS (ERASE SECOND WORD)

Press < and — to select the word and press RETURN.

* IGNORE. Leaves the word unchanged and resumes scanning

* ERASE SECOND WORD. Automatically deletes the repeated word and
resumes scanning

* CANCEL. Stops Spell Check

If a word with incorrect capitalization is found, this dialog box appears:
(The procedure is the same’as when a misspelled word is found.)

Capitaliz ation error!

< SUSPECT WORD >
BOstonr

Use cursor to select and press RETURN.
RS (SUGGESTION] [RETYPE] [ADD] [CANCEL]

Check during Typing ON/OFF (Spell Check)

When you select Check during Typing ON/OFF from the Option menu,
the DICT indicator on the status line is highlighted, and Spell Check
checks your text as you type it. Unless you make mistakes, you do not
notice that Spell Check is running. When you make a mistake (misspelled
or redundant word, capitalization mistake), the appropriate dialog box
appears. Continue as you would with the Spell Check All option.

To turn this feature off, select Check during Typing ON/OFF from the
Option menu.

User Dictionary Maintenance

The User Dictionary allows you to
add new words, delete old ones,
save the User Dictionary file on
diskette, or load a User
Dictionaty fife from diskette.

Spell Check comes with a built-in dictionary containing standard English
words. (You cannot change the built-in dictionary.)

Spell Check also, however, stops at such words as people’s names,
company names, or other non-English words, even if they are correct. To
prevent this from happening, create your own dictionary. When you have
such a User Dictionary in memory, Spell Check does not stop at a word
that is in your User Dictionary.

You create a User Dictionary when you select Add in Spell Check to add a
word to the dictionary.
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This dictionary is held in memory as long as the Desktop Publisher is
turned on. If you add words to the User Dictionary and want to use the
same dictionary for checking other files, save the User Dictionary onto a
diskette before turning your system off. Later, when you want to use that
same dictionary, load the dictionary from the diskette. When working with
the User Dictionary, keep the following limitations in mind:

¢ Each diskette can hold only one User Dictionary. If you save a User
Dictionary onto a diskette that already contains one, the dictionary
previously on the diskette is overwritten by the new user dictionary.

* The memory of the Desktop Publisher can hold only one dictionary. If
you create a dictionary in the memory and then load a dictionary from
a diskette, the one currently in memory is overwritten by the dictionary
loaded from the diskette.

p-To add a word to the User Dictionary:

The S'ZP’ES!‘ way fo add a word 1. Press MENU to see the menu bar; show User Dictionary Maintenance
i;g;ie_ ;f;ﬁ'ggogpag r’Jsirt:othe from the Option menu. The User Dictionary dialog box shown below
Spell Check dialog box. A second lists the words in the current User Dictionary:

€€ USER DICTIONAAY MAINTENANCE >

way to enfer words in the User
Dictionary is to use the User
Dictionary Maintenance option.

TQrAL:
© word(s)

LIST;

< MESSAGE >

< HOW TO EDIT USER DICTIOMNARY >

To add, lype word and prass AETUAN.
Prass MENU far othar optinns.

 RARRRERXERII1R)

2. Start typing the new word. The cursor moves to the entry field at the
top of the dialog box.

3. Press RETURN. The word appears in the list.

p-To edit the User Dictionary:

f operate B 1. Press MENU to see the menu bar; select User Dictionary Maintenance
from the Option menu. The User Dictionary dialog box lists the words
All in the current User Dictionary.

2. Press MENU to see the menu bar; press O to select the Operate
menu. You can select from the following options on the Operate
menu: »

* Delete. Deletes a word (shortcut: CODE + D). This message
appears:

Move cursor to delete and press RETURN.

Press T or { to select the word you want to delete and then press
RETURN.

¢ Delete All. Deletes all entries. This dialog box appears:
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OK to deilate all words In user dictionary?
Use cursor tlo select and press RETURN.
[NO]

Select YES to delete all words or NO to cancel.

* Load. Loads a User Dictionary file from a diskette. Before
selecting Load, insert a diskette with a User Dictionary in the disk
drive. If a User Dictionary is already in memory, this dialog box
appears:

User dictionary already exists in meameory!
Cuarwrite?

Use cursor to seiect and press RETURML
[V EZ=] [NO]

Select YES to overwrite the current User Dictionary or NO to
cancel. Remember that you can have only one User Dictionary in
the memory.

OR

If the diskette does not contain a User Dictionary, this dialog box
appears:

Insert disk with user dictionary file you crealed and relry.

\Use cursor to setect and press RETURN.

Insert another diskette and select RETRY or select CANCEL to quit.

* Save. Saves the User Dictionary on a diskette. Before you select
Save, insert a diskette in the disk drive. If the diskette does not
contain a User Dictionary, the current User Dictionary is saved
immediately. If the diskette already contains a User Dictionary,
this dialog box appears:

User dictionatry already exists on disk!
Overwrite?

Use cursor to select and press RETURMN.

[P ES) {NO]

Select YES to overwrite the User Dictionary stored on the diskette
or NO to cancel. Remember that you can have only one User
Dictionary on a diskette.

¢ Exit. Exits from the User Dictionary mode.

Auto Letter Layout

The Auto Letter Layout function allows you to use predefined formats for
your letters. For more information, see Auto Letter Layout on page 222.
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P> To use Type Thesaurus (with the word “book” as an
example):

L. Instead of typing the word in your text, press MENU to show the

menu bar; choose Type Thesaurus from the Option menu. The
thesaurus asks for a word:

<< TYPE THESAURUS »>

SPECIFIED WORD:

Type word and press RETURN.

2. Type the word (“book” in our example) and press RETURN. 7he
Thesaurus dialog box appears:

Model DP-530CJ

2< THESAURUS »>

|_< SPECIFIED WORD » book

1
MEANING(S): Verbl Verbz
bvalume ] tome

L ME A MG,
ctword and pressz RETIURM.

MEANING(S). Lists the possible parts of speech for the specified
word. In our example, “book” can be 2 noun or a verb.

Model DP-540CJ, DP-550CJ, & DP5040CJ

<< THESAURUS >>

[ <sepeciFiEo woro > book |
MEANING(S]: 5YNONYMIS):
Llec o sl s @m 1
Verb! engage Ome
Verb: list

A printed and bound weork.

Press t, 4 to selecl MEANING.

MEANING(S). Lists the possible parts of speech for the specified
word. In our example, “book” can be a noun or a verb. In the
DP-400CJ and the DP-5040C] a short definition of the word is given.
Synonyms appear in the box on the right.

3. Press < and — to go from one column to the other. Press T and | to
move inside a column.

4. Press RETURN to insert the selected word in your text or CANCEL if
you cannot find an appropriate word.

s If the Desktop Publisher cannot find a synonym for the specified
word, this message appears instead of the Thesaurus dialog box:

<< TYPE THESAURUS >»

Mo synonyms!

SPECIFIED W
Press any key to continue.

T!_JF\E weard and press
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P To use Edit Thesaurus:

;’;: wi“of’:ffiiﬁ :‘:ﬁ’:f’; it 1. Move the cursor to the word that you want to replace. Press MENU
a better synonym automatically, to show the menu bar; choose Edit Thesaurus from the Option
Use this function when revising menu. The Thesaurus dialog box appears.
text
- 2

. Select a synonym in the same way as you would with the Type
Thesaurus function. Press RETURN to replace the current word with
the selected synonym.

Word Count

This function scans your text in word processing mode and tells you how
many times a given word has been used in current file. It also allows you
to search for each occurrence of any given word. Words are given in
descending order of frequency.

pTo use Word Count:

The system counts words of more 1. Press MENU and select Option; then select Word Count from the

than one character. It also counts . . .
all letters of the alphabet. Other function menu. The following window appears:

symbols are treated as
separators of words.
Your Desktop Publisher can list

<< WORD COUNT >>
START POSITION SET

the words that are froquently
used in the document in the [TOP OF FILE] [CANCEL]
window.

2. Use « and — to move the cursor to a setting.
CURRENT: Scans the text from the current cursor position.
TOP OF FILE: Scans the text from the beginning of the file.
CANCEL: Cancels this mode and returns to the previous screen.

3. Press RETURN when you have made your selections. The system
starts counting and the results appear on the following screen:

<< WORD COUNT >

24 23 to
17 of 15 gyour
13 and 11 you
10 mr 9 far
S paument 8 letter
& an B be

To search, select a word and press RETURNL

4. If you want to search for each occurrence in the text of a particular
word, use «, =, T, or { to position the block cursor on the word;
press RETURN.

The system begins searching. If the selected word is found, it is
highlighted, and this window appears:

Replace?

(Use cursor to select and press RETURDM. :
! A (RETYPRPE] I THESAURUS] [CANCEL]

5. Use « and — to move the cursor to a setting.
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IGNORE: Leaves this word unchanged and resumes scanning
RETYPE: Allows you to type a word in yourself

Type the word in the window and press RETURN to replace
the current word in your file and resume scanning. Up to 25
characters can be typed.

<< RETYPE >>

Type word and press RETURRMN.

THESAURUS: Gives the screen of Thesaurus mode

<< THESAURUS >>

| < sreciFiec worp > partial : ]
MEANING(S): EYNONY M(S):
m IIiTﬁﬁﬁ Is

dj.: partisan preferential

RdJ.: Tragmentary

Disposed to Tavor one over
another.

MNress t, 4 to select MLCANITNG.

Press «, » to select word and press FIETURNMN.

pTo select synonyms using Thesaurus:

1.
2.

Total Word Count

Use «, —, T, or { to select the word.

Press RETURN to replace the selected word in your text, or CANCEL
if you cannot find an appropriate word. If the RETURN key is
pressed after selecting the word, the Thesaurus mode will be closed
automatically and scanning resumed. (See the Thesaurus section for
more details.)

CANCEL: Cancels this mode and returns to the previous screen.
When the selected word cannot be found, this message appears:

Word(s) not found.

The Total Word Count function calculates the total number of words in the
current document automatically.

1.

The following codes are treated 2.

as word separators: SPACE,
RETURN, P IND, Centering,
Right Margin Flush, TAB, P
BREAK, COL END.

Press MENU and select Option; then select Total Word Count from
the function menu. The system begins searching and the results
appear in the window:

<< TOTAL WORDS >>
<

Press any key to continue.

Press any key to return to the Input/Edit screen.
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Using the Screen Menu

B e Use the Color Screen menu to turn on/off the scale line, use text symbols,
Of type in two screens.

Scale Line ONIOFF

Function Mark ONIOFF
Color Mark ONIOFF * Change Screen. Moves the cursor from one file to the other in Dual

Splt Size Screen mode

* Scale Line ON/OFF. Switches the scale line on or off
* Function Mark ON/OFF. Switches the text symbols on or off

* Color Mark ON/OFF (below Function Mark ON/Off). Makes the
colored text stand out.

* Split Size(Models DP-540CJ, DP-550CJ, & DP-5040CJ only). Adjusts the
size of the screen area used to show each file in Dual Screen mode

Change Screen

The Change Screen option allows you to go from one file to the other in
Dual Screen mode.

Press CODE + Q to change the screen. The file name of the active file
(the file where the cursor is located) is highlighted. The cursor moves
to the last selected cursor position.

When you are using the Dual Screen mode, the following information is
shared by the two files:

* Status of the keyboard (SHIFT LOCK, CAPS LOCK, NUM LOCK)

s Status of the Insert or Overwrite mode

Scale Line ON/OFF

The Scale Line ON/OFF option allows you to change the viewing space
for your documents.

Press MENU to see the menu bar; select Scale Line ON/OFF from the
Screen menu. The Scale Line switches on and off.

Function Mark ON/OFF

If Function Mark is tumed off, the . The Function Mark ON/OFF option allows you to turn the text symbols
Color Mark aiso disappears. (such as Return or Page Break symbols) on or off. Press MENU to see the
menu bar; select Function Mark ON/OFF from the Screen menu,

The Color Mark ON/OFF option allows you to recognize the colored
characters and easily edit them.

If Color Mark ON/OFF is turned on, the colored text will have a line

above the text.
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The Calor Inkjel Desktnp Publisherd
Ereate stylized documents, newsletters and brochu

‘? :
’1 The Colo IHE]EI UESE[DD Fu ElIS“E rd

Ereate stylized documents, newsletters and brochi

If Color Mark On/Off is selected again, the screen returns to normal
mode.

The default when opening the file is always “Color Mark is Off.”

Split Size (Model DP-540CJ, DP-550CJ, & DP-5040CJ only)

When you open a second file in Dual mode, the screen splits into halves.
The Split Size option allows you to change the height of one of the
windows so you can see more of one document.

pTo change the height of a window in Dual mode:

1. Press MENU to see the menu bar; select Split Size from the Screen
menu. A dotted line appears at the boundary line between the two
ﬂles

2. Press T and | to move the boundary line up or down; press
RETURN. If you press CANCEL instead of RETURN, the screen returns
to the condition it was in before you started the operation.

NS IR IR NN TR AN AN NN RN IR I PN SN NSO A NN NN R AN RN NN E ORI BN TN NGNS RN IRANNDANIRROED

Tl

FILE 2
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Using the Print Menu

Screen Use the Print menu to preview and print your document.

Erint |l .
* Print. Prints your document

* Layout. Previews your document so you can proof it before printing.

p-To print a document:
1. Press PRINT. The Word Processing Print Menu dialog box appears:

<< WORD PROCESSING PRINT MEMNUS >
STARTING PAGE: 1 HEADER FRINT: YES
ENDING PAGE: 2985 FOOTER PRINT: YES
NUMBER OF COFIES: 1 COLOR PRINT: YES
FPRINT GUALITY: MEDIUM MERGE PRINT: NO
IFILENAME: MES
ENVELOPE PRINT: NO

Type number and press RETURN.

2. Press T, |, «, and —» to move the cursor to a setting. Type the
values or press the SPACEBAR to change settings. Press RETURN
when you finish.

If you specify a starting page * STARTING PAGE: The page number of the first page you want to
number that does not exist, print
printing will not start.

¢ ENDING PAGE: The page number of the last page you want to
print. (The ending page number must be greater than the starting
page number.)

« NUMBER OF COPIES: The number of times you want the
document to print (maximum 999)

This model prints faster with the * PRINT QUALITY:
biack inkjet cariridge; therefore, . . A
use a black cartridge for biack FINE—For final copy quality printing
text and save the color cartridge MEDIUM~—For average print quality
for color printing only. . - . . . .
rcolor prning oy DRAFT—For trial printing. (You save time and ink with this
setting.)

e ENVELOP PRINT:
YES—For printing on envelops and thick paper only
NO-—For printing on normal paper

¢ HEADER PRINT:

YES—Prints headers (has no effect if you have not defined
headers)

NO—Prints without headers

¢ FOOTER PRINT:
YES—Prints footers ¢(has no effect if you have not defined
footers)
NO—Prints without footers

* COLOR PRINT:
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YES—IF color inkjet cartridge is installed on the machine, the
document will print in color. (Even if YES is selected, your
document will print in monochrome when using a
monochrome inkjet cartridge.)

NO—The document will print in monochrome. Using a
mono-inkjet cartridge is recommended.

* MERGE PRINT:

YES—Merges information from an Addressbook file into your
document. When you select Yes, this message appedrs:

Press TAB to open MERGE FILE INDEX.

Press TAB to list Addressbook files on the diskette.

Press the arrow keys to select a file name and press RETURN.
The file loads and the file name appears under MERGE
PRINT/YES.

NO—Prints without merging. (This setting cancels merge
printing even if you have selected an Addressbook file.)

The maximum fength of paper 3. Press RETURN when finished. This message appears:

that can print is 14 inches.
Printing....press CANCEL to stop printing. I

If you press CANCEL to stop printing, this dialog box appears:

Use cursor to select and press RETURN.
= {NO]

OK to cancel printing?
[TES

Select YES to cancel printing or NO to continue printing.
* If the paper has not been inserted or is jammed or cannot be
ejected, this message appears:

Faper feed proklem!
Insert paper correctiy.
OK to continue printing?

Use cursor i select and press RETURDML.
[NO]

[(TE=

You may wish to turn the machine off before attempting to
remove the jammed paper manually. (Be sure that the information
is stored on the disk before turning off the machine.)

OR
Press CODE+ SHIFT + HELP to eject the paper; select YES to
continue printing or NO to cancel.

¢ If the paper is shorter than specified in Page Setup, this message
appears:
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Incorrect papér size!
Check page setup menu or insert correct paper.
OK lo cancel printing?

Select YES to cancel. Select NO to restart printing. The part of the
Pprevious page that could not print, prints from the top of the new
sheet of paper.

* If the text extends outside the printable area, printing stops and
this message appears:

Data will be truncated!
Check page setup menu and rmargin setlings.
Do you still want to continue printing?

Use cursor to select and press RETURDN.
==

Select YES to truncate (cut off) text and continue printing or NO
to stop printing to check margin settings.

The system always checks the type of ink cartridge installed on
the machine. If the setting Color Print does not match the type of
inkjet cartridge, one of the two following messages appear:

ﬁ'tinting....press CANCEL to stop printing.
Use black ink cartridge to print this data at best
quality and speed. Check print menu seltings.

Printing....press CANCEL to stop printing.
Printing with black ink carlridge.
Use color cartridge to print color. Check print menu sellings.

Press CODE + SHIFT + W to delay printing for any reason. 7he
Jollowing screen appears:

<< PAPER INSERTION >>

Frezs SFATE by change satting and press FL_ETUFL:"-J,
Press SPACEBAR to select a setting.

* AUTO—Feeds the paper without a delay

* 15-SECOND WAIT—Loads the paper 15 seconds after printing each
page

* 30-SECOND WAIT—Loads the paper 30 seconds after printing each
page

e MANUAL—Asks you to insert a paper manually. Each time printing a
page is completed, the message “Press RETURN to continue printing.”
appears. Set the paper and press RETURN to insert paper.
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Merge Printing

Merge symbols with a label name that does not exist in the Addressbook

file are ignored. The same happens when there is no information in the
Addressbook for the specified record.

If you select Merge Print/No for a document that contains Merge symbols,
the label names print as they appear on screen.

Using Layout to Preview a Document

Press T to preview the previous  The Layout option allows you to preview a full page as it appears when
page, and L to preview the next vy orine it. (In a multipage document, the previewed page is the one the
page. cursor is on when you start.)

1. Press CODE + LAYOUT.

2. Press RETURN to return to the Input/Edit screen. The page shown last
in the Layout screen appears.
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2 Spreadsheet
—————— e
What is a Spreadsheet?

In the past, financial records for any type of business or other organization were
always kept by hand in bound form, hence the term “keeping the books.” A sales
ledger, for instance, might be laid out as a graph with the months of the year across
the top and the names of sales personnel or merchandise down the left column. This
type of accounting tool had another name: it was called a “spreadsheet.”

Jan. Feb. Mar. Apr. May June July Aug. Sept. TOTAL
A) Household Ttems
Morgage/Rent 1,000 1,000 1,000 1,000 1,000 1,000 1,000 1,000 1,000 12,000
Heat/Water 110 t1o 100 BO 70 T0 &0 60 60 260
Gas & Electric a5 35 35 30 25 25 25 25 30 350

Phone 35 35 35 35 35 35 35 35 35 420

Even with an electronic calculator, bookkeeping is still a difficult task, especially
when making revisions or corrections. The major advantage of the electronic
spreadsheet is the ability to make corrections any time and have all the calculations
made for you, quickly and easily.
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Starting the Spreadsheet Program

You may create your own
spreadsheet or use one already
made for you. For information,
see Template on page 240.

Be sure to learn Spreadsheet
functions before using templates.

You can retrieve Spreadsheet
files created with your Desklop
Publisher (extension SPR} or
Spreadsheet files created with
Lotuse 1-2-3 (extension WKT).
Some Lotus® 1-2-3 files
automatically convert lo Desktop
Publisher's format before being
loaded. Since a particular Lotus®
1-2-2 file may use functions not
available on your Desktop
Publisher, the conversion is
sometimes incomplete. For
information, see Converting a
Lotuse 1-2-3= file into a
Spreadsheet file on page 153.

A spreadsheet file consists of a page of rows and columns where you can
type in information, such as figures or formulas, with which you want to
perform calculations.

> To create a new Spreadsheet or open an existing one:
1. Turn on the power to show the Main Menu.

2. If you want to retrieve a spreadsheet file from a diskette, insert that
diskette into the disk drive.

3. Press 2 to select the Spreadsheet icon. If you insert a diskette, the list
of Spreadsheet files stored on the diskette appears:

[P et o \ [EPDSorend- [P ddess- \

AMHEWNDS TR

4. Press the arrow keys to select the file you want to retrieve; press
RETURN. To start a new document, press RETURN. The Spreadsheet

Input/Edit screen appears.

Spreadsheet Input/Edit Screen

Status Line —
Input Area — ]

1 2
| I
ez _gwewoata [ NoRmAL _Jiafa]

1.

Column Name

| Row Number

—— Worksheet Area —

T

En-l;:r your spreadsheet data.
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The Spreadsheet Input/Edit screen is divided into three different areas:
Status Line. The status line shows your current settings.

1 The settings of the cell where the cursor is positioned {defauit:
Normal).

2 The column width status (default: 10 characters).

Input Area. Below the Status Line is the input area where you enter or
change the contents of a cell. The input area indicates which cell is
highlighted in the worksheet area.

Worksheet Area. The rest of the screen is called the worksheet area. It is
divided into cells, designated by their positions or address on the grid, so
that the cell at the top left of the worksheet becomes Al, the cell
diagonally to the right and below it B2, etc.

There are two different modes for creating and formatting your
spreadsheets:

Input/Edit mode. In the Input/Edit mode you can insert and change
information within individual cells. You know that you are in the
Input/Edit mode when a text cursor appears in the input area.

Press HELP to list the keys you Command mode. In the Command mode, you can move the cell cursor

can use in Spreadsheet n the worksheet, and you have access to the menu bar to perform large
(Input/Edit or Command modes). o ! Yy p g
scale changes.

Moving Around in the Screen

When the Spreadsheet Input/Edit screen appears, the cursor is in cell A1,
ready for you to type in information. You can move the cursor by pressing
«, =, T, and { to highlight any cell and to tell the Spreadsheet program
where you want to place the information. You will notice that only part of
the spreadsheet is shown on the screen. The spreadsheet extends far
beyond what the screen is able to show at one time. You can type in as
many as 256 columns and 256 rows.

It is also possible to move the cursor faster through the spreadsheet:

* CODE + an arrow key moves the cursor to a border of the screen,

* Press CODE + GOTO. 7his dialog box appears:

Type cell address and press RETURN or use arrow keys
to mowve to data top, bottomn, left or right.

Move the cursor to a particular cell by typing the cell address
(example: A1) and pressing RETURN.
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Pressing <— moves the cursor to the first column of that same row.
Pressing — moves the cursor to the last column containing information
in that same row. Pressing T moves the cursor to the first row in that
same column. Pressing | moves the cursor to the last row containing
data (information) in that same column. In each case, the cursor moves
vertically or horizontally in the direction of the arrow on the key top.
(Both ¢ and T move the cursor to the first column/row in that same
column/row [not the first column/row containing information]).

Entering and Editing Information

With a paper spreadsheet, you write the information directly in the cells of
the sheet. With an electronic spreadsheet, you highlight the cell in the
worksheet, then type or edit the contents of the cell in the input area.

There is a possibility that the To enter information in an empty cell, select that cell and type in the
:f::f:; ’;‘;?gf:;;g;’t’hf’;nﬁ;"f information. A text cursor appears in the input area as soon as you start
spreadsheet with information. it typing, which means that the Spreadsheet program switched to the

wams you of this with the Input/Edit mode. Press RETURN when you have finished. The information

message “Memory full! Press any  appears in the cell.
key to continue.” At this point,

’é‘e’:’e‘::;"%:':zz mﬁm:ﬂ Proceed in the same way to replace old information with new. The old
save yo;” file to the diskette and informati(?n disappears from tl'.ne input area as soon as you start typing.
continue with a new Spreadshest  The new information appears in the cell when you press RETURN after

file. typing.

To edit old information without deleting it, highlight the cell; press TAB.
The cursor appears in the input area and you may now edit the
information. Press RETURN when it has been edited.

While typing in the input area, you can use the following keys:

* All character keys, including special characters obtained with the
CODE, CODE+ E CHAR, and CODE + SYMBOL keys

* CODE + NUM-L to lock the keyboard in numerics

* CODE + P BREAK to enter a page break symbol [¥]; during printing,
paper is ejected at that point after the row prints

® CANCEL to restore the contents of the cell as they were before you
began editing. Use this when you mistakenly start editing a cell that
did not need editing

Do not worry if the information * BACKSPACE to delete one character to the left of the cursor
you type does not appear exactly

the same when itis transferredto -« DELETE to delete the character highlighted by the cursor

a cell. During that transfer, the

information is processed in * WORD OUT to delete one word to the left of the cursor
several ways. For example, a

formula is calculated or apiece of  ®* CODE + LINE OUT to delete all characters from the input area
fext is formatted. The result of

that process appears in the cell, * INSERT to alternate between the Insert and Overwrite modes
but the infarmation reappears in
the input area in its original form * « to move one character to the left

when the cell is selected again.
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* — to move one character to the right. If the cursor is to the right of the

last character, this key enters the information and selects the next cell
to the right,

* CODE + « to move the cursor to the first character
* CODE + — to move the cursor to the right of the last character

After typing or editing the information in the input area, you can transfer
it to the selected cell using one of these keys:

* RETURN to transfer the information to the cell and keep the same cell
selected

* — to transfer the information to the cell and select the next cell to the
right. This works only if the text cursor is to the right of the last
character in the input area

T to transfer the information to the cell and select the next cell above

! to transfer the information to the cell and select the next cell below

Entering Alphanumeric and Numeric Information

Your Spreadsheet program can handle two kinds of information: numeric
and alphanumeric.

Alpbanumeric information is made up of combinations of characters
(letters, digits, and other characters) used as a label or title to identify the
entries of the spreadsheet. Alphanumeric information is generally used as
a column heading, such as JAN. or ’12th Region. This information is not
calculated.

Numeric information are direct numbers or formulas and are calculated.

Since alphanumeric information can contain digits, and numeric
information can contain letters (cell addresses), it is important to
understand exactly how the spreadsheet program distinguishes between
alphanumeric and numeric information.

Follow these rules:

¢ If the information begins with one of these characters:
+-(@1234567890
the information is considered numeric.
Example: (A1) and 1+A1l are numeric.

* If the information begins with any other character, it is considered
alphanumeric, and the Spreadsheet program automatically inserts a
single quote mark ( ¢) before it in the input area. '

Example: ‘Cost and ‘Al are alphanumeric.

This single quote mark is called a format mark. (For more
information, see the next page.)
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Format Marks

A default single quote mark .
appears automatically in the input
area when the spreadsheet
recognizes your information as
alphanumeric. If you delete it, it
reappears when the alphanumeric
information is confirmed.

Instead of typing the format mark
for right alignment [*], you can
press CODE + R. Instead of
typing the format mark for
centering [A], you can press
CODE + F. If you press these
keys while in Command mode,
the Deskiop Publisher switches to
the Input/Edit mode and the
corresponding mark appears in
the input area.

* To make sure that information such as a telephone number or a date is

correctly interpreted as alphanumeric, be sure to type a format mark
before it.

Examples:

10-12-1996 is calculated (10 minus 12 minus 1996 = -1998) and
it becomes —1998 ‘

'10-12-1996 is not calculated; it remains 10-12-1996

* To make sure that a formula is not interpreted as alphanumeric, never
start a formula with a cell address. Instead, use the + sign or
parentheses.

Example: (A1+1) or +A1+1 are interpreted as formulas and are
calculated. If you do not start with the + sign or the left
parenthesis, the Spreadsheet program inserts a single quote
mark.

Format marks are typed before the information and tell the Spreadsheet
program that whatever follows is alphanumeric and is not to be
calculated.

Format marks also tell the Spreadsheet program how to position the
information in the cell. You can use one of these four format marks:

It

(single quote) to align the information to the left of the cell

(double quote) to align the information to the right of the cell
(CODE + R)

®  to center the information in the cell (CODE + F)
t  fills the cell by repeating the character following the mark

Format marks appear in the input area only (they never appear in the
cell). The above characters are interpreted as format marks when they are
typed in the first position of the input area. If they are typed in the middle
of the information, they are considered as common characters and appear
in the cell.

Maximum Length of Information

The maximum length of the input area is 240 characters (1 format mark
and 239 characters).

When alphanumeric information cannot fit into the cell, it uses the next
cells of the worksheet unless these cells are already occupied.
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Performing Calculations

Direct Numbers

This convenient feature is used for long titles (when you do not want to
disturb the layout of the spreadsheet by increasing the width of a
column). Please note that entering many long pieces of alphanumeric
information can cause the memory to become full before all cells are
filled. Also, adjusting the width of many columns to show long pieces of
alphanumeric information may cause the rows to be cut off when the
spreadsheet prints.

Numeric information consists of direct numbers or formulas and is
calculated. When information is recognized as numeric, Spreadsheet
checks whether it is valid. :

* If the information is valid, the result (a number) is calculated. If the
number can fit in the cell, it is automatically right aligned. If the
number cannot fit in the cell, a string of asterisks fills the cell. The
correct number is, however, kept in the memory and appears if you
adjust the width of the column.

s If the information is not valid, “ERROR” appears in the cell, and one
of the messages below appears:

When a denominator is zero:

Division by zaro!
Press any key to continue.

When a result is positive and contains more than 10 digits:

Numeric overflow!
Press any key to continue.

When a result is negative and contains more than 10 digits:

Numeric undarflow!
Press any key to continue.

If 2 number contains characters other than numeric ones, or a decimal
point (e.g. 1,000, 100$):

Invalid entry!
Press any key to continue.

A direct number is made up of digits and possibly a decimal point. Other
characters make the information invalid for calculation. The maximum
number of digits is 10 to the left of the decimal point and 5 to the right
(zeroes preceding other digits are not counted). Below are some examples
of valid and invalid numbers:
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Valid Invalid

1234 1,000 (comma is invalid)

0.94956 126$% ($ is invalid)

00001 12a12 (a is invalid)
000000000000001 99999999999 {more than 10 digits)
(zeroes are ignored)

Formulas

A formula consists of operators, operands, and possibly pairs of
parentheses to control the order of calculation.

Operators. An operator is a character that specifies the mathematical
operation to be performed. Operators recognized by the system are (in
order of precedence):

Symbol Operator

+- Positive and negative signs
# Exponentiation

*/ Muiltiplication, division

+— Addition, subtraction

The following rules apply to using operators in formulas:

* The + and - operators are considered as the positive or negative sign
of the following operand when they come first in a formula,
immediately after a left parenthesis or another operator.

* The # operator performs only integer exponentiation. If the exponent
(the next operand after #) has a decimal value, it is rounded to the
closest integer before exponentiation is performed. Therefore, this
operator cannot be used to calculate roots (although roots can always
be written as a decimal exponent in math). Zero with any positive
exponent gives zero. Zero with a negative exponent gives “Invalid
entry! Press any key to continue.”

* Division by zero is invalid.
* A sequence of three or more operators makes a formula invalid
(2 + x — 1 is invalid).
* A sequence of two operators is valid only if the second operator is a +
or — sign,
Example:
5 % —2 is valid and gives -10
1 - % 2is invalid
Operands. An operand is information in a formula on which a
mathematical operation will be performed. An operand can be a valid
number, a cell address containing numeric information, a function, or a

valid formula enclosed in a pair of parentheses. Below are examples of
valid operands:
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Valid Operand Operand Description

123 valid direct number

A1l orat cell address

@SUM{A1..B6) valid function

((A1+5)x2) valid formula enclosed in a pair of parentheses

Please remember the following rules about operands:

* A cell address can be written using either upper- or lower-case letters.
When a cell address must come first in a formula, it must be preceded
with a + or ~ sign or by a left parenthesis. Otherwise, the formula is
considered alphanumeric and is not calculated. Therefore, instead of
Al+A2, enter +A1+A2, (A1+A2), or (A1)+AZ2.

* If a cell that is referred to while doing a calculation contains
alphanumeric information, the formula is invalid, and “ERROR”
appears. An empty cell, however, is valid and assumed to contain zero.

Order of Calculation of a Formula

The calculation of a formula is performed in the following order:
1. The + or - sign is applied to the operand directly to the right of the sign.
2. Exponential calculations
3. Multiplication and division
4. Addition and subtraction
Example: 2#3x4-2
8x4-2
32 -2
30
When two or more operators have the same order of precedence

(multiplication and division or addition and subtraction), calculation is
carried out from left to right.

Example: 1+3+4-2 2#3#2
4+4-2 8#2
8-2 64
6

To change the order of calculation, you can use a pair of parentheses. The
formula in parentheses is calculated first.

Example: 1+3x4 1+3) x4
1+12 4 x4
13 16

Parentheses can contain other pairs of parentheses. Calculation starts from
the innermost pair of parentheses.

Example: BG4+ x 4+3) x4-12
(BBx4+3)x4-12
55 x4 - 12

Spreadsheet 95




220 - 12
208

One pair of parentheses can contain up to five other pairs. Using more
than five pairs of parentheses in one pair of parentheses makes the
formula invalid. The formula is also invalid if parentheses do not come in
pairs. You can use parentheses to make the information numeric. (Al+A2)
or (A1)+A2 can be used instead of +A1+A2.

Using Math Functions

Range of Cells

Typing in a Range

Math functions are used to make formulas shorter and easier to edit. A
math function performs specific operations on a single argument or on a
list of arguments. Arguments are included in a pair of parentheses
following the function name. A function name always starts with the
character @.

Example:
@SUM(1,A1,4,B6) returns the sum 1+A1+4+B6
@SUM(A1..B4) returns the sum A1+B1+A2+B2+A3+B3+A4+B4

* Some functions like @INT accept only one argument. In that case, using
more than one argument or using a range makes the formula invalid.

* A range can be used simultaneously with numbers or addresses.

Example:

@SUM(1,A1..B4) and @SUM(A23,A1..BG6) are valid.
A function is a valid operand of a formula and a formula is a valid
argument of a function.

Example:

1+A1+@SUM(B2..CS) is a valid formula.

@SUM(1+2), @SUM(+A1), and @SUM(1+A1) are valid.

A range is a group of cells enclosed in a rectangle and, therefore, can be
specified by the addresses of two opposite corners. When using math
functions, you specify a range using the notation A1..C3, for example. You
could also specify the same range with A3..C1, C1..A3, or C3..Al.

Range A1..C3,A3..01,
C1..A3,0rC3.. A1

O I W Ny o

Rather than typing in the cell address at each corner of the range, you can
mark and highlight the range to be used. Spreadsheet automatically
defines the top left and bottom right corners of the range.
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Suppose you want to calculate the sum of the range A1..C2 and show the
result in D2. First enter the information given below:

4 s5HA

1. Move the cursor to D2 and type @SUM(. As soon as you type the left
parentbesis of the function, this message appears:

IEnter cell specification. —I

2. Instead of typing Al, move the cursor to Al and press CODE + L.
@SUM(A1L.. now appears in the input area.

el @SUM(A1 . .1

2 3
4 5 ¢

4. Press RETURN. The cursor is back on D2, and the complete range
specification appears in the input area.

1 2 3
4 5 slN

The method of specifying cell addresses by moving the cursor instead of
typing the address can actually be used not only to specify 2 range in a
math function, but also to specify a single address in any formula.
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Spreadsheet Functions

Example: To enter (A1+B1) in C1, move the cursor to C1 and type (.
From this moment, the desktop publisher knows that the information is
a formula and allows you to move the cursor to a cell. Instead of
typing Al, move the cursor to Al and press +. The input area now
appears (Al+. You are again allowed to move the cursor to a cell.
Move the cursor to B1 and press RETURN. The input area now appears
(A1+B1). Press RETURN to finish and calculate the result.

Some functions can process only one or two arguments and are very
similar to the math functions. Arguments may include not only direct
number inputs but cell addresses as well.

The most sophisticated function of Spreadsheet is that it can process
multiple arguments. Arguments may be written individually, separating
each with a comma, or if all the arguments belong to a range, the range
can be specified by the addresses of two opposite corners, using two
periods as a separator. Arguments may be defined as a range or may
consist of any combination of direct numbers and cell addresses.

Functions using one or two arguments:

@ABS
Gives the absolute value of the argument. If the argument is positive
or zero, the same value is returned; if the argument is negative, the
opposite of the argument is returned.

@ABS(5) gives 5 @ABS(-5) gives 5

@INT
Gives the #nteger part of the argument. The decimal point and
subsequent decimal digits are removed without being rounded off; an
integer remains untouched.
@INT(5) gives 5 @INT(0.9) gives 0
@INT(1.1) gives 1

@MOD
Divides the first argument by the second and gives the remainder of
the division.
@MOD(10,3) gives 1 @MOD(2.3,2) gives 0.3
@MOD(0.33,2) gives 0.33

@REPEAT repeats the argument the number of times specified. Two
entries are required between the parentheses: the argument itself,
which must be a string of characters between a pair of double
quotation marks or the address of a cell containing alphanumeric
information, and a direct number that specifies the number of
repetitions. If that number is not an integer, it is first rounded off to
the closest integer.

@REPEAT(“Aa",2) gives AaAa
@REPEAT(“2",3) gives 222 (alphanumeric)
@REPEAT(A1,2) gives AaAa (if Al contains Aa)
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@ROUND rounds off the argument to the number of specified decimal places.
Twp entries are required between the parentheses: the argument itself and
a direct number that specifies the number of decimal places. If that number
is not an integer, it is first rounded off to the closest integer.
@ROUND(1.66666,2) gives 1.67
@ROUND(1.66666,3) gives 1.667
@ROUND(1.66666,2.1) gives 1,67

@ROUND(1.66666,2.5) gives 1.667

@SQUARE gives the square of the argument. The argument multiplied by
itself is returned; the result is always a positive number.
@SQUARE(5) gives 25
@SQUARE(-S) gives 25
@SQUARE(0) gives 0
@SQRT gives the square root of the argument. The result multiplied by
itself is equal to the argument. The argument may not be negative.
@SQRT(25) gives 5
@SQRT(2) gives 1.41421
@SQRT(-25) is invalid

Functions using multiple arguments:

@AVG gives the average value of the arguments. The sum of the arguments is
calculated; then that sum is divided by the total number of arguments.

@AVG(1,2,3,4) gives (142+3+4)/4 = 2.5
@AVG(175) gives 175/1 = 175

@COUNT gives the number of nonblank cells. This function is an
exception to the general rules in that the cell referred to may contain
either alphanumeric or numeric information.

@COUNT(A1,A2,A3,A4) gives 3 if Al contains 5 (numeric), A2 contains
your name (alphanumeric), A3 contains Error (this is not a blank cell),
and A4 is empty.

@IF checks whether a specified condition is verified and gives a value that
depends on the result of that check. The form of this function must be
@IF (condition, argumentl, argument2), and can be read as: if the
condition is satisfied, then show argument 1. If the condition is not
satisfied, then show argument 2. Arguments 1 and 2 can be direct
numbers, strings of characters enclosed in a pair of double quotation
marks (example: “ABC”), or a cell address. The condition is usually an
arithmetic comparison, using two values (number or cell address) and
one of the following comparison operators:

= equal to < = less than or equal to
< less than > = greater than or equal to
> greater than <> not equal to

@IF(A1>100,100,50) gives 100 if Al is greater than 100,
and 50 if Al is equal to 100 or smaller than 100

@IF(A1>100,100,A1) gives 100 if A1=200 and 60 if A1=60
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@MAX gives the greatest argument (maximum). Remember that a positive
argument is always greater than a negative one.
@MAX(1,234) gives 234
@MAX(1,-99999) gives 1

@MIN gives the smallest argument (minimum). Remember that a negative
argument is always smaller than a positive one.

@MIN(1,234) gives 1 @MIN(-1,99999) gives -1

@SUM gives the sum of the arguments. This function is used to shorten long
sums when the arguments belong to a range.
@SUM(1,2,3,4,5) gives 15
@SUM(A1,A2,A3,B1,B2,B3) is equivalent to @SUM(A1..B3)

@TSUM gives the total sum of a range of cells and also the sum of each row
and column of the range if they contain information. This function is an
exception to the general rules that the argument MUST be a range and
that results appear not only in the selected cell (total sum) but also in the
column to the right and in the row below the range. Therefore, you
must be sure that the column to the right and the row below the range
are empty.

Example:

1. Enter the numbers shown below in the range Al..C2; then type
@TSUM(A1..C2) in D3.

el @TSUM(A1..C2)B

2. Press RETURN. The results appear as foliows:
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Using Spreadsheet Menu Options

The following options can be found under the menu bar at the top of the
screen. This bar can be reached by pressing MENU.

File

B 4t Swie Use; the File menu to open, save, or close your files and to return to the
Main Menu. These function operate exactly the same as in Word
Processing (see page 38).

Treals Iew File
Open File

Save File

Open Fiie for Dual
Close File

File Management

Use the Edit Menu to make changes in the appearance or contents of
many cells, to rearrange the worksheet, or to extract part of the
information.

* Left. Aligns alphanumeric information to the left in a range of cells

s Center. Centers alphanumeric information in a range of cells

» Right. Aligns alphanumeric information to the right in a range of cells

You can press CANCEL at any * Search. Searches for occurrences of a specified string of characters
time to quit an option.

Replace. Searches for occurrences of a specified string of characters -
and allows for automatic replacement with another string

Fill. Fills a selected range with a specified arithmetic progression

L]

Sort. Sorts a specified group of rows

Select. Selects rows according to specified conditions; the selection can
be written in the worksheet and printed

Left, Center, and Right affect only cells containing alphanumeric
information in the selected range; numeric cells and empty cells will not

change.

Left, Center, and Right change the corresponding format marks ([‘] [*] [“])
in the input area of the affected cells. When the alphanumeric result of 2
cell is produced by a function like @REPEAT or @IF, the format mark is
not added, but the characters in the cell can be highlighted.
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The Left, Center, or Right option . To align text left, center, or right of a cell:
aligns all alphanumeric

information of a range to the left, 1. Move the cursor to a corner of the range of cells you want to format.
center, or right of the cells. Press MENU to see the menu bar; select either Left, Center, or Right
from the Edit menu. This message appears:

Move cursor to end of bhlock and press RETURN.

2. Move the cursor to the opposite corner of the range of cells you
want to format and press RETURN. The alpbanumeric cells of the
range are aligned to either the left, right, or center.

Search and Replace

These functions are described in Search on page 45 and Replace on page
46. Please refer to those sections for basic operations.

* The Search option can find both numeric and alphanumeric
information, but only if the information appears in the input area. For
example, you can find aaa in a cell only if it has been entered directly

into the input area. If the same information is entered as
@REPEAT(“2",3), you cannot find it.

* When replacing one string of information with another, this dialog box
appears if the replacement has to take place in a protected cell:

Protected cell error!
Press any key to continue.

» If the replacement string is longer than 240 characters, a dialog box
appears:

Word(s) too long!
OK to truncate data?

Jse cursor to select and press ARETURN.
INCY

Selecting YES omits the information in the replacement string to the

right of the possible 240 characters and carries out its replacement. NO
cancels the function.

The Fiil option allows you to B To use the Fill option:

number rows or columns or

numbers in a range quickly in 1. Move the cursor to a corner of the range of cells you want to fill.
order to check how math Press MENU to see the menu bar; select Fill from the Edit menu. This

functions are working.

Columns are filled from top to
bottom. Rows are filled from left
to right. In the case of a range,

the first column is filled first, then 2. Move the cursor to the opposite corner of the range of cells you
the second, etc.

want to format; press RETURN. The Fill dialog box appears:

message appears:

Move cursor to end of block and press RETURN.
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The Sort option allows you fo
rearrange your worksheet. When
adding additional information to it,
you usually add it at the end of
the file. To make the addition
easier lo find later, however, you
need some logical organization.
Alphabetical order is commonly
used, with the sorting feature
saving you time and effort in this
organization.

When a column that is selected
for primary or secondary sort
contains different types of cells,
the sort order is:
Empty cell < Numeric <
Alphanumeric < ERROR cell.

<< FILL =>
STARTING VALUE: [ |
JUMPING VALUE:

ENDING VALUE:

Type number and press RETURN.

3. Press T and { to move the cursor to a setting. Press the numeric keys
to enter the specifications. Press RETURN when you finish.

* STARTING VALUE; The first number of the arithmetic operation.

* JUMPING VALUE; The difference between two successive values.

* ENDING VALUE; The value that the arithmetic operation cannot
exceed. The cells fill up to either the Ending Value (or the closest

value less than it) or up to the last cell of the range, whichever
comes first.

Example: If the Starting Value is 5, the Jumping Value is 4, and the
Ending Value is 20, you get the numbers 5, 9,13, and 17.
(Because 21 is higher than the Ending Value, it is not included.)

P To sort information in a range of cells:

1. Move the cursor to a corner of the range of cells that you want to
sort. Press MENU to see the menu bar; select Sort from the Edit
menu. This message appears:

Move cursor to end of block and press RETURN. J

2. Move the cursor to the opposite corner of the range of cells you
want to format and press RETURN. Be careful to select all the
information of the rows. For example, if you have information in
columns A to E and you select only columns A to D in a range, the
cells in column E do not move along with the cells in columns A to
D, and it is impossible to reverse this situation.

After you specify the range, an arrow cursor appears above the
worksheet. A message asks you to move the arrow cursor to select
the column of the range according to the information to be sorted.

rMove cursor to primary sort column and press RETURN. |

This sorting option can perform a double sort, both primary and
secondary. A typical example of double sorting is when you have
information relating to people. You can use the family name for primary
sort and the first name for secondary sort.

3. Move the cursor to the primary sort column and press RETURN. 7his
message appears:

ﬁ\iove cursor to secondary sort column and press RETURN. J

4. Move the cursor to the secondary sort column and press RETURN. If
you do not need a secondary sort, leave the cursor on the primary
sort column. This diglog box appears:
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Direction?

Use cursor to select and press RETURN.
SRISIRIE) [DESCENDING] [CANCEL]

i

5. Press « and — to select ASCENDING, DESCENDING, or CANCEL
and press RETURN to sort.

¢ ASCENDING. Normal alphabetic order for alphanumeric
information, increasing values for numeric information (A-Z and
1—-100)

* DESCENDING. Reverse alphabetic order for alphanumeric
information, decreasing values for numeric information (Z-A and
100-1)

* CANCEL. Stops sorting and the previous screen appears

This option allows you to select iy To select rows of information:
rows of information that match a

condition that you select. The 1. Move the cursor to a corner of the range of cells that you want to
information can be shown on the select. Press MENU to see the menu bar; choose Select from the Edit
screen, written in the current menu. If you have not recalculated the spreadsheet since changing
worksheet, and printed. \

any cells contents, this message appears:

The sheet needs recalculation.
Recalculate?

iUse cursor to select and press RETURNL
== [NC]

Select YES and press RETURN.
OR

If the spreadsheet has not been changed since the last recalculation,
this message appears:

Move cursor to end of block and press RETURN.

Move the cursor to the opposite corner of the range of cells you
want to format and press RETURN. After you specify the range, an
arrow cursor appears above the worksheet. A message asks you to
move the arrow cursor to select a column for the range.

Move cursor to select column and press RETURN.

2. Move the cursor to the column where the select condition is to be
applied; press RETURN. The Select dialog box appears:

<< SELECT >>
CONDITION:
EQUAL TO:

Press SPACE to change selting and press RETURN.

3. Press SPACEBAR when the cursor is located on the condition. The
items that can be selected are indicated in the drop down list below:
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<< SELECT >>»

CONDITION:
EQUAL TC:

NOT EGUAL (WORD)
NOT EG

Press SPAC | s UaL (NUMERIC)
SREATER
BETWEEN

NOT BETWEEM

4. Press 1 and |, or SPACEBAR to move the cursor to a setting. Press
RETURN . Enter the information on the lower line of the dialog box.
Press RETURN when you finish.

* The conditions are: Equal, Not Equal, Less, Greater, Between, and
‘Not Between.

¢ All these conditions apply to numeric information, except Equal
and Not Equal, which can be set for alphanumeric information
(Word).

* With Equal(Word) and Not Equal(Word), the Desktop publisher
checks for an exact match of the first characters of the cells. If you
enter Equal to:BA, BANANA and BAY are selected because these
words start with BA; banana, B, B.A., and 1BANANA are not
selected. '

¢ The selected information appears in the Selected Data dialog box.

Example: Suppose you have a list of salespersons with each row
containing the last name, first name, and sales results.

‘LAST NAME

IRST NAME SALES RESULTS
Henry $12,345
John $10,539
William £34,129
Ruth $22,410
David $18,300
Jodce $15,885
Terry $20,782

<< SELECT >>
CONDITION: LESS
LESS THAN: 200000

Type number and press RETURN.

The Selected Data dialog box looks like this:

<< SELECTED DATA: 4 >>
LESS THAN: 20000

Marsh Herry $12,345
Anderson John $10,538
Carter David %18, 300

'Use cursor ‘o select and press ARETURN.
EERAERERIEE (FPRINT]

[CANCEL]}

From the Selected Data dialog box you can write the selected information
in the current worksheet, print the information, or leave the selected
information and return to the original worksheet.
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* To write the selected information in your worksheet, select WRITE IN
SHEET and press RETURN. This message appears:

]Move cursor to position to write SELECTED DATA.

Move the cursor to the location for the selected information and press
RETURN. The upper-left corner of the selected information coincides with
the selected position. The information that is written overwrites existing
information in the same way as when you copy a block.

If the information to be written exceeds the boundary of the worksheet,
this message appears:

Wrile canceled.
Range exceeds boundary of spreadsheet!
Press any hey to continue.

* To print the selected information, select PRINT; press RETURN.

* After looking at the selected information, press CANCEL to return to
the previous screen.

Style Menu
Edit M Eiock Sheet Use the Style menu to change the appearance of a range of cells.

rdering }

%_oldd * Underline. Switches underlining on or off
Fixe

Currency * Bold. Switches bold on or off

Percent

Formula Text * W .
No Displzy Fixed. Controls the number of decimal places

Al Off

* Currency. Automatically adds a § sign to numeric results in a range
While using the above options, .
press CANCEL at any time to go

to the previous screen. * Formula Text. Allows you to see the formulas, rather than their
results. This is useful, for example, when you want to show someone
how you have set up a particular worksheet.

Percent. Automatically adds a % sign to numeric results in a range

* No Display. Switches the display of selected cells on or off. This is
useful when some cells of the worksheet are used for intermediate
calculations. You can hide these cells and show only what is necessary.

* All Off. Cancels all settings made with the above options and restores
the default settings.

Style Notes

* Both Bold and Underline can be applied to the same cell and can be
applied together with one of the other settings as well.
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The Underline option alfows you
to draw horizontal lines
separating rows. When a cell is
set to Underline ON, the
underlining extends from the left
fo the right end of the cell,
regardiess of its contents.

* The other settings, from Fixed to All Off, exclude each other. For

example, a cell cannot be set to Percent and Currency at the same
time. If you apply Percent to a cell that was set to Currency, the § sign
disappears and a % sign appears. However, it is possible to set
Formula Text or No Display in addition to either Fixed, Currency, or
Percent. For example, if No Display is set along with Percent and the

No Display setting is cancelled, the % sign appears again.

* Underline draws a line across the entire cell regardless of its contents.
This function is used to separate rows of the worksheet.

* All Style options apply to empty cells. If you set an empty cell to Bold
and Percent, a numeric value entered later in that cell is bold and has a
percent sign.

pTo use Underline in cells:

1

. Move the cursor to a corner of the range of cells you want to
underline. Press CODE + N. This message appears:

[Move cursor to end of block to be formatted and press RETURN. J

2

3

. Move the cursor to the opposite corner of the range of cells you
want to underline; press RETURN. 7his dialog box appears:

Underlina?

Use cursor to select and press RETURM.
[OFF] [CANCEL]

. Select ON, OFF, or CANCEL and press RETURN.
* ON. Underlines all the cells in the range
* OFF. Removes underline from cells in the range
* CANCEL. Returns to the previous screen

p-To use Bold in cells:

1.

Move the cursor to a corner of the range of cells you want to bold.
Press CODE + B.

2. Move the cursor to the opposite corner of the range of cells you

want to bold; press RETURN. 7his dialog box appears:

Bold?

Use cursor to select and press RETURNMN.

{CANCEL]

3. Select ON, OFF, or CANCEL and press RETURN.

® ON. Sets all the cell contents in the range to bold
* OFF. Removes bold from cells in the range
* CANCEL. Returns to the previous screen
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The Fixed option allows you to
control the number of decimal
places that appear and to use
commas to separate the
thousands. The default is an Auto
mode, which shows up to five
decimal digits. The ssfting does
not affect the number of decimal
places that are actually stored in
the memotry.

The Currency option adds a doflar
sign § to the feft of numbers. Like
the Fixed option, it controls the
number of decimal digits,
separates the thousands with
commas, and can also hide zero
values.

P> To use the Fixed option in cells:

1. Move the cursor to a corner of the range of cells you want to format.
Press MENU to see the menu bar; select Fixed from the Style menu.

2. Move the cursor to the opposite corner of the range of cells you
want to format; press RETURN. The Fixed dialog box appears:

<< FIXED =>>
FIXED DISPLAY:
SEPARATOR: NOC
DECIMAL PLACES [0 ~ SI: a

Press SPACE to change selting and press RETURN.

3. Press T and { to move the cursor to a setting. Press SPACEBAR to
alternate between Yes and No. Press the numeric keys to set the
number of decimal places.

* FIXED DISPLAY:

YES—Cancels the settings of Currency and Percent and enables
the setting of the Fixed dialog box

NO—Cancels the Fixed setting in the designated range and
returns the default Auto mode

* SEPARATOR:

YES—Shows the numeric values with commas separating the
thousands (for example, 1,234,567).
NO—Shows the numeric values without commas.

* DECIMAL PLACES [0-5]: Shows the numeric value with the
specified number of decimal places. If a2 numeric value has more
decimal digits, it is rounded off. If it has less, zeroes are added to
the right.

4. Press RETURN when you finish.

pTo use the Currency option in cells:

1. Move the cursor to a corner of the range of cells where you want to
add a dollar sign. Press MENU to see the menu bar; select Currency
from the Style menu.

2. Move the cursor to the opposite corner of the range of cells you
want to format; press RETURN. The Currency dialog box appears:

<< CURRENCY >>

CURRENCY DISPLAY:
ZEROC DISPLAY: YES
SEPARATOR: NO
DECIMAL PLACES[0 ~ S1: 2

Press SPACE to change setting and press RETURN.

3. Press T and | to move the cursor to a setting. Press SPACEBAR to
select either YES or NO, Press the numeric keys to set the number of
decimal places.

* CURRENCY DISPLAY:
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YES—Cancels the settings of Fixed and Percent and uses the

setting of the Currency dialog box. A dollar sign appears to the
left of the numeric values.

NO—Cancels the Currency setting and removes the dollar sign.
® ZERO DISPLAY:

YES—Gives numeric values that are equal to zero. If the

number of decimal places is set to two, for example, the display
of 0 is $0.00.

NO—Changes the spreadsheet so that no numbers appear (the
cells appear empty).

* SEPARATOR:

YES—Shows the numeric values with commas separating the
thousands (for example, 1,234,567).

NO—Shows the numeric values without commas.

* DECIMAL PLACES [0~5]: Shows the numeric value with the
specified number of decimal places. If a numeric value has more
decimal digits, it is rounded off. If it has less, zeros are added to
the right.

4, Press RETURN when you finish.

pTo use the Percent option:

The Percent option automatically 1. Move the cursor to a corner of the range of cells where you want to
shows numbers as percentages. show numbers as percentages. Press MENU (o see the menu bar;

To do this, the Desktop Publisher select Percent from the Style menu.

muitiplies the values by 100 and

adds a percent sign (%) fo the 2. Move the cursor to the opposite corner of the range of cells you
right of the number. The Percent want to format and press RETURN. The Percent dialog box appears:
option also provides decimal

contm,' << PERCENT >>

PERCENT DISPLAY:
DECIMAL PLACES[D ~ 5]:

Praess SPACE to change setting and press RETURN.

3. Press T and | to move the cursor to a setting. Press SPACEBAR to
alternate between Yes and No. Press the numeric keys to set the
number of decimal places.

* PERCENT DISPLAY:

YES—Cancels the settings of Fixed and Currency and enables
the setting of the Percent dialog box. Numeric values are first
multiplied by 100; then a percent symbol appears to the right of
the value.

NO—Cancels the percent settings and removes the percent sign.
* DECIMAL PLACES [0-5]: Gives the numeric value with the
specified number of decimal places. If a numeric value has more

decimal digits, it is rounded off. If it has less, zeroes are added to
the right.

4. Press RETURN when you finish.
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The Formula Text option alfows
you to show formulas (rather than
their result) in cells. Use this
feature to print ali the formulas
you have creatad.

The No Display option allows you
Io hide the contents of cells. Use
this option to hide cells used only
for intermediate results that do
not need to appear in your

_ worksheet.

The All Off option allows you to
reset ail the attributes of the
selected cells to their default
settings (underiine off, bold off,
fixed auto decimal, currency and
percent off, no commas, formula
text off, no display off}.

pTo use the Formula Text option:

1. Move the cursor to a corner of the range of cells where you want to
show formulas in cells. Press MENU to show the menu bar; select
Formula Text from the Style menu.

2. Move the cursor to the opposite corner of the range of cells you
want to format; press RETURN. This dialog box appears:

Formula Text?

Use cursor to select and press RETURRMN.

OFF] ICANCEL]

3. Select ON, OFF, or CANCEL; press RETURN.
* ON. Shows formulas instead of their results
* OFF. Shows the result in any cell that was showing a formula
¢ CANCEL. Returns to the previous screen

p-To use the No Display option:

1. Move the cursor to a corner of the range of cells where you want to
hide the contents of cells. Press MENU to see the menu bar; select
No Display from the Style menu.

2. Move the cursor to the opposite corner of the range of cells you
want to format; press RETURN. This dialog box appears:

No Display?

Use cursor to select and press RETURN.

[OFF] [CANCEL]

3. Select ON, OFF, or CANCEL and press RETURN.

* ON. Changes the screen so that the contents of all the cells in the
range appear empty

* OFF. Shows the contents of all the cells
¢ CANCEL. Returns to the previous screen

p>To use the All Off option:

1. Move the cursor to a corner of the range of cells you want to reset.
Press MENU to see the menu bar; select All Off from the Style menu.

2. Move the cursor to the opposite corner of the range of cells you
want to format; press RETURN. This dialog box appears:

O K to delete format?

Use cursor to select and press RETURDNL

["ES] [NO]

* YES. Deletes all the Style settings and restores the default settings
in the selected range.

* NO. Keeps the style settings and returns to the previous screen.
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Block Menu

Sheel  Oplin Use the Block menu to change the location of a range of cells.

* Move. Moves a range of cells to another location. The original location

Copy(A Range ol Cells) -
is left empty.

Copy(One Ceflto Oihiar Cefts)
Clear

Copy to Clip Board
Pastz from Clip Board

* Copy (A Range of Cells). Copies a range of cells to another location.
The original location is left unchanged.

¢ Copy (One Cell to Other Cells). Copies one cell to all the cells in a
range

You can press CANCEL at any * Clear. Empties all cells in a range
time to cancel an option.

* Copy to Clip Board. Copies a range of cells to the clip board
The Block operations move the

Style settings of the individual * Paste from Clip Board. Pastes the contents of the clip board into the
cells with the cells. worksheet

Relative and Absolute Addresses

Whenever the layout of your spreadsheet changes and the information
within a cell has been copied, the cell reference in the formulas is
updated accordingly. A cell with a relative address is updated to reflect
most layout changes. However, there may be times that you do not want
the cell address in the formula updated. A cell with an absolute address is
generally not updated when you change the layout.

Cell addresses are considered relative unless a $ (dollar sign) is placed at
the beginning of the cell address in the formula: A1 is a relative address;
$A1 is an absolute address.

The Move option allows you fo »TO move a range of cells:
move a range of cells to another
focation. The original cells are 1. Move the cursor to a corner of the range of cells you want to move.

cleared. Press CODE + E. This message appears:

|Move cursor to end of block to be moved and press RETURN. ]

2. Move the cursor to the opposite corner of the range of cells you
want to move; press RETURN. This message appears:

|Move cursor to destination for blocked data and press RETURN. |

3. Move the cursor to the upper left corner of the destination range;
press RETURN.
* [f the new destination is such that the relocated information
exceeds the limits of the worksbheet, this message appears:

Move canceled.
Range exceeds boundary of spreadsheet!
FPress any key to continue.

» If the destination has protected cells (cells you cannot erase or
overwrite without first removing the protection), information
transfer is canceled and this message appears:
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FProtected cell error!
Press any key to continue.

This optlion works like the move »To copy a range of cells:
option, except the original range

of cells is not cleared. 1. Move the cursor to a corner of the range of cells you want to copy.
Press CODE + C. This message appears:

|Move cursor to end of block to be copied and press RETURN. ]

2. Move the cursor to the opposite corner of the range of cells you
want to copy; press RETURN. This message appears: '

[Move cursor to destination for blocked data and press RETURN. ]

3. Move the cursor to the upper left corner of the destination range;
press RETURN.

» If the new destination is such that the relocated information
exceeds the limits of the worksheet, this message appears:

Copy canceled.
Range exceeds boundary of spreadsheet!
Press any key to continue.

* If the amount of information that you try to copy is such that your
file becomes too large, this message appears:

Copy incomplete. Meamory fuill
Press any key to continue.

If any key is pressed, the information that could be copied is
shown on the screen.

* If the destination has protected cells (cells you cannot erase or
overwrite without first removing the protection), copy is
performed only on unprotected cells and this message appears:

Protected cell error!
Press any key to continue.

This option allows you fo copy pTo copy one cell to other cells:
one cell to all the cells of a

specified range. 1. Move the cursor to the cell you want to copy. Press MENU to see the
menu bar; select Copy (One Cell to Other Cells) from the Block
menu. Before pressing MENU, make sure the cursor is in the cell you
want to copy. This message appears:

lMove cursor to start of block to be copied and press RETURN. l

2. Move the cursor to one corner of the destination range and press
RETURN. This message appears:

IMove cursor to end of block to be copled and press RETURN.
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3. Move the cursor to the opposite corner of the destination range and
press RETURN.

* If the amount of information that you try to copy is such that your
file becomes too large, this message appears:

Copy incomplete. Memory fulll
Prass any key to continue.
If any key is pressed, the information that could be copied is
shown. .

* If the destination has protected cells (cells you cannot erase or
overwrite without first removing the protection), only unprotected
cells are copied and this message appears:

Protacted cell error!
Press any key to continue.

This function clears all the cells in }To clear all cells in a range:

a range.
9 1. Move the cursor to a corner of the range of cells you want to clear.
Press CODE + D. This message appears:

[Move cursor to end of block to be cleared and press RETURN. i

2. Move the cursor to the opposite corner of the range of cells you
want to clear; press RETURN. A dialog box appears:

iUse cursor to select and press RETURN.

3. Select YES or NO and press RETURN.
YES. Clears the range
NO. Keeps the cells and returns to the previous screen

* If the selected range has protected cells (cells you cannot erase or
overwrite without first removing the protection), only unprotected
cells are cleared and this message appears:

Protected cell error!
Press any key lo conlinue.

Copy to Clip Board/Paste from Clip Board
These operations are described in Clip Board on page 234.
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Sheet Menu

oy Use the Sheet menu to adjust the width of columns, freeze, insert or

Block z
F———— remove rows and columns, recalculate the results of formulas, and protect

Option

Title

important parts of the worksheet.
[nsett
Delete * Column Width. Changes the width of columns
Eizsfﬁmlect ¢ Title. Freezes column(s) or row(s) on the screen so that the labels they
Worksheet Protect contain are always visible when you scroll the worksheet. The same
Caloutation Method function is used to release frozen columns or rows,

Insert. Inserts blank rows or columns in the middle of the worksheet

When columns or rows are
inserted or deleled from the
worksheet, cells are renumbered,

Delete. Removes columns or rows from the worksheet

Recalc. Updates the results of all formulas

You can press CANCEL at any * Range Protect. Protects a range of cells against accidental deleting or
time to cancel these options. overwriting. The same option removes the protection.

¢ Worksheet Protect. Turns on or off the protection of a range of cells
from accidental deleting or overwriting

* Calculation Method. Changes the method of calculation

This option aliows you to change  Jp.To change the width of columns:
the width of entire selected

columns, from the top to the 1. Move the cursor to the leftmost or rightmost column where you want

bottom of the worksheet. to change the width. Press MENU to see the menu bar; select
Column Width from the Sheet menu. The Column Width dialog box
appears:

<< COLUMN WIDTH »»

CHOICE

iPress SPACE to change setling and press RETURN.

2. Press T and | to move the cursor to a setting. Press SPACEBAR to
change the settings.

s HOW?:

MANUAL—Manually sets the width (you have to enter a value
for the width).

AUTO—Automatically sets the width (the width is set

automatically so that the longest entry of the selected column][s]
can fit).

DEFAULT—Resets the width to 10 characters (default value).
* WHERE?:
CHOICE—Applies the change to specified column(s) only.
GLOBAL—Applies the change to the entire worksheet.
3. Press RETURN when you finish.

How
Manual | Auto Defauit
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The Title option freezes the first
rows/columns of a large
worksheet so that the litles they
contain are afways visible when
you scroll the sheet.

Where 5.

Select column(s). |Select a range. See | Select column(s).
See step 4. Enter |step 4. See step 4.
Choice |a value for the
width. See step

Enter a value for |Operation is carried | Operation is carried
Global | the width, See out immediately. out immediately.
step 5.

4. If you apply Manual or Default with Choice, the entire column is

highlighted and this message appears:

l@fark columns for width change and press RETURN.

Move the cursor horizontally to mark more columns, if necessary,
and press RETURN.
If you apply Auto with Choice, this message appears:

Press ¢, — to mark columns for width change, T, 1 to
mark rows for data scan.

Press « and — to select the columns. Press T and | to select the
length of the information scan range and press RETURN.

5. If you have to enter a value for the width, the Column Width Set

dialog box appears:
<< COLUMN WIDTH SET 5

CHANGE COLUMN: XX -XX
COLUMN WIDTH: . XA

i Type number and press RETURMN.

Type a number for the new column width and press RETURN.

* If you apply an Auto width change to an empty column, the width
of that column does not change.

¢ The maximum width of a column is 95 characters. The minimum
width is one character. If you try to specify values outside this
range, you hear a beep.

pTo use the Title option:

1. Press MENU to see the menu bar; select Title from the Sheet menu.

The Title dialog box appears:
<L TITLE »>
TITLE FREEZE OR RELEASE:
DIRECTION: COLUMNS

Press SPACE lo change selling and press RETURN. ‘

2. Press T and | to move the cursor to a setting. Press SPACEBAR to
change the settings.

s TITLE FREEZE OR RELEASE:
FREEZE—Freezes column(s) or row(s).
RELEASE—Releases frozen columns or rows.
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¢ DIRECTION:
COLUMNS—Applies the change to column(s) only.
ROWS—Applies the change to row(s) only.
BOTH—Applies the change to both column(s) and row(s).
3. Press RETURN when you finish.

If you select Release, the frozen column(s) or row(s) or both are
released and this message appears:

|Frozen columns/rows have been released. —l

If you select Freeze, this message appears:

Move cursor to right of the columns/one row below the
rows to be frozen and press RETURN.

4. To freeze columns, move the cursor to the right of the last column to
be frozen.

Example: To freeze columns A and B, move the cursor to
column C.

To freeze rows, move the cursor one row below the last row to be
frozen.

Example: To freeze rows 1 and 2, move the cursor to row 3.

To freeze both columns and rows, combine the procedures for columns
and rows.

Example: To freeze column A and row 1, move the cursor to
cell B2,

5. Press RETURN.

* You cannot freeze rows when showing two files at a time (Dual
Screen mode). In Dual Screen mode, only columns can be frozen.
If you wish to change this in Dual mode, the following error
message appears:

IOnly columns can be frozen in dual screen! l

¢ If you switch to the Dual Screen mode while rows are frozen, they
are automatically released. The following message appears when
you switch between files with the Change Screen command:

lFrozen rows have been released. }

This function inserts blank rows . B To insert blank rows or columns into a worksheet:
or columns in the middle of the )
worksheet. 1. Move the cursor to the cell where you want to insert rows or

columns.

Example 1: To insert a row between rows 1 and 2, move the
Cursor to row 2.

Example 2: To insert a column between columns A and B,
move the cursor to column B.

2. Press INSERT. The Insert dialog box appears:

Spreadsheet 116




<< INSERT >»

INSERT COLUMNS OR ROWS: ISR
NUMBER CF COLUMNSIROWS TO INSERT: 1

|[Prass SPACE lo change selling and press RETURN.

3. Press T and | to move the cursor to a setting. Press SPACEBAR to
switch between Columns and Rows and type a number.
* INSERT COLUMNS OR ROWS:
COLUMNS—Inserts column(s).
ROWS—Inserts row(s).

* NUMBER OF COLUMNS/ROWS TO INSERT: Enter the number of
columns or rows you want to insert (1-99).

“When you insert a row between rows 1 and 2, a new empty row
2 is inserted, and subsequent rows are renumbered (old row 2
becomes new row 3, etc.).

When you insert 2 column between columns A and B, a new
empty column B is inserted, and subsequent columns are
renumbered (old column B becoming new column C, etc.).

Relative addresses in a formula are automatically adjusted.

Example: C1 contains (A14+B1) and you insert a column
between A and B. C1 becomes D1 and now contains (A1+C1).

If the amount of columns or rows to be inserted is such that
subsequent columns or rows that already contain information are
pushed outside the limits of the worksheet, this dialog box
appears:

Insert will result in data lossg!
Is it OK? :

[Use cursor lo select and press RETURNMN.
[YES]

If you select NO, insertion is canceled. If you select YES, insertion
is performed with information lost, unless one or more cells
among the information to be lost is protected, in which case this
dialog box appears and insertion is canceled:

Pratected cell error!
Press any key to continue.
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The Delete option removes pTo deiete columns or rows from a worksheet:
columns or rows from the

worksheet. 1. Move the cursor to the first column or row that you want to delete.
Press MENU to see the menu bar; select Delete from the Sheet menu.
The Delete dialog box appears:
<< DELETE »»

DELETE COLUMNS OR RCWE:
NUMBER OF COLUMNS/IRCOWS TO DELETE: 1

|Press SPACE lo change selling and press RETURN.

2. Press T and | to move the cursor to a setting. Press SPACEBAR to
switch between Columns and Rows and type a number.

* DELETE COLUMNS OR ROWS:
COLUMNS—Deletes column(s).
ROWS—Deletes row(s).
* NUMBER OF COLUMNS/ROWS TO DELETE: Enter the number
of columns or rows you want to delete (1-99).

3. Press RETURN. This message appears:

Delete?

Use cursor to select and press RETURN.
TES INO]

Select YES to delete or NO to cancel; then press RETURN.
* Relative addresses in a formula are automatically adjusted.

Example: D1 contains (BI1+C1) and you delete column A.
D1 becomes C1 and now contains (A1+B1).

* After deletion, subsequent columns or rows are renumbered.

* If one or more cells among the information to be deleted are
protected, this dialog box appears and deletion is canceled:

Pratected cell arrorl
Press any key to continue.

Recalc

The Desktop Publisher constantly checks for the need to recalculate the
entire worksheet. If recalculation is necessary, the dialog box below

appears immediately before printing or immediately before sorting or
selecting:

The sheat needs recalculation.
Recalculate?

Use cursor to select and press RETURN.
[VEZS {NO]

To recalculate, select Yes and press RETURN. The message “Working ...”
appears while recalculation is going on.
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If you do not want to recalculate, select NO and press RETURN.

* Recalculation begins from top to bottom and continues left to right.

* Desktop Publisher recalculates the worksheet twice. If you are using
formulas referring to cells that refer to other cells, sometimes the
system cannot give the correct results immediately. You may need to
use the recalculation function again if your spreadsheet is using
complex formulas.

To recalculate manually, press CODE + RETURN.

The message “Working...” appears while recalculation is going on. When a
file is opened that has not been recalculated but has been saved, the
following message appears to prompt you to recalculate manually:

[The sheet needs recalculation. Recalculate. ]

Range Protect
This option protects a range of cells against accidental deleting or
overwriting. The same option removes the protection. Three things to
remember when using Range Protect are:

* When a cell is protected, you cannot delete or overwrite its contents.
You also cannot delete the row or columns it is in.

* You can use Range Protect to avoid accidental deletion or modification
of cells that contain complicated formulas.

* The cell can be updated by recalculation, but the formula itself cannot
be changed.

pTo use the range protect option:
1. Move the cursor to one corner of the range you want to protect.
Press MENU to see the menu bar; select Range Protect from the
Sheet menu. This message appears:

Move cursor to end of block to be protected on/cff and
press RETURN.

2. Move the cursor to the opposite corner of the range you want to
protect; press RETURN. This dialog box appears:

Protect?

Use cursor to select and press RETURN.

[OFF] [CANCEL]

3. Select ON, OFF, or CANCEL and press RETURN.
* ON. Protects all the cells of the range
* OFF. Changes all the cells in the range to unprotected
¢ CANCEL. Returns to the screen before MENU was pressed
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The Worksheet Protect option
aither gives or takes away
protection of a range of cells from
accidental deleting or overwriting.
When a worksheet is protected,
you cannot delete or overwrite ils

contents.

This option alfows you to change
the cafculation method and is
useful when using the
Spreadsheet for financial

purposes.

P To use the Worksheet Protect option:
1. Press MENU to see the menu bar; select Worksheet Protect from the
Sheet menu. This dialog box appears:

Worksheet Protect?

Use cursor to select and press RETURN.L

NN (DISABLE] [CANCEL]

2. Select ENABLE, DISABLE, or CANCEL; press RETURN.
* ENABLE. Turns on Range Protect
» DISABLE. Turns off Range Protect
¢ CANCEL. Returns to the previous screen before MENU was
pressed

pTo change the calculation method:
1. Press MENU to see the menu bar; select Calculation Method from the
Sheet menu. This dialog box appears:

Calcuiation Precision?

[Use cursor to select and press RETURN.
WEIERY (USE PRECISION AS DISPLAYED) [CANCEL]

2. Select USE FULL PRECISION, USE PRECISION AS DISPLAYED, or
CANCEL; press RETURN.
* If you select Use Full Precision, calculation is carried out precisely.
(See the example on this page.)
* If you select Use Precision as Displayed, this dialog box appears:

O K to lose accuracy?

Use cursor to select and press RETURN.

[vE= [INO]

YES. Calculation is carried out as shown.

NO. Cancels this option.
» If you select Cancel, you return to the previous screen before
MENU was pressed.

Example 1: Use Full Precision

1. Enter 1/4 (0.25) in cell Al. (Decimal places: 1)

2. Enter 2 in cell B1.
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3. Enter +A1xB1 in cell C1. The precise value stored in the cell is used
for the calculation.

Example 2: Use Precision as Displayed
1. Enter 1/4 (0.25) in cell Al. (Decimal places: 1)

3. Enter +A1xB1 in cell C1. The given value is used for the calculation.
This selection is useful for financial purposes.
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Option Menu

Screen  Print Use the Option menu to spell check your text and to maintain a User
Dictionary or Abbreviated Phrase file.

* Abbreviated Phrase Maintenance. Edits the Abbreviated Phrase
memory.

» Spell Check All. Spell checks the alphanumeric entries

* User Dictionary Maintenance. Edits the User Dictionary

£ dabad Fhraze Mantenaroe |
Spell Check Al
User Diclionary Maintenance

Abbreviated Phrase Maintenance

Use the Abbreviated Phrase option to add long strings of text faster. You
can edit the Abbreviated Phrase memory from the Spreadsheet program
the same as with the Word Processing program. For information, see
Understanding Abbreviated Phrase Memory on page 70.

Spell Check All
This option starts the spell check feature. The operations are the same as
in Word Processing. For information see Spell Check All on page 70.
* When an error is found, the cell is highlighted and its contents appear
in the input area with the misspelled word highlighted.
Frozen cells are not checked.
* You cannot correct a protected cell.
* You cannot enter more than 240 characters when retyping.

User Dictionary Maintenance

Operations are the same as in Word Processing. For information, see User
Dictionary Maintenance on page 70.

Screen Menu

: : Use the Screen menu to control the display. These menu options are
Option Print . S
O available only when working in Dual Screen mode.
Split Size * Change Screen. Changes the active file while working in Dual Screen
mode

* Split Size (DP-540C]J, DP-550C], & DP5040C]J only). Adjusts the
screen size while working in Dual Screen mode

Change Screen

The operations are the same as in Word Processing. For information, see

Change Screen on page 81.

* The short-cut keys CODE + Q can be pressed only when you are in
Command mode.

* If the file that becomes active is a Spreadsheet file, you are in
Command mode.
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Split Size (DP-540CJ, DP-550CJ, & DP-5040CJ only)

The operations are the same as in Word Processing. For information, see
Split Size on page 82.

Print Menu

Scteen | Frirt | Use the Print menu to print a range of cells or the entire worksheet.
R

i

To select a print area, move the cursor to a corner of the range you want to
print. Press PRINT. The Spreadsheet Print Menu dialog box appears:

<< SPREADSHEET PRINT MENU »>

FPAINT AREA:

PRINT POINT: 12 POINT
PRINT QUALITY: MEDIIM
PAGE SETUP: LETTER RORTHAIT

LPress SPACE to change setling and press RETURMN.

Setting the Print Options

Press T and | to move the cursor to a setting. Press SPACEBAR to sclect
an option. Press RETURN when you finish.

Print Area
You can print a selected range or the entire worksheet.

To print the entire worksheet, press SPACEBAR to see Global.
OR

p-To print a range of cells:
1. Press SPACEBAR to see Range (XX..XX).
2. Press — or TAB. This message appears:

[Move cursor to end of block to be printed and press RETURN.

3. Move the cursor to the opposite comer of the range to be printed;
press RETURN. The selected range now appears in the Spreadsheet
Print Menu next to the Print Area heading, This range specification is
saved along with your file and is not reset until you change it.

The line under the Print Area specification shows how many rows
are going to print as well as the number of characters in the rows.
This helps to prevent printing longer rows than can fit on the paper.
(See Page Setup on the next page.)

Print Point
Press SPACEBAR to select the size of the printed characters: 7, 10, or 12

points.
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Print Quality

Print Frozen Title

Page Setup

Press SPACEBAR to select print quality: FINE, MEDIUM, or DRAFT.
DRAFT prints faster and uses less ink. MEDIUM quality printing is between
FINE and DRAFT. Use DRAFT for trial copies and FINE for final copies.

If you change Print Area from GLOBAL to RANGE (XX..XX), Print Frozen
Title appears on the menu. Press SPACEBAR to select YES to print frozen
title cells or NO if you do not want to print the frozen title cells. If PRINT
FROZEN TITLE is set to Yes, a line showing how many rows are going to
print as well as the number of characters in the rows appears under Print
Frozen Title.

The current paper size is indicated beside the Page Setup heading in the
Spreadsheet Print Menu. If you change Print Area from GLOBAL to
RANGE (XX..XX), the maximum number of rows/characters that can print
on a single page is indicated under the Page Setup heading. Compare
these numbers with the number of rows and characters in the current file
to determine if all the information fits on a page. If the information cannot
fit, it is cut off.

If the selected print area cannot fit, try to reduce the character size and/or
change the Page Setup.

Changing the Page Setup

To change the page setup, go to the Spreadsheet Print Menu and follow
the steps on this page: (See Print Menu on page 123 to learn how to get
to the Spreadsheet Print Menu.)

pTo change the Page Setup:

1. Move the cursor down to PAGE SETUP; then press — or TAB. The
page setup dialog box appears.

<< PAGE SETUP >3

PAPER SIZE & ORIENTATION: 8.50
[LoT e T T y
LETTER LANDSCAPRE
A4 PORTRAIT
Ad LANDSCAPE

8.00111.00

AS PORTRAIT
OTHER

IPress t, + to change setting and press RETURN.

Press +, - to move to anolher setting.

2. Press T and ! to select the paper size and orientation. This
determines the width and length of the paper and the margins.

3. Press the arrow keys to type a value in inches in each entry field.
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* You can move the cursor to the underlined fields only. The
margin entry fields are always underlined. The width and length
are underlined only if you select Other for the paper size.

* Each field has room for five characters (four digits and a decimal
point). Pressing BACKSPACE or DELETE clears the whole field.

* If the information area width is less than 1 inch or the length is
less than 4 inches, this message appears:

IIncorrect setting! ’ *—T

* With Other, if you set the width to more than 9.5 inches or the
length to more than 14 inches, this message appears:

lIncorrect setting! 47

Adjust the left and right margins so you can print the entire row
of your selected print area.

4. When you finish, press RETURN to return to the Spreadsheet Print
Menu.

p>To print a spreadsheet:

1. When all the settings of the Spreadsheet Print Menu are complete,
press RETURN.

The maximum length of paper 2. The desktop publisher starts printing.
that can printis 14 inches. * If you try to print a range but have not indicated what the range is

(both the indication Row: and CHARACTER: show XXX instead of
actual settings), this message appears:

No range print area! Press TAB then mark range for
printing.

* If a whole row cannot fit between the left and right margins, the
Desktop Publisher prints the portion that can print and gives this
message:

{Ezhe(s) truncated. I

* During printing, press CANCEL to stop printing.
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3 Addressbook

Use Addressbook to enter and organize information such as a list of names, addresses, telephone
numbers, and fax numbers.

Each entry is called a record and appears as a single row divided into several items. On the top of the
list of records, labels identify each item. You can edit, sort, and print the list. Parts of the list can be
selected according to specific conditions. :

You may also use Addressbook files with Merge printing to create multiple copies of a document
created in Word Processing. Merging information in this way can prove useful if you have, for example,
a form letter that you want to send to several different people. You could create an Addressbook file of
information to be inserted using merge codes and match each one to a different record in the
Addressbook. After arranging these two files, you would tell the desktop publisher to merge them.
When you print, you should have several customized versions of your form letter.

When you save an Addressbook file, the system adds the extension .MRG to the file name. Files with
that extension can be used for merge printing with Word Processing files.

pTo create a new Addressbook file or look at a stored one:

If you get a message that you 1. Turn the power on to show the Main Menu.
d , . . .
Z?shi’(‘::g ﬂffgf ;ﬁ:;;',z‘:mage 2. To look at an Addressbook file from a diskette, insert that diskette
diskette with another or go to into the disk drive.
page 22 in Ge“,f,ng Sttaft?; ;e_ar 3. Press 3. If you insert a diskette, the list of the Addressbook files stored
ea /
ngg;zo"s o how o Infelz on the diskette appears:
|- ]
!I ! 5 d- = Address- ‘
qn/ ‘.I;':":;;dessin ey W book —!
FHELIEDQOE

Remember that you can press 4. To open a stored file, press the arrow keys to select the file you
HELP to get on-screen help. want to look at and press RETURN. To open a new document, press

RETURN with *NEWBOOK selected. If you retrieve an existing
Addressbook file, the View screen appears. If you start a "NEWBOOK,
the Data Input screen appears, and you can enter your first record.
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Using Addressbook Screens

View Screen

If you are at the View screen,
press RETURN to see the Dala
Input screen.

Data Input Screen

if you are at the Data Input
screen, press CODE + RETURN
to see the View screen.

To see both screens at once,
press MENU to show the menu
bar, and select Open File for Dual
from the File menu.

If the Dala Input screen appears
at the bottom, press CODE +
RETURN fo see the View screen.

Addressbook uses two screens: the View screen and the Data Input
screen.

e wewok [RECoRD 1]

The View screen gives a list of your records. Use the View screen to make
large-scale edits, such as moving or deleting a block of records or sorting
records. You cannot edit the contents of a record from this screen.

The check marks at the left of the records indicate they are selected for
printing. (A new record that you create is automatically selected for
printing.) For more information about selecting a record for printing, see
page 134.

| o s— LT |neconn: 1]

MR/
LAST NaNE
FIRST NAME
TELEPHONE
FAX MNO.
TITLE
CONPRANY
ADDRESS
CITY
SIATE
ZIP

The Data Input screen appears as an empty record where you enter the
information for that record. You can edit this information after it is
entered.
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Working with Addressbook

When creating or editing an Addressbook file, keep the following points
in mind:

* You can set the width of a2 column between one and 71 characters.

* You can have a maximum of 20 different labels.

® The maximum length of a label name is 12 characters.

File

Z}J’;JU 9‘9;7: messag*: indic;tgwg The File menu is available on both the View and Data Input screens. Use
d:m{::; z d d;,sek:ge‘,”:e;h”:fre:lazre the File menu to open, save, or close your files and to return to the Main
the diskette with another one or Menu or go to File Management. These menu options work the same in
go lo page 22 in Getting Started  the Word Processing program. For more information, see Using the File

for instructions on how to initialize  Menu on page 38.
a diskette.

Input Menu (View Screen)

M record Use the Input menu to create a new record or move to the top or bottom

of the list.
Top Record
Bottom Record e New Record. Creates a new record

* Top Record. Jumps to the first record

* Bottom Record. Jumps to the last record

New Record
The New Record option allows you to add a new record at the end of
your Addressbook.
Press CODE + R. The Data Input screen appears.
The entry fields will be empty. The new information that you enter
appears at the end of your list when you return to the View screen.
Top Record

Use Top Record to move to the first record of your Addressbook file. The
record appears on the Data Input screen.

Press MENU to see the menu bar; select Top Record from the Input
menu.
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Bottom Record
Use Bottom Record to move to the final record of your Addressbook file.
The record appears on the Data Input screen.

Press MENU to see the menu bar; select Bottom Record from the Input
menu.

Record Menu (View Screen)

Use the Record menu to change the location or appearance of an entire
block of text.

Label

Ed

Celete
Copy to Clip Board
Paste from Clip Board
Insert

¢ Move. Moves records from one location to another location in
Addressbook

* Copy. Copies records to another location. The original records are not
changed.

* Delete. Removes records
¢ Copy to Clip Board. Copies records to the clip board

* Paste from Clip Board. Pastes the contents of the clip board into the
Addressbook

» Insert. Inserts a blank record

~ pTo move a block of records:
This option removes a block of 1. To move records, place the cursor on the first record to be moved.

records from its original location .
and places it at another location. 2. Press CODE + E. This message appears:

[Move cursor to end of block to be moved and press RETURN. |

3. Move the cursor to the end of the block. As the cursor moves, the text
is bighlighted.
4. Press RETURN when the block is highlighted. This message appears:

|Move cursor to destination for blocked record and press RETURN. —]

5. Move the cursor to where you want the records placed and press
RETURN. The records are removed from their original location and
placed at another location.

p-To copy a block of records:
This option copies a block of 1. To copy records, place the cursor on the first record to be copied.

records fo another location )
without removing the original 2. Press CODE + C. This message appears:

records.

|Move cursor to end of klock to be copied and press RETURN. J

3. Move the cursor to the end of the block. As the cursor moves, text is
bighlighted.
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4. Press RETURN when a block is highlighted. This message appears:

lMove cursor to destination for blocked record and press RETURN. 41

5. Move the cursor to where you want the records placed and press
RETURN. 7he records are inserted

P> To delete a block of records:
::7; ’;I;ﬁc‘" removes a block of 1. To delete records, place the cursor on the first record to be deleted.
2. Press CODE + D. This message appears:

IMOVE cursor to end of block to be deleted and press RETURN. ]

3. Move the cursor to the end of the block. As the cursor moves, text is
bighlighted.

4. Press RETURN when a block is highlighted. The desktop publisher
asks you to confirm.

ES] INOY;

Deleta?
jUse cursor ‘o select and press RETURN.

5. Select YES to delete the block or NO to cancel.

Copy to Clip Board/Paste from Clip Board

These operations are described in Clip Board on page 237.

Insert
This option inserts a blank record.

1. Move the cursor to the place where you want a blank record.
2. Press INSERT. A blank record appears.

Label Menu (View Screen)

Use the Label menu to create, change, or delete labels. The labels are the
names at the top of each column.

Harean

[
Change Label Name & Width

* Insert Label. Creates a new label

¢ Delete Label. Deletes a label
* Change Label Name & Width. Edits a label name and changes the

label width
pTo insert a label:
This option creates a new label 1. Press MENU to see the menu bar; select Insert Label from the Label
and sets the name and width of menu. This message appears:

the label.

‘Move cursor to position for insert label and press RETURN. I
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The maximum number of labels 2. Move the cursor where you want a new label and press RETURN.

you can create is 20. ‘e A .

The maximum length for a label This dialog box appears:

name is 12 characters. << INSERT LABEL >>
The width of a column must be - .
between 1 and 71 characters. t:g:t :TQ:FH 12

| Type label name and press RETURN.

3. Press T and | to move to an entry field. Type a label name and a
value for the width. Press RETURN.

pTo delete a label:
This option removes columns of 1. Press MENU to see the menu bar; select Delete Label from the Label
information together with their menu. This message appears: -

labels.

IMove cursor to start of block to be deleted and press RETURN.

2. Move the cursor to the beginning of the block of labels you want to
delete and press RETURN. This message appears:

Move cursor to end of block to be deleted and press RETURN.

3. Move the cursor horizontally to the end of the block of labels you
want deleted. As the cursor moves, the selected labels are bighlighted.

4. Press RETURN when a block is highlighted. The Desktop Publisher
asks you to confirm.

Deleta?

Use cursor to select and press RETURN.
[NO]

5. Select YES to delete the block or NO to cancel.

P To change a label name and width:

1. Press MENU to see the menu bar; select Change Label Name & Width

The maximum length for a label from the Label menu. This message appears:
name is 12 characters.

The width of a column must be

between 1 and 71 characters. lMove cursor teo position for change and press RETURN.

2. Move the cursor to the label that you want to change and press
RETURN. This dialog box appears:

<< CHANGE LABEL >>

LABEL NAME: BIRTHDAYL
LABEL WIDTH: 12

Type label name and press RETURN.

3. Press T and | to move to an entry field. Type a label name and a
value for the width. Press RETURN.
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Edit Menu (View Screen)

Use the Edit menu to sort your records and to select records from the file.
* Sort. Sorts the records

* Select. Selects records

pTo sort records:
This option rearranges the 1. Pre . i
recorts in alphabetis arder o ;s ME!;;J;; ;Dh;\;vs .the menu bar; select Sort from the Edit menu.

The sort option can perform a
double sort, primary and
secondary. Usually, you use the
family name for primary sort, and
the first name for secondary sort.

|Move cursor to primary sort label and press RETURN.

2. Move the cursor to the primary sort label and press RETURN. 7his
message appears:

[Move cursor to secondary sort label and press RETURN.

3. Move the cursor to the secondary sort label and press RETURN. If
you do not need a secondary sort, leave the cursor on the primary
sort label. This dialog box appears:

Direction?

iUse cursor ta select and press RETURN.
[EEMSIPSIES (CESCENDING] [CANCEL]

4. Press « and — to select and press RETURN when you are finished.
* ASCENDING. Normal alphabetic order (A—Z)
* DESCENDING. Reverse alphabetic order (Z-A)
* CANCEL. Cancels the function

P To select records:

This option selects records that 1. Press MENU to see the menu bar; choose Select from the Edit menu.
-match your selections. When the Thi .
. is box appears:
records are found, you can print b ppe
them. << SELECT >
MR/MS
LAST NAME
FIRST NAME
TELEPHONE
FAX NO.
TITLE i

COMPANY
ADDRESS
CITY
STATE
ZIP

Type character and press RETURMN.

2. Press T and | to move to an entry field. Type in the information.

3. Press RETURN. All entries that match your conditions are selected.
A message tells you if the Addressbook cannot find any record that
matches your selection.

If the Addressbook can find record(s) that match your selections, those
records appear in the Selected Data dialog box:
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<< SELECTED DATA: 12>

a b c d
MR/MS [ LAST NAME FIRSY HAME TELEPHONE
M Fletcher

Use cursor to select and press RETURN.
Press CODE + 1, &, «, = o view SELECTED DATA.
{PRINT] [COPRPY TO CLIF) [CANCEL)

4. If necessary, press CODE + arrow keys to scroll through the

information appearing on the screen. Press T and { to select an
option and press RETURN. '

* EXIT. Returns to the View screen
¢ PRINT. Prints the selected information

* COPY TO CLIP. Copies the selected information to the clip board.
Once the information is stored in the clip board, you can paste it
into another file.

* CANCEL. Stops record selection

For details about the clip board,
see page 237.

Screen Menu (View Screen)

B = Use the Screen functions to control the display on the screen. (This

Charian iore e function is available only in Dual Screen mode.)
Siplt Sive

* Change Screen. Swaps the active file while working in Dual Screen

The screen operations are the mode

same as in Word Processing.
See Using the Screen Menu on

et * Split Size (DP-540CJ, DP-550C], and DP-5040C)). Adjusts the

screen size while working in Dual Screen mode

Print Menu (View Screen)

Use the Print menu to select records for printing and to print your

Addressbook:
Print Record ON/OFF

* Print. Prints envelope labels (Label printing) or a list of records (List
printing)

» Print Record ON/OFF. Sets the check mark (¢) to turn printing on or
off

p-To print labels:
1. Press PRINT. The Addressbook Print menu appears:

<< ADDRESSBOOK PRINT MENU >>

PRINT APPLICATION:
PRINT RECCRD: ALL
PRINT POINT: 12 POINT
PRINT GUALITY: MEDIURM
NUMBER CF COPIES: 1
LABEL SI1ZE: I X298
NUMBER OF LABELS: ACROSS <3

Press SPACE lo change selling and press RETURN.
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The kind of label that you create
will be stored in the file.

2. Use T or { to move to a setting. Press SPACEBAR to alternate

between settings.

3. Press RETURN when finished.
P> To change label settings:

4.

PRINT APPLICATION: LABEL. Prints envelop labels
PRINT APPLICATION: LIST. Prints a list of records
PRINT RECORD: ALL. Prints all records

PRINT RECORD: SELECTABLE ( »~). Prints only selected records
indicated with a check mark.

PRINT POINT: 12, 10, 7 POINT. Selects the character size

PRINT QUALITY: FINE. For final quality printing

PRINT QUALITY: MEDIUM. For average quality printing

PRINT QUALITY: DRAFT. For trial

LABEL SIZE: 1x25/g,11/3x4,4x1,4x2,3 1/3 x4, or OTHER. (The
size of the labels is in inches.)

NUMBER OF LABELS: Type in the kind of labels to be used. (The valid
information is Across = 1-9 and Down = 1-99.)

NUMBER OF COPIES: The number of times the paper is to be printed
(maximum 999). In label printing, the number of times the label is to be
printed.

Check the size of the label you wish to use, and type in its number.

If you press RETURN after typing in each value, the Position Set

Print menu appears.

If incorrect information is typed into the ADDRESSBOOK PRINT menu,
the following messages may appear:

|Label exceeds boundary of the paper! ]

[Incorrect setting! I

If OTHER is selected in LABEL SIZE on the ADDRESSBOOK PRINT menu,

the following message appears:

lPress TAB to change setting and press RETURN. l

0.20 2.62 0.00
02,50
¥ e
1.00
h 4 .
[
0.00

<< LABEL SIZE »>

' [ I —

| Type number and press RETURN. Press -, ioﬂmoue_t_q anolher setting.

Check the label that you wish to use, and type the number accordingly.
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The type of label that you indicate
will be stored in the file.

if you press CANCEL while the
cursor fs in the night box, the
setting of the current label name
is canceled, and you retumn to the
left box. If you press CANCEL
while the cursor is not in the right
box, you retumn to the
Addressbook Print Menu.

The default settings for the label
structure and contents appear
only when you are working with
an Addressbook file in which you
have not inserted or deleted the
label and changed the label
setting.

If you press RETURN after you put in a value, the Addressbook Print
Menu screen again appears.

pTo change label settings:

1. Select LABEL before printing and press RETURN to enter the settings
of the ADDRESSBOOK PRINT menu. The POSITION SET PRINT menu

ach

n
L%k

Uszc oursor to select fabel name and press
SPACE b set, DELE TE lo clear. Preas

2. Press T and { to move the cursor to a label name in the Position Set
menu.

3. To remove a label name that is already set, press DELETE. The
check mark on the left of the label name disappears, and the small
letter corresponding to that label is removed from the right box.

4. To set a label name, press SPACEBAR and the cursor appears in
the right box. Use the arrow keys to move the cursor in the right
box to a position and press RETURN to confirm the setting. When
the cursor appears in the left box, a ¢ appears.

5. Repeat steps 1 and 2 to get all necessary items at the correct location.

6. To start printing, set the paper on the paper support and press
RETURN when the cursor is not in the right box.

. :
pTo print a list:
1. Press PRINT. The ADDRESSBOOK PRINT menu appears.
<< ADDRESSBOOK PRINT MENL >
PRINT APPLICATION:
PRINT RECCRD: ALL
PRIMNT POINT: 12 POINT
PRINT SUALITY: MEDHIM
NUMBER OF COPRIES: 1
LABEL SIZE: 1 X258
NUMBER OF LABELS: ACROSS 3
77777 SFACE to change setting and press RETURN.
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You ca t Pri 7
" set Print Record, Print Press T and | to move the cursor to PRINT APPLICATION and press

Point, and Number of Copies as SPAC
you would when printing labels, EBAR to select LIST. The ADDRESSBOOK PRINT menu changes as
Label Size does not appear on shown below:
this dialog box. Instead, you can RESS
st the page dimonsions. v << ADDRESSBOOK PRINT MENU 55
Page Setup. The current paper PRINT APPLICATION: 15T
size is indicated at Page Setup in o
the Addresebook Prirraors: FRINT RECORD: SELECTABLE(v)
PRINT POINT: 12 POINT
PRINT QUALITY: MEDILM
CUT SHEET FEEDER: OFF
NUMBER OF COPIES: 1
PAGE SETUP: LETTER PORTRAIT
pTo change Page Setup:

L. Press 1 and |, to move the cursor to PRINT APPLICATION; press
SPACEBAR to select LIST.

2. Move the cursor to PAGE SETUP.

3. Press —> or TAB to change page setup. The Page Setup dialog box

appears:

<< PAGE SETUP >

PAPER SIZE 8 ORIENTATION: 8.50

LETTER LANDSCAPE
A4 PORTRAIT
Ad LANDSCAPE

AS PCRTRAIT r
._1.00

CSTHER F h 4
1.00 | 1.00

8.00 111.00

Press 1, 4 to change setling and press RETURMN.
Press «, —+ to rmove o another setting.

4. Press T and | to select the paper size and orientation. This
determines the width and length of the paper and the margins.

5. Press the arrow keys to move the cursor to the entry field for each
margin setting and type a value in inches.

* You can move the cursor to the underlined fields only. The
margin entry fields are always underlined. The width and length
are underlined only if you select OTHER for the paper size.

* Each field has room for five characters (four digits and a decimal
point). Pressing BACKSPACE or DELETE clears the whole field.

*» If the Data Area width is less than 1 inch or its length is less than
4 inches, this message appears:

[Incorrect setting! J

* With OTHER, if you set the width to more than .9..5 inches or the
length to more than 14 inches, this message appears:

|Incorrect setting! |
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If you press CANCEL while the
cursor is in the right box, the
sefting of the current labef name
cancels and you return o the left
box.

If you press CANCEL while the
cursor is not in the right box, you
retumn to the ADDRESSBOOK
PRINT MENU.

The maximum length of paper
that can print is 14 inches.

6. When finished, press RETURN to go back to the ADDRESSBOOK
PRINT menu.

7. Press RETURN at the Label setting to see the Label Set Print Menu where
you decide the contents and structure of the list you want to print. The
left box shows the list of labels of the current Addressbook file, preceded
by a small letter. The right box shows the contents and structure of the

BETTING CHARACTER: [
PRINTABLE CHARACTER: 66

s et i selenil Labied fiatrie o pieess
r»_m:. t DELEIE 10 Ctaar. Préss ‘

Pty
FhTIIRI‘J 0 wlacl prinkig

pTo change label print settings:

1. Move the cursor to a label name in the left box of the Label Set Print
dialog box.

2. To remove a label name, press DELETE. The check mark at the left
of the label name disappears, and the small letter corresponding to
that label is removed from the right box.

To set a label name, press SPACEBAR and the cursor appears in
the right box. Use the arrow keys to move the cursor in the right
box to a position and press RETURN to confirm the setting. When
the cursor moves to the left box, a V' appears.

3. Repeat steps 1 and 2 to get all necessary items in the correct
location.

As you add labels, Addressbook automatically shows the label width to be
printed. The total width, according to the selected character size and your page
setup, also appears. If you set too many labels in the records to be printed, so
that their length exceeds the printable length, your records are cut off.

pTo start printing:
1. Set papers on the paper support and press RETURN while the cursor
is not in the right box.
When label or list printing starts, this message appears:

L Printing....press CANCEL to stop printing. J

2. Press CANCEL to cancel printing. This dialog box appears:

OK lo cancel printing?

Il 'se cursor to select and press RETURN.

3. Select YES to cancel printing or NO to cancel the function.
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Selecting Records for Merge Printing

This feature turns the check mark on or off that appears at the left of the
records on the View screen.

During merge printing in the Word Processing program, records without
the check mark are ignored. (A new record is automatically active.)

During label or list printing, only records with a check mark print if you
select PRINT RECORD: SELECTABLE (¢). If you select PRINT RECORD:
ALL, the check marks make no difference.

P To select records for printing:

1. Press MENU to see the menu bar; select Print Record ON/OFF from
the Print menu. A dialog box appears:

How do you set print recerd anloff?

Use cursor to selecl and press RETURN.
DRI (ALL RECORD ON] [ALL RECORD OFF} [CANCEL)

2. Select the setting and press RETURN.
* CHOICE. Sets the check mark on or off for a block of records
* ALL RECORD ON. Sets the check mark on for all records
* ALL RECORD OFF. Sets the check mark off for all records
- * CANCEL. Cancels the function.
When you select CHOICE, this message appears:

Use cursor to select and press SPACE for print record on/
off. Press RETURN.

3. Move the cursor to a record and press SPACEBAR to turn the check
mark on or off. Press RETURN when you finish.

You can also select the record on the View screen and press SPACEBAR
to make a record inactive. The check mark of the selected record
disappears. Pressing SPACEBAR again reactivates the record.

Jump Menu (Data Input Screen)

m Label

Top Record
Bottom Record
Search

You can also press

CODE + G; then press T to jump
to the top record or CODE + G;
then press 4 to jump to the
bottom record.

Use the Jump menu to create a new record, to show the top or the
bottom record, or to search for a piece of information.

* New Record. Creates a new record

» Top Record. Shows the first record

* Bottom Record. Shows the last record

* Search. Searches for a piece of information

The first three options (New Record, Top Record, and Bottom Record)
work the same way as the options on the View screen. For information,
see Input Menu (View Screen) on page 129.
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P To search for an occurance of certain text:

1. Press MENU to0 see the menu bar; select Search from the Jump menu.
The Search dialog box appears:

Continue search?

Use cursor to select and press RETURNL
INOD]

2. Define the text and other settings as you would in Word Processing.
For information, see To Search for Text on page 45. When an
occurrence of the specified string is found, this dialog box appears:

3. Select YES to search for the next occurrence, NO to stop searching,
or CANCEL to return to the previous screen. When the text cannot be
Jound, this message appears:

lWord{s) not found.

Label Menus (Data Input Screen)

Option Sorean _ Use the Label menu to create, change, or delete labels.

Delete Label
Change Label Name & wiatn | * Insert Label. Creates a new label

¢ Delete Label. Deletes a label

* Change Label Name & Width. Edits a label and changes the column
width

All these options work the same way as on the View screen. For
information, see Label Menu (View Screen) on page 131.

Option Menu (Data Input Screen)

m Soreen The Option menu has only one function: Abbreviated Phrase
BT Maintenance. This function allows you to create, edit, print, load, and save
an abbreviated phrase file that is your list of short, often-used phrases.

For instance, you can store the phrase “United States of America” together
with the name “USA.” Once this has been done, all you have to do to
enter “United States of America” in your document is type “USA” and press
CODE + A. “USA” automatically replaced with “United States of America.”
{f you type a name that does not exist in the abbreviated phrase memory
and press CODE+ A, you hear a beep.

Screen Menu (Data Iinput Screen)

| =crzcn B Use the Screen menu to control the display on the screen.

.

¢ Change Screen. Switchs the active file while working in Dual Screen
mode

Bet to View Screen
Splil Size

s Return to View Screen. Returns to the View screen
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* Split Size(DP-540C]J, DP-550C], & DP-5040C]J only). Adjusts the
screen size while working in Dual Screen mode

Return to View Screen

This option returns to the View screen after editing or creating a record on
the Data Input screen.

The Screen options work the same way in Word Processing for Change
Screen and Split Size. For information, see Using the Screen Menu on page
81.

Press CODE + RETURN. The View screen appears.
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4 File Management
-

The File Management program allows you to organize and convert your files on a diskette. The index
screen of the File Management program lists all files.

All operations, except disk copy, can be started from the menu bar.

Please note that only
MS-DOS-formatted 1..44 Mb
MF-2HD and 720 kb MF-2DD
diskettes can be used on your
Desktop Publisher. If you get a
message indicating you have an
unformatted or damaged disk,
either replace the diskette with
another or go to page 22 in
Getting Started or page 148 in
this chapter for instructions on
how fo initialize a diskette.

You can move the cursor to the
file you want to select by pressing
the first character key of the file
name. For example, if you press
C, the cursor moves lo the file
whose name starts with a C.

Your Desktop Publisher can only
search Word Processing files
when the cursor is located at the
extension .WPT. Press TAB to
move the cursor fo the next
extension.

p-To start File Management:
1. Turn on the power to see the Main Menu.
2. Insert a diskette into the disk drive.
3. Press 4. The list of files appears:

<< FLE MANAGEMENT >

REMAIN: 1444.8 K] [IHs]HiHifsua]

LETTER1C.WPT ¢ ©O.6)
LETTERZ .WFT ¢ 0.8>

LETTER1IL1.WRT ¢ 0.5)
Select a file and prasz MEPI. Frass CAMCEL to auil,

The list of files stored on the diskette appears in the order shown in the
table below. The file names are sorted alphabetically for each of those
classes. The number following each file name gives the size of the file in
kilobytes.

Type of File File Name & Extension
Word Processing ANYNAME.WPT —
Word Processing Templates ANYNAME.WP1
Spreadsheet ANYNAME.SPR
Spreadsheet Templates ANYNAME.SP1
Addressbook ANYNAME.MRG
Addressbook Templates ANYNAME.MR1
Drawing ANYNAME.DRW
Drawing Templates ANYNAME.DR1
Greeting Card ANYNAME.CRD
Greeting Card Template ANYNAME.CR1
Communication ANYNAME.CPF
Clip Art ANYNAME.BIM
User Dictionary SPELLUSR.DCT
Abbreviated Phrase ABBR.PHR

ASCIl ANYNAME.TXT
Lotus® 1-2-3® ANYNAME.WK1
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When using Desktop Publisher files in a personal computer, and vice
versa, remember the following points:

* Your system can only read and write from the root directory of a
diskette. Do not create any directories on the diskette.

® When creating or renaming a file with your personal computer, make
sure that you use correct file name extensions. There are two major
errors in working with extensions that you must avoid:

1. The first error is to change the file name extension of a file that has
been created on your Desktop Publisher. For example, if you use your
personal computer to change the extension .WPT to .WP, your Desktop

’ Publisher will not recognize the file and will not show it on the index
or the File Management screens.

2. The second error is to create a file (using one of the above file name
extensions) in a format that cannot be recognized by your Desktop
Publisher. If you use your personal computer to create a file, giving
that file the file name extension .WPT, the file appears on the index
and File Management screens, but your Desktop Publisher will not be
able to open or convert the file.

Making a Backup Copy of a Diskette

The disk copy command copies all information on a diskette to another
diskette (backup copy). Disk copy does not appear on the menu bar.

CAUTION:

Copying an entire diskette to another diskette destroys any
information that may be on the destination diskette. Check the
destination diskette before starting. Make sure your destination
diskette has been initialized.

P To make a backup copy of a diskette:
1. Press CODE + SHIFT + O. This message appears:

iInsert source disk and press RETURN. I

Disk copy is only between 2. Insert the original source diskette and press RETURN. 7he Desktop
diskettes that are formatad o th Publisher starts reading files from the source diskette. The Desktop

f:n: 'izua"c: : : o':eczgjf;n; a Publisber reads the first portion of the diskette; then this message

1..44 Mb diskette to a 720 kb appears:
disksette, or vice versa.

LInsert destination disk and press RETURN. I

3. Insert the destination diskette and press RETURN. The Desktop
Publisher transfers the files that bave been read from the source
diskette onito the destination diskette. It then asks you to reinsert the
source diskette.
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Disk copy can be used only when
accessing File Management from
the Main Menu. It is not available
if File Management is accessed
through Word Processing,
Spreadsheet, Addressbook,
Drawing, and Greeting Card.

Using the File Menu

A  Disk Conv

File Delata
BRename
Feturn to Main Menu

4. Repeat steps 2 and 3 until all files have been transferred to the
destination diskette. You may need to swap these diskettes a number
of times before all files are copied to the destination diskette. The
Desktop Publisher knows which diskette is the source diskette and
which one is the destination diskette. If you insert a wrong diskette,
this message appears:

[[ Incorrect disk! n
= iy key ! ontinu

o~
o S

Insert the correct diskette and press RETURN.
When copying ends, this message appears:

[Disk copying completed. j

Use File to copy, delete, rename files, and return to the Main Menu.

* File Copy. Copies a file

s File Delete. Deletes a file

s Rename. Changes the name of a file

* Return to Main Menu. Returns to the Main Menu

File Copy copies 2 file. You may copy to the same diskette or to a
different one. If the destination diskette is the same as the source

diskette, the file name must be different.

pTo copy a file:
1. Move the cursor to the file name that you want to copy. Press
CODE + C. This message appears:

Ensert destination disk and press RETURN.
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2. To copy the file on the same diskette, press RETURN.
OR ‘

To copy the file to another diskette, insert that diskette in the disk drive
and press RETURN. The File Copy dialog box appears:

<< FILE COPY >

ORIGINAL FILENAME: AKDFLE WPT
TARGET FILENAME: AKDFLE ___.WPT

{ Existing File(s) '1

LETTER1 ..WPT ¢ 0.4) LETTER1O.WPT ¢ 0.4)
LETTER1LI.WPT ¢ ¢O.4) LETTERZ .WPT ¢ 0.4

I Type filename and press RETURN.

Press t, ¢ to scroll file directory .

This dialog box shows the files of the destination diskette that are
the same kind as the source file. The dialog box also provides an
entry field to type the name of the target file. When you type the
first letter of the file name, a list appears that starts with the file
alphabetically closest to that letter. It automatically scrolls to make
sure you do not enter an existing file name. To see another file
name, scroll manually using T or .

3. To copy the file, type a file name that is not in use on the destination
diskette; press RETURN.

pTo delete files from a diskette:

1. Move the cursor to the file name you want to delete. Press
CODE + D. A check mark appears at the left of the file name. This
message appears:

LPress SPACE to select file(s) and press RETURN. ]

2. Press the arrow keys to select a file name. Press SPACEBAR to turn a
check mark on or off to the left of the file name. Repeat this
operation to mark all files you want to delete; press RETURN. 7his
message appears:

OK to delete the selected file{s)?

cursos 0 select and press RETURN

[NO]

Use

[N

3. Select YES to delete or NO to exit and press RETURN. As files are
deleted, their file name appears. If you press CANCEL while a file is
being deleted, that file is still deleted. Other files marked to be
deleted, but which were not deleted before you pressed CANCEL,
are not deleted.
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P To rename files on a diskette:

1. Move the cursor to the file name that you want to rename. Press
CODE + R. The Rename dialog box appears:

<< RENAME >>»

CRIGINAL FILENAME: LETTERL .WPT
NEW FILENAME: LETTERL__.WPT

f Existing File(s) \

LETTER1 .WPT ¢ 0.4 LETTER1O.WPT { 0.4>
LETTER1LI.WPT ¢ 0.4 LETTERZ .WPT ( 0.4>

. Type filename and press RETURNMN.

‘Press *, 4 to scroll file directory_

The dialog box shows the files of the current diskette that are of the
same kind as the selected file. The dialog box also provides an entry
field to type the new file name. When you type the first letter of the
file name, a list appears that starts with the file alphabetically closest
to that letter. The list automatically scrolls to make sure you do not
enter an existing file name. To see another file name, scroll using T
or {.

2. Type a file name not in use on the current diskette and press
RETURN to rename the file.

P To return to the Main Menu:

Press CANCEL. This ends File Management and returns you to the Mair.
Menu.
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Using the Disk Menu

lﬂu Convert

Initialize Disk
Directory Read
List Print

All unprotected files on the root
directory are deleted with this
option. This includes unprotected
files created on a PC that do not
appear in the index.

Initialize Diskeftte

Your Deskiop Publisher uses both
MF-2HD and MF-2DD floppy
diskettes, though the MF-2DD
has half the capacity of the
MF-2HD.

Wheanever you use a diskette, the
Fife Management program
chacks its format. It recognizes a
new diskette or a diskette that is
not formatted to DOS 1..44 Mb or
DOS 720 kb. If the diskette is
new, a prompt asks if you want to
initialize. Select YES to initialize
the diskette (all contents will be
deleted).

Use the Disk Menu to initialize diskettes, update the index, or print file
names on diskette.

L]

Delete All. Deletes all unprotected files on diskette
Initialize Disk. Initializes a diskette

Directory Read. Reads the directory of a diskette when this has not
been done automatically

» List Print. Prints all file names indicated on the screen

P To delete all unprotected files from a diskette (Diskette
Delete):

1. Press MENU to see the menu bar; select Delete All from the Disk
menu. This message appears:

OK 1o delete all files on disk?.

Use cursor to selact and press RETURN.

2. Select YES to delete or NO to exit; press RETURN.

A new diskette must always be formatted (initialized) before you try to
use it. You can also reformat a diskette that already contains information
in order to clear all files and subdirectories.

CAUTION:
Executing Initialize Disk deletes all the information on the diskette.

You can format diskettes using either this Desktop Publisher or a personal
computer. If you use a personal computer, be sure to format the diskettes in
MS-DOS and use 2HD diskettes for 1-.44 Mb and 2DD diskettes for 720 kb.

P> To initialize a diskette:

1. Insert a diskette. This message appears if the diskette is unformatted or
damaged:

Unfarmatted or damaged disk!
Insert another disk and retry.

Lize curser to select and press RETIURM.
FETRY] [CANCEL]

2. Press CANCEL.

3. Press MENU to see the menu bar; select Initialize Disk from the Disk
menu. This message appears:
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Do you want to iniialize disk?
All data on disk will be deleted if initialized.

Eé-..‘se cursor {o select and press RETURN. ¢

4. Select YES to initialize or NO to exit and press RETURN.
If you select NO, initializing a diskette is canceled.
If you select YES, this message appears:

<<FORMAT TYPE »>»

R R
2DD DISK 720KB

‘Use cursor to select and press RETURN.

Press T and | to select a setting; press RETURN to start initializing the
diskette.

Directory Read |
The directory of a diskette is usually read automatically each time you
insert a new diskette. In some circumstances, however, the directory is not
read automatically, and you may need to update the index manually.
pTo update the directory manually:
Press CODE + F. The message “Working ...” appears while the
directory is being read.
P To print a list of all file names on the screen:
Set the papers and press PRINT. A/l file names indicated on the
screen print as follows:
FILE LIST Used: 97K Free: 14479 K
LETTERI .WPT  (0.4) LETTERZ WPT (0.4) LETTER3 .WPT (0.4) LETTER4 .WPT (0.4)
LETTERS .WPT  (0.4) LETTER6 WPT (0.4 BOOK2 MRG (1.5) BOOK3 MRG (L5)
BOOK! .MRG (1.5)
Using the Convert Menu

Convert menu converts your Word Processing files to a PC or make ASCII
files available to your Desktop Publisher.

* WP TEXT.WPT—ASCIL.TXT(Text Only). Converts a Desktop
N RS X T Tt with h“"'“"l Publisher file into an ASCII file (all format codes except TAB and
OHlGINAL._E_ER-OLOTUSlzs.WK'I RETURN are rem0ved)

* WP TEXT.WPT—ASCIL.TXT(Text with Layout). Converts a Desktop
Publisher file into an ASCII file; SPACE and RETURN codes are added
to preserve the look of the file.
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* ASCILTXT—-WP TEXT.WPT. Converts an ASCII file into a Desktop
Publisher file

Conversions to or from ASCII files are carried out according to the
IBM PC Code on page 155. For information about code page
switching, refer to your DOS manual (DOS command mode device
code page). A table on page 221 shows all characters that can be
correctly converted. Characters not included in that table are
converted into blank spaces.

* ORIGINAL.SPR—LOTUS123.WK1. Converts a Spreadsheet file into the
Lotus 1-2-3 format

Conversions to or from Lotus 1-2-3 files are carried out according to
LICS (Lotus International Character Set). For information, refer to
your Lotus 1-2-3 manual.

Converting Word Processing Files to a PC Format

* WP TEXT.WPT—ASCIL.TXT(Text Only)
* WP TEXT.WPT—ASCIL.TXT(Text with Layout)

You may want to use the information you create with the Word Processing
program on a PC. To do this, you must first convert the Word Processing
file into the ASCII format. Once this is done, you will be able to import
the ASCII file into most word processing programs available on PCs.

An ASCII (American Standard Code for Information Interchange) file
consists of printable information with no special formatting codes for
underlining, boldface, etc. These special formatting features, such as
underlining, do not translate correctly between your desktop publisher
and a computer. Therefore, when a file is converted to ASCII, all special
formats are eliminated. Once the file is transferred, the file must be
reformatted and any special effects must be added.

An ASCII file can include some formatting codes like carriage returns and
tabs. When you convert a2 Word Processing file into an ASCII file, you can
select one of the following:

* Text Only removes all formatting except TAB and RETURN from the
file. When you import such a file into a personal computer or a word
processing system, the text automatically adapts to the format of the
PC word processing program.

* Text with Layout preserves some of the format of the file. A return is
added at the end of each screen line.

However, if the margins of your original file are unusually wide, additional
carriage returns are placed into the file, and reformatting is necessary.
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p-To convert files from Desktop Publisher to PC:

1. Press MENU to see the menu bar; select
WP TEXT.WPT—ASCILTXT (Text Only) or
WP TEXT.WPT—ASCILTXT (Text with Layout)
from the Convert menu. The Convert Index dialog box appears:

<< CONVERT INDEX >> [CONVERT (Text with Layout) | [REMAIN: 1444.8 K] ms|§num§ SNlﬂi
LETTERL . WPT o  O.6) LETTER1O0.WPT ¢ 0.6>
LETTERIL.WPT ¢ ¢.5) LETTERZ ..WPT ¢ 0.8
Select s file to convert and press RETURM, FPress SAMNCEL b oeril

2. The index shows only Word Processing ( WPT) files. Press the arrow
keys to select the file you want to convert and press RETURN. 747s
message appears:

Ensert destination disk and press RETURN.

3. Insert the destination diskette and press RETURN, or press RETURN
if you want to store the converted file on the same diskette. This

dialog box appears:
<< CONVERT »>> l
CRIGINAL FILENAME: LETTER1 .WPT
TARGET FILENAME: LETTERL_. TXT

f Euxisting File(s) ‘

This dialog box shows the ASCI files (TXT) on the current diskette.
The dialog box also provides an entry field for you to type a new
file name. When you type the first letter of the file name, a list appears
that starts with the file alphabetically closest to that letter. It
automatically scrolls to make sure you do not enter an existing file
name. To see another file name, scroll manually using T or |.
Once a file is in ASCII format, 4. Type a file name that is not in use on the current diskette and press
you can recall that file into a word RETURN to convert the file. During conversion, the message
processing program on a PC. R R )
“Working ..." appears. When conversion is complete, the Desktop
Publisher asks you to reinsert the source diskette.

5. To convert another file, insert the source diskette and continue
converting. To return to File Management, press CANCEL.

Converting PC Text Files to Word Processing Files
* ASCILTXT—WP TEXT.WPT
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You may want to use text created on a PC with the word processing
program. To do this, you must first convert the text file from the PC into
ASCII format. Most PC word processing software allows you to save a file
as an ASCII text file.

You must also remember that your Desktop Publisher can only use
diskettes formatted to DOS 1-.44 Mb or DOS 720 kb. If you plan to move
information from a PC to your Desktop Publisher, you must be sure that
the diskette containing the file is formatted to DOS 1-.44 Mb or DOS 720
kb.

You can format your diskettes to DOS 1-.44 Mb or DOS 720 kb on a PC or
on your Desktop Publisher. Your PC manual should list the steps to
complete this operation.

The ASCII file must also be stored in the root directory of the diskette and
its file name extension must be .TXT.

P To convert files from PC to Desktop Publisher:

1. Insert the diskette containing the ASCII file into the disk drive. Press
MENU to see the menu bar; select ASCILTXT—WP TEXT.WPT from
the Convert menu. Press RETURN. 7This dialog box appears:

<< CONVERT INDEX >> |FlEMMN: 1440.2 KI

[ = S s

[LHSTHOMHshi

Selzst 3 file to convert and press RETURM. Fress CAPMCTEL to anit,

2. The index shows only ASCII (.TXT) files. Press the arrow keys to
select the file you want to convert and press RETURN. This message

appears:

IInsert destination disk and press RETURN.

3. Insert a destination diskette and press RETURN; or press RETURN if
you want to store the converted file on the same diskette. This dialog

box appears:

<< CONUERT >>

ORIGINAL FILENAME: SPECCH .TXT
TARGET FILENAME: SPECCH__.WPT

f Ewisting File(s) \
RABCDFILE.WPT ¢ ©0.%) AKDFLE .WPT ¢ ¢.4)
BDELFILE.WPT ¢ 0.8} GOSCHILE.WPT ¢ ©.6)
HEDFILES.WPT ¢ 0.8} MARCFILE.WPT {( ©.8)

I Type hlename and press RETURN.

(Press t, 4 to scroll file direclory. .
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Once a file is converted to
Desktop Publisher’s formal, you
can go to the file with the Word
Processing program.

The dialog box above shows the Word Processing files ( WPT) on
the current diskette. The dialog box also provides an entry field for
you to type the new file name. When you type the first letter of the
file name, a list appears that starts with the file alphabetically closest
to that letter. The list automatically scrolls to make sure you do not

enter an existing file name. To see another file name, scroll manually
using T or {.

4. Type a file name that is not in use on the current diskette and press

RETURN to convert the file. During conversion, the message
“Working ..." appears. When conversion is completed, the Desktop
Publisher asks you to reinsert the source diskette.

5. To convert another file, insert the source diskette and continue

conversion. To return to File Management, press CANCEL.

Converting Spreadsheet Files into Lotus 1-2-3 Files

Characters of the SPR file that do
not exist in the Lotus format are
converted into spaces.
Conversion of the text is
performed according to LICS
(Lotus International Character
Set).

* ORIGINAL.SPR—LOTUS123.WK1

You can convert a Spreadsheet file from your Desktop Publisher to the
Lotus 1-2-3 format in order to use the file on a PC.

pTo convert Spreadsheet files to the Lotus 1-2-3 format:
1. Insert the diskette containing the Spreadsheet file.

Press MENU to show the menu bar; choose
ORIGINAL.SPR—LOTUS123. WK1 from the Convert menu,
The Conwvert Index dialog box appears:

<< CONVERT INDEX >> [rEmain: o xx | joverf MWII

LETTERZ .5PR OXX.X) LETTER3 .SPR OOX.X)

Select 3 hile to convert and press RETURN. Press CANCEL to exit.

2. The index shows only Spreadsheet (.SPR) files. Press the arrow keys

to select the file you want to convert and press RETURN. 7his
message appears:

|Insert destination disk and press RETURN.

3. Insert a destination diskette and press RETURN; or press RETURN to

store the converted file on the same diskette. This dialog box
appears:
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<< COMNVERT »»

ORIGINAL FILENAME: LETTER3 ,SPR
TARGET FILENAME: LETTER3M. WK1

f Eristing Fiie(s} ‘

LETTERL WK1 (XXX.X)  LETTERZ WK1 OO(C.X)
LETTER3 WK1 (XXX.X)

narne and press RETURMN.
o scrolf hic drrectory.

The dialog box above shows the Lotus 1-2-3 files (WK1) on the
current diskette. The dialog box also provides an entry field for you
to type a new file name. You can scroll the list to make sure you do
not enter an existing file name.

4. Type a file name that is not in use on the current diskette and press
RETURN to convert the file. During conversion, the message,
“Working...,” appears. When conversion is completed, the Desktop
Publisher asks you to reinsert the source diskette.

5. To convert another file, insert the source diskette and continue
conversion.

OR
To return to File Management, press CANCEL.

Converting a Lotus 1-2-3 File into a Spreadsheet File

To use Lotus 1-2-3 files on your Desktop Publisher you do not need any
special conversion tool. A Lotus 1-2-3 file can be opened just like an .SPR
file using the Spreadsheet program if the following conditions are met:

¢ The file is stored on the root directory of a DOS 1.44 Mb or DOS
720 kb diskette.
* The file name extension is .WKI1.

There is no guarantee that the entire Lotus 1-2-3 file will correctly
convert. The conversion is incomplete in the following circumstances:

* The Lotus 1-2-3 file is too large (.SPR files hold 2 maximum of
256 rows X 256 columns). Conversion stops and the following
message appears:

Cells extend beyond range.
Unable to convert!
Press any key to conlinue.

* The Lotus 1-2-3 file size is larger than the maximum Spreadsheet
file size. Conversion stops and the following message appears:

Not enough memory remaining!
Press any key to continue.

* You need a password. Conversion stops and the following
message appears:
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IBM PC Code

Unable to convert!

Password is set.
Press any key to continue.

¢ There are more than 130 errors. Conversion stops and the
following message appears:

Cannot read this file!
Press any kay to continue.

* A cell in a Lotus 1-2-3 file contains more than 239 characters. In
this case, only the first 239 characters of the cell appear in the
converted file if the data is alphanumeric. If the data is a formula,
it does not convert.

¢ When a function available with Lotus 1-2-3 is not recognized or
“has a slightly different format (e.g. @COS(45*@P1/180)), it does
not convert. Check the Lotus 1-2-3 file to make sure only
functions and formats available on your Desktop Publisher are
used.

® Characters of the Lotus 1-2-3 file that do not exist on your
Desktop Publisher convert to spaces. The conversion of the text is
performed according to LICS (Lotus International Character Set).

The following table shows the printable characters that can be correctly
translated when you convert to or from ASCII files on your Desktop
Publisher. Empty cells in this table correspond to control codes or
characters that are converted into blank spaces.

0j1]|]2|3|4|5]|]6|7|8B8|]9]A|BJCIDI|E]|F
0 olelP|~|plclE]|A al=
1 llT1|Ajala|qlolae]|T B+
2 “12|B|RIbfr{éAE]OS r
3 # |3 |C|ISjc|s|af|dé]u n
4 $|14|D}|Tjd|t]|a]|o6]|hn =
5 %{5]EjU]elu]ajo|N o
6 |6 jF|VIfiv]iaja|? n| =+
7 171G |W]lgiw]ejuijf? T
8 (|8|H|[X{h}x]jé&]Vy]¢ ®|o
9 ylo(t|Y|i]ly[|[e]|O e
A * | 1JdlZ]jlz|8d |0 Q| -
B + | IK|[T Ikl {]T]e]ln B R
o] <Ly jriilelu o0
D ~l=IMj1 im0 [¥]; o |2
E >|IN|[Afn|~]A|Pt]« 3
F /I 1?2]10]|_}o Alr]-»
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5 Disk Application

Disk Application allows you to start programs that are not built into the system but come on separate

diskettes.

The following disk application programs come with your Desktop Publisher: Graphic Art Print, Frame
Print, Games, Fax, Self-Demo, and Tutorial. These programs (contained on three diskettes) are described
in Supplemental programs on page 29.

Using Graphic Art Print

Diskette 1 contains the Graphic
Art Print program. This diskette
must be inserted and Graphic Arnt
Print (GRARTPRT.APL) selected
before you can view graphics
{color or black and white).

The Graphic Art Print software allows you to print black and white and
color graphics. These graphics are stored on Diskette 3. You can select

graphics from various categories and print them in normal, half, or double
size.

These graphics print directly onto your paper. They are not saved as part
of a word processing file. To use a graphic as part of a document, print
the graphic onto the paper; then re-insert that paper for printing your text.
These graphics allow you to create such documents as personalized
letterheads, fancy invitations, and newsletters.

If you use special IRON-ON transfer paper, you can iron the graphic
image onto white or light-colored fabrics that are 100% cotton or

cotton/polyester blend, e.g., T-shirts, aprons, nightshirts, baseball shirts,
and pillowcases.

p-To print a graphic image on paper:
1. Turn on the power to see the Main Menu.
2. Insert Diskette 1 into the disk drive.

3. Press CODE + Q. A Iist of programs on the diskette appears on the
screen.

4. Press the arrow keys to select the graphic you want to print; press
RETURN. The Grapbic Art Print dialogdialogue box appears:

<< DISK APPLICATION >> !HEM“!N: 833.0 KI
R EF ST s

GRARTPRT.APL ¢ 31.0)

Sertect a e and press AETURN., FPress CANCEL 16 display MAIN MERU
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The Graphic Art Print program
from Diskette 1 must be inserted
and Graphic Art Print
(GRARTPRT.APL) selected
before you can see cojor or black
and white graphics.

When you select REPEAT:YES,
the cursor moves in a vertical
direction only. The cursor can
move anywhere within the
selected paper size.

When you select REPEAT
PRINT:YES, the maximum
number of images that can print
within the width of the specified
paper are printed.

5. Press RETURN. The list of black and white grapbics appears.

You must use the color ink cartridge to print color graphics. You can
use either the black or color ink cartridge for printing a black and
white graphic. Please check your ink cartridge before printing.

6. Press the arrow keys to select the graphic you want to print; press
RETURN. The Grapbic Art Print dialog box appears:

<< GRAPHIC ART PRINT >>
FILENAME: BASY &M

PRINT SI1ZE:

(1o8x 288 f v, 0.50
REPEAT PRAINT: NO h :[ VVVVVVVVVVVVV *: 2.8t
NUMBER OF COPIES: "
PAPER SIZE: LETTER PORTRAIT
PRINT QUALITY: MEDIOM
MIRAOR PRINT: NO

Press SPACE to change setting.

Precs TAB fn st printing pasition - Press RETURN ko print

7. Press T and | to move the cursor to a setting. Press SPACEBAR to
change the settings or type in values.

* PRINT SIZE:
NORMAL—Prints the graphic at actual size
HALF SIZE—Prints the graphic at half width and half height
DOUBLE SIZE—Prints the graphic at double width and double
height
e REPEAT PRINT—No: Prints one graphic
Yes: Prints multiple copies of a graphic

e NUMBER OF COPIES: The number of times the paper prints
(maximum 999)

¢ PAPER SIZE: The paper orientation and size to be printed

¢ PRINT QUALITY:
FINE—For final quality printing
MEDIUM—For average quality printing
DRAFT—For trial printing. With this setting, you save time and
ink.

* MIRROR PRINT:
NO—For normal printing
YES—For printing the graphic with a reversed image. Mirror
printing is useful when printing graphics on the iron-on transfer
paper. We recommend using Brother iron-on transfer paper.
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The size of the cursor reflectsthe 8. Press TAB to set printing position. The cursor appears in the right
size of the selected information. box.

When you select REPEAT
PRINT/YES, the cursor moves in
a vertical direction only.

<< GRAPHIC ART FRINT >>
FILENAME: BASEBAL .BIM

The cursor can move anywhere PRINT SIZE: NORMAL v: 0.50
within the selected paper size. T (197 % 280 ] x: 2.80
NUMBER OF COPHES: 1
PAPER SIZE: LETTER PORTRAIT
When you select REPEAT o Sty rEECER oer
PRINT/YES, the maximum PRINT GQUALITY: MEDILM

number of images that can print
21 the width of the specified paper
are printed.

Move cursor to set position.

FPress TAR (o chiange setling, RETURMN lu print.

9. Place the cursor where you want to position the graphic and press
RETURN. If you select a black and white graphic file and the color
cartridge is inserted, this dialog box appears:

<< COLOR >>

BLUE
GREEN
CYAN
RED
MAGENTA
YELLOW

10. Press SPACEBAR to change the setting; press RETURN.

If you select the color graphic file and the monochrome cartridge is
inserted, this message appears:

Cannot print using monochrome ink cartridge!
Replace it with the color cartridge.
Press any key to continue.

Replace the cartridge and press RETURN.

11. Set your paper according to the size you set in the Graphic Art Print
dialog box. Press RETURN to start printing. This message appears:

Printing....press CANCEL to stop printing.

12. Press CANCEL to stop printing. 7his dialog box appears:

QK to cancel prinling?

L"fﬂf‘"gm to select and press RETURN.
i EZ] [NO]

Select YES to cancel printing or NO to continue printing.
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Using Frame Print

This feature prints a frame as a border in your document. These frames
print directly on your paper and are not saved as part of 2 word
processing file. Instead, to frame a document, you will print the frame on
the paper and then reinsert the paper to print your document.

pTo print a frame:
1. Turn on the power to see the Main Menu.
2. Insert Diskette 1 into the disk drive.

3. Press 5. A list of programsprogrammes on the diskette appears on the
screen:

<< DISK AFPFLICATION >> [REMAINT_as3.0 «] [ovew) mm e

OGRARTPRT.APL { 31.0»

feoloct a filo and pross RETURN, Procs CANCE

4. Press the arrow keys to select FRAMEPRT.APL and press RETURN.
(Insert the color ink cartridge if you want to print the frame with
color.) The Frame Print dialog box appears:

<< FRAME PRINT >>

e i

DESIGN:

NUMBER OF COPIES: 1
PAPER S1ZE: LETTER RORTRAIT
PRINT QUALITY: MEDILM

ta selach image and preco HE DUIRR

rRas 4, -+
Press 1.+ to move 1o anolher setting

5. Press T and ! to move the cursor to a setting. Press «, —, or
SPACEBAR to change settings or type in values.

Select FRAME TYPE and then * FRAME TYPE: An icon shows an example of each type of frame
DESIGN. ¢ DESIGN: An icon shows an example of each type of design

¢« NUMBER OF COPIES: The number of times the paper prints
{maximum 999)

» PAPER SIZE: The orientation and size of paper to be printed
* PRINT QUALITY:

FINE—For final quality printing

MEDIUM—For average quality printing
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DRAFT—For trial printing. With this setting, you save time and
ink
6. Press RETURN to enter the settings of the Frame Print dialog box. If
the color cartridge is inserted, this dialog box appears:

<< COLOR >>

B0
BLUE
GREEN
CcYanN
RED

MAGENTA

YELLOW

Press t,+ to change setting and press RETURN.

Press T and | to change the setting and press RETURN. The frame
information will be printed out. The following message appears
while printing.

I Printing . . . press CANCEL to stop printing. |

7. Press CANCEL to stop printing. 7his dialog box appears:

\Use cursor to select and press RETURRN.

OHK lo cancel printing?
£ [NCJ

Select YES to cancel printing or NO to continue printing.

p-To use the tutorial:
1. Turn on the power to see the Main Menu.
2. Insert Diskette 1 into the disk drive.
3. Press CODE + Q. A list of programs on the diskette appears on the
screen:

Model DP-530CJ

<< DISK APPLICATION >3 [REsama: 767,64 K] |ovEREHUMISHIT
IR EYEEEEEER POKER «APL ¢ £3.5>
TUTOR APL ( 27.7)

Seeesbable snd prez: RETURRS ez A ZEL B dizplay DR RAET L
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Model DP-540CJ, DP-550CJ, & DP-5040CJ

<< DISK ARPFLICATION >>

POKER «APL { E3.5) TUTCR APL ¢ 27.72

sotact a tle and precc Hik TURPL Frocc

UAMNUEL lo display RARN MERI.

4. Select a program and press RETURN. The program starts.

5. Follow the instructions shown on the screen.

Using Disk Applications

pTo use the tutorial:
1. Turn on the power to see the Main Menu.
2. Insert Diskette 1 into the disk drive.

3. Press CODE + Q. A list of programs on the diskette appears on the

Screen:
Model DP-300CJ
<< DISK APPLICATION »> {remain: 7874 K|

POKER .APL ¢ B3.5%)
TUTOR «APL ¢ 27.7

cratile andprezs RETURM Fresz TAMCEL bo dizplay R IFE RAE M
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Model DP-400CJ & DP-5040CJ

ez —
<< DISK APPLICATION >> [REMAINT 7574 K] Hum JerieT]
T $  FOKER  (APL < 63.5) TUTOR  .APL ¢ 27.77

Salect a hle and press His PORMN. Hress CANGCEL 1o displary MAITN M EIU

4. Select a program and press RETURN. The program starts.

5. Follow the instructions shown on the screen.

Playing Games: Black Jack

This version of Black Jack is a simplified version that does not contain the
options of Double Down, Insurance, or Split.

To play Black Jack, you begin at the Bet screen:

Bet:

§ DR

Y ou:

Use t,4 o change bet and press RETURN.

P

This screen shows your credit and allows you to bet.

When the game starts, you begin with a credit of $1,000. Use the T and |
to increase or decrease your bet by $10. Press RETURN or SPACEBAR to
start playing. A screen similar to the one below appears:

Bet: »?
00050

= Stand
Y ou: 12
500950 -
¥ 2z
»
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Screen Indicators

Value of the Cards

Bet Current bet
ou our current credi
M7 The unknown total of the machine
09 Your total
Stand You are not issued an additional card.
Hit You are issued an additional card.
[music note] The sound is turned on.
A tnitially 11, but changes to 1 when the total
would exceed 21
K QJ 10
Other cards Their number

When this screen appears, the total of your cards and the total of the
Dealer’s cards are either 21 or less than 21.
e If both totals are 21, nobody wins (Push).

* If your total is 21, you win (with Black Jack). The Bet screen reappears,
and your credit is increased by 1.-5 X your bet.

» If the Dealer’s total is 21, you loose (with Black Jack). The Bet screen
reappears, and your credit is decreased by the amount of your bet.

¢ If both totals are less than 21, you can hit or stand.

Use the T and | to select Hit or Stand and press RETURN or SPACEBAR to
confirm.

When you select Hit, you receive an additional card.

e If your total is still less than 21, you can repeat the step above (hit or
stand).

* If your total is equal to 21, you win (without Black Jack). The Bet
screen reappears, and your credit is increased by the amount of your
bet.

e If the total exceeds 21, you loose (Bust). The Bet screen reappears, and
your credit is decreased by the amount of your bet.

When you select Stand, the Dealer shows his cards and can request
additional cards in order to get a total closer to 21 than your total.

o If your total is closer to 21 than the dealer’s total, or if the Dealer’s total
exceeds 21, you win. The Bet screen reappears, and your credit is
increased by the amount of your bet.

* If the dealer’s total is closer to 21 than yours, you loose. The Bet screen
reappears, and your credit is decreased by the amount of your bet.

At the start of the game, your credit is $1,000. The game is over when you
have no credit left. :
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Bet:
$00000

Y ou:
$0000C0

L

Press Y to show the Bet screen, or press N to quit.

To exit from this garhe before the game is over, press MENU, then
CANCEL.

If your credit reaches $10,000, this message appears:

Bet
$00000

Y ou:
$§00000

»

Press Y to re-start the game or press N to quit.
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Key Quick Guide

T To increase or decrease your bet (while viewing
the Bet screen

To select Hit or Stand (while playing)

SPACEBAR RETURN To confirm your bet and start playing (while
viewing the Bet window)

RETURN To confirm your selection (Hit or Stand — while
playing) .

H Same as selecting Hit and pressing SPACE-
BAR

T Same as selecting Stand and pressing
SPACEBAR

S To toggle the sound on/off

MENU To show a dummy WP window. Press MENU to

restart playing, or CANCEL to exit the game.

Using the Fax Function (US Models Only)

The FAX function allows you to send the text file that you created in word
processing directly to the facsimile machine by using an optional
Fax/Modem.

NOTICE: The Telepbone Consumer Protection Act of 1991 mabkes it
unlawful for any person to use a computer or electronic device to send any
message via a telepbone fax machine unless such messages clearly contain
in a margin at the top or bottom of each transmitted page or on the first
page of the transmission, the date and time it is sent and an identification
of the business or otber entity, or other individual sending the message and
the telepbone number of the sending machines or such business, other
entity, or individual.

pTo set up the FAX:

1. Insert Diskette 4 into the disk drive; press CODE + Q at the Main
Menu.

2. Press T or {; select FAX SET UP from the FAX MENU below:
3. Press RETURN. The following screen appears:

<< FAX MENU >>

SEMD 8 FEe
FAX SET UP

Insert your data disk and press RETURRML
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Please refer to page for
information on modem settings.

<< SET UP >>
FAX NUMBER:
NAWME:
CIAL MODE: TOMNE
MO DEM: FX-144

Type yvour fax number and press AETURNMN.

4.

Use the arrow keys to move the cursor to the parameter.
YOUR FAX NUMBER: Type in your fax number.
YOUR NAME: Type in your name,
DIAL MODES
TONE: For a push button phone.

PULSE: For a rotary dial phone.
MODEM

Determines the type of modem to be used in FAX mode. If
Other is selected, the initial string setting screen appears.

Please refer to the manual of the FAX/MODEM which you use
to verify the settings. If the incorrect settings are stored, a
follow-up message appears when sending the fax.

Modem setting is not correct. Check setting.
Press any key to continue.

5.

Press RETURN when you finish the settings. The changed
information is stored on your program disk. 7he FAX MENU screen

appears.

pTo send a FAX:

1.

W

Connect the optional Modem to the serial port of the machine before
turning the power On.

Turn on the power to the modem and your Desktop Publisher.
Insert the fax program disk into the disk drive.

Press 5. A list of the programs contained on the diskette appears on the
screen.

. Use the arrow keys to select the FAX program file (FAX.APL).
. Press RETURN. The FAX MENUscreen appears:

<< FAX MENU >

S EMC O O

FAX SET UP

Insert your data disk and press RETURN.

p-To send a file to the FAX:

1.
2.

Press T or 4; select SEND A FAX on the FAX MENU.
Press RETURN. The list of word processing files appears.
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3. Use the arrow keys to select the file to be sent to the facsimile
machine; press RETURN. The following screen appears:

<< SEND A FAX »>>
FILE NAME TO SEND: LETTER1.WFT
FAX NUMBER:

AUTC REDIAL: YES
LETTERHEAD: NO
DATE: TIME:

Type fax number. .
Press RETURNM to execute. Press CANCEL to cancel.

4. Press T and | to move from one item to the next. Type in the fax
number, date, and time; press SPACEBAR to change each setting of
AUTO REDIAL and LETTERHEAD.

FAX Number. The number of the fax where you wish the document
to be sent. A fax number is made up of digits (0-9). You may also
use other characters in addition to digits. These characters and their
functions are listed below:

Characters Function
0-9 The actual fax number
() - Parentheses and hyphens make the numbers

easier to read {these are ignored when dialing)

Each comma inserts a two-second pause. This
is useful when the auto dialing pace is too fast.

x # Gives a tone while dialing

w Waits for a second dial tone (insert this
character between the international call number
and the rest of the fax number to aliow for
connection.)

T Specify tone dial mode. Enter this character
before the fax number to override the dial mode
setting of the DIAL MODE entry field.

Auto Redial. If you set Auto Redial to YES, the machine
automatically redials two times when the line is busy. If the setting is
No, the machine aborts the transmission when the line is busy.

Letterhead. Set Letterhead to YES if you want the machine to create
a letterhead design at the top of each page.

Date. Type in today’s date.
Time. Type in today’s time.

* The setting on the Send a Fax mode cannot be stored in the memory
and disk. You must type in the information each time when
activating the fax mode.

~ * The fax number cannot be merged from the Addressbook file.
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We recommend that you create
the word processing file with the
font Brougham 12 point {o send
the file properly to the remote fax
machine.

5. Press RETURN when you finish the setting. The selected file will be
sent to the facsimile machine. The Send A Fax screen appears when
transmission is completed.

The machine converts the selected word processing file into ASCII
format. An ASCII (American Standard Code for Information
Interchange) file consists of printable information with no special
formatting codes for such features as bold, italics, and underline.
These special formatting features will be eliminated when sending
the file to the facsimile machine.

If sending the file is not perfectly completed during transmission, the
following error message appears:

FAX communication error!
Press any key to continue.

Press any key to return to the Send A Fax screen. Please retry to send the
file. '
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6 Drawing

If you see a message indicating
you have an unformatted or
damaged disketle, replace the
diskette with another or go to
page 22 in Getting Started for
instructions on how fo initialize a
diskette.

There is a 1/2 inch area around
all sides of the paper where
information cannot be printed

property.

This program allows you to create several different kinds of graphics, such
as maps, illustrations, and shapes, by using the unique and powerful tools
provided.

pTo create a new file:

1. From the Main Menu, press 6 to select Drawing. A /ist of the drawing
files appears.

‘ ? Drawing \

HHEWDRAL

2. Press RETURN when you see the file *NEWDRAW highlighted. The
Input/Edit screen appears.

P To edit an existing file:
1. Insert the diskette with the file into the disk drive.

2. Press 6.

3. Use the arrow keys to highlight the file you want to retrieve; press
RETURN. (To begin work on a new file, move the cursor to
*NEWDRAW; press RETURN.) The Input/Edit screen appears:

onw ANEWDRAW Prass MENU to sslect functian.

IHE § UM IFT|

ol 1 1 2 3 3 : % ] k=) E -] 1 7 s

The Input/Edit screen is divided into two parts:
Status Line: Shows the current settings and guide messages

Input/Edit Area: The second portion of the screen (all the area not
included in the Status Line). The Arrow symbol shows the current cursor
position. The dotted line shows the border of the Input/Edit area.

4. Use the arrow keys to move the cursor.
5. Select a drawing tool from the menu.
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Working with Drawing Tools

When creating or editing a drawing file, keep the following points in
mind:

* The system automatically brings objects forward (to the front) in the
following order when showing and printing:

1. Text

2. Images

3. Graphic Art

4. Box/Fill Box/Circle/Fill Circle/Line
5. Train Track

6. Road/Roundabout
7. River

* Whenever two or more boxes, filled boxes, circles, filled circles, or
lines are combined, the old object is moved backward automatically.

* Whenever the same kind of roads (road, train tracks, river) overlap, a
crossing is automatically created as shown below:

Up to 100 roads, roundabouts,

train tracks, or rivers can be put

into one file. If you try to draw the

data more than 101, the error

message “Too many objects! -p
Maximum of 100 roads,

roundabouts, train tracks, or river

objects can be used. Press any A
key to continue.” will appear.

* When you draw the line of a road, roundabout, train track, or river, the
cursor always appears at the center point of these objects.

Using Menu Functions

The following functions (File, Insert, Map, Draw, Edit, Style, and Print) can
be found on the menu bar at the top of the screen. Press MENU to see this
bar.

Using the File Menu

All Drawing files end with the file. Use the File Menu to open, save, close, delete, or rename your files;
extension “.DRW" initialize disks; and return to the Main Menu. These functions work exactly
the same way as the Word Processing program, except for the following

Insart R points:

Zreate MNew File

.g_pe: FF.III: * The Clip Board memory is cleared when you close a Drawing file. If
E?:ﬁe File there is any information stored in the Clip Board when Close File is
Eile Managerent selected, the following screen appears: -
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CRAWING CLIP BOARD data will be delsted!
Press any key to continua.

e When Open File is selected, the File Index for Word Processing,
Spreadsheet, and Addressbook does not appear. It appears only for
Drawing.

* Open File for Dual is not available in Drawing mode.

Using the Insert Menu

Use these functions to insert various kinds of information at the current
cursor position:

Sraphic At * Images: Inserts a special symbol

* Text: Inserts a block of text

¢ Graphic Art: Imports graphic art information from a diskette

pTo insert images:

1. Press MENU and select Insert; then select Images from the function
menu. The following screen appears:

<< IMAGES >>

HEEgaeaBa

Press «, 3, 1, + to select a image and press RETURRN.

2. Use the arrow keys to select the image; press RETURN.

Besides the arrow keys, you can use the following keys to move quickly
through the image screen:

Keys Cursor movement

CODE + EXPR To the beginning of the line shown
CODE + RELOC To the end of the line shown

CODE +PRE S To the beginning of the previous line
CODE + NEXT S To the beginning of the next line

The screen changes to Size and Color Change mode. On this screen,
the image you have selected appears in the center. You can also
change its size and color.
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<< IMAGES >> Fress SPACE to changa size. Prass COLOR 1o change color.
Press RETURM to oontinua or CANCEL o @it E—Z‘I[u_{]
T ]

) 1 f 2 1 3 t & f s ' 5 i

P ame——

=]

Press SPACEBAR to change the size of the image. The indicator on the
status line changes cyclically:

1 Insert the image in normal size
7] Insert the image in half size
2 Insert the image in double size

Press CODE + COLOR to change the color of the image. If CODE +
COLOR is pressed, the following screen appears:

<< COLOR >>

BLUE
SREEN
CYaN
RED
MAGENTA
YELLOW

Press t,4 to change setling and press RETURM.

Press T and | to select a color; press RETURN. The status line
indicator changes to indicate the selected color.
3. Press RETURN to enter the Position Set mode. The following screen

appears:

<< IMAGES >> Moue oursor to pasition ta paste data and press RETURN.

] 4 L] 3 1 4 I [] ] ] ] ki A

of T

H

4. Use arrow keys to move the selected image to a position.
Besides the arrow keys, you may use the following keys to move the
image quickly:

Keys Cursor movement

CODE + L Aligns the image to the left edge of printing area

CODE +F Centers the image between both left and right edge of
print area

CODE+R Aligns the image to the right edge of printing area
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FNEWDRAW Press MENU lo selact function.

<3 1 4 1 k=1 3 6 1 7 ]

o2 1 H 2

1 EED

a

Pressing CANCEL always returns you to the previous screen. If the image
is beyond the edge where the Desktop Publisher can print and RETURN is
pressed, then the following message appears:

Data will be truncated!
Press any key to continue.

> To use the text function:

1. Press MENU to see the menu bar; select Text from the Insert menu.
The following screen appears:

LLTEXT >>

Press T STYLE, FONT ar COLOR to change text attribute_
Type text and press CODE + RETURNMN. Press CANCEL to exil.

2. Type the text. Up to 2,249 characters can be typed. You can change
the type style, font, point size, and color of the text. Only one kind
of type style, font, point size, and color can be applied in each
character area. Use the following function keys to change attributes

of the characters.

Keys

Cursor movement

CODE + T STYLE
CODE + FONT
CODE + COLOR

Changes the type style of the characters
Changes font and size of the characters
Changes color of the characters

You cannot, however, see the actual effect of the character on this

input screen.

These functions work exactly the same way as in Word Processing.
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The following keys are valid on the previous screen:

Keys Function

Alphanumeric letter Type in the letters

Numeric information Type in numeric information

Symbois (CODE + SYMBOL) Type symbols

Extra characters (CODE + E CHAR) Type in extra characters

SPACE Type in a space

PERMANENT SPACE Type in a permanent space

HYPEN Type in a hyphen

PERMANENT HYPHEN Type in a permanent hyphen

INSERT Switches the Insert mode on/off

CURSOR UP/DOWN/LEFT/RIGHT Moves the cursor in the desired
direction

DELETE Erases the data at the current
cursor position

BACKSPACE Erases the data just before the
current curser position

WORD OUT Erases a word

CODE + LINE OUT Erases a line

CODE +EXPR Moves the cursor to beginning of
the current line

CODE + RELOC Moves the cursor to the end of
the current line

CODE + T STYLE Enters the Type Style Change
mode

CODE + FONT Enters the Font Change mode

CODE + COLOR Enters the Color Change mode

RETURN Enters the Width Set mode

CODE + RETURN Enters the RETURN symbol

CODE +D Deletes all information in the
character input mode (the con-
firmation message appears
before erasing the information)

CODE +B Turns the bold mode on/off

CODE + N Switches the underline mode
on/off (continuous/word/off)

CANCEL Returns to the previous screen

If the character or space is typed in at the end of the line, the cursor
moves to the next line automatically. The Word Wrap function is not
active at this time.

If CODE + D is pressed at the Character Input screen, the following screen
appears:

OK to delete all input data?

tUse cursor to select and press RETURNL

FES [NO]
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Select YES to delete all‘typed information, or NO to cancel the function.

3. When finished editing, press CODE + RETURN. The following screen
appears:

<< WIDTH SET >>
WI(DTH SET:

Press SPACE to change setling and press RETURMN.

4. Use SPACEBAR to change a setting and type the value.
WIDTH SET Auto: The width of the text area is automatically adjusted
to the longest line. The maximum width is 6 inches.

WIDTH SET Manual: You can change the width of the text area. The
line of WIDTH appears on the screen with the following message only
when MANUAL is selected.

I Type number and press RETURN ]

Width: Sets the width of the text area manually. Type a value in
inches.

The maximum and minimum text areas are as follows:
Minimum Width Maximum Width

Paper Size

4 inches
1 inch 6 inches

A5 Portrait
Others

If an incorrect value is typed in, the following error message appears:

I Incorrect Setting! |

Scrolf the data in the box up and 5. When finished, press RETURN. The following screen appears:

down by pressing T |, T > e R o e, TS e S Tl {5 § rand e

o 1 t z : 3 ) ¢ s : ¢ : 7 v

EBCD EFGHIIK]

3

6. Press RETURN to enter the Position Set mode, or press CANCEL to
return to the Width Set mode. The following screen appears if
RETURN is pressed:

<< TEXT >> Mave cursor ta poaition to pasts dats snd prass RETURAN, fouerf wom JlsirT]

o 1 P 2 1 3 T Y : = 1 ) T 3

IS

3

7. Use the arrow keys to move the character information to a position.
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Besides the arrow keys, you can use the following keys to move the text
quickly.

8. Press RETURN. Insert the information. The N is located at the center
of the inserted information.
[EEN— AEWDRAW Press MEMW ta aaiact function. m

o 1 P 2 1 3 1 ) : 3 ' Y : 7 :

ABCRDEF

If the text is beyond the edge where the Desktop Publisher can print and
RETURN is pressed, the following message appears:

Data will be truncated!
Fress any key to continue.

pTo use Graphic Art:

1. With the Graphic Art Image diskette in the drive. press MENU and

select Graphic Art from the Insert menu. 7he Graphic Art file list
appears.
If the Color Image file is 2. Use the arrow keys to highlight the file you want to use; press
selected, the Color indicator RETURN. The following screen appears with the selected
does not appear on the status . R
line. information shown:
K< ARAT >> Preass SPACE to change size. Press COLOR ta changs color.

Prass RETURN o continua or CANCEL 1o axit.
o 1 H 2 ] 3 a L H 5 H [-] : 7 ]

Press SPACEBAR to change the size of the information. The status line
indicator changes cyclically.

1 Insert the graphic art in normal size
1/ Insert the graphic art in half size
2 Insert the graphic art in double size
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Pressing CODE + COLOR is
invalid when a color graphic is
selected.

Pressing CANCEL always allows
you to return io the previous
screen.

When the Garphic Art information cannot fit on a smgle page and
RETURN is pressed, this screen appears:

Data will be truncated!
Praess any key to cantinue.

Change the Graphic Art information to the appropriate size by pressing

SPACEBAR again.

Press CODE + COLOR to change the color of the information. Select
a color and press RETURN. The indicator on the status line will be
changed to the indicator of the selected color.

Press t 4 to change setting and press RETURDPL

<< COLOR »>»

BLUE
GREEMN
CY AN

RED
MAGENTA
YELLOW

3. Press RETURN to enter the Position Set mode. The following screen

appears:

4. Use the arrow keys to move the Graphic Art to a position.
Besides the arrow keys, you can use the following keys to move the

graphic art quickly.

Keys
CODE +L

CODE +F

CODE +R

Cursor movement

aligns the information to the left edge of printing
area

centers the information between left and right
edges of printing area

aligns the information to the right edge of printing
area

5. Press RETURN to insert the selected information. The file name of
the Graphic Art information appears at the center of the box. You
will, of course, be able to print out the complete image information.
The N is located at the center of the inserted information.

If Graphic Art is beyond the edge where the Desktop Publisher can
print and RETURN is pressed, the following message appears.

Data will be truncated!
Press any key to continue.
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Using the Map Menu

The color used for roads cannot
be changed; they are always
black.

Pressing CANCEL always allows
you to retum to the previous
operation, If CANCEL is pressed
in the start position set mode, you
can return to the nomnal
Input/Edit mode.

Pressing DELETE just after
pressing RETURN or period
erases the current road.

* Road: Draws a line that indicates a road

* Roundabout: Draws lines representing a roundabout
* Train Track: Draws a line indicating a train track

¢ River: Draws a line representing a river

p-To draw a road:

1. Press MENU and select Road from the Map menu. 7he following
screen appears:

<< ROAD >> Press SPACE to vhange size.
Mova cursar (o starl position and prass AETUFRN.

a2 1 ] 2 1 3 t 4 ] -3 1 -] 1 2 1

2. To draw a road, move the arrow to the starting position for the road;

press RETURN. The previous message is replaced with:

Press SPACE to change size.

Move cursor to end position and press RETURMN.

After the start position is set and the cursor is moved, a + sign appears at

that positon.

You can set the width of the road by pressing SPACEBAR. You will

see the road width at the top right of the screen.

-

3. Use the arrow keys to move to the end position for the road; press
RETURN. If you press the period key instead of RETURN, the
Desktop Publisher draws the road from the start position (or the
position of the period key) but still asks you to draw the road from

that position. Using the period key is useful when you wish to draw

the road continuously.
4. Repeat steps 2 and 3 to draw all roads.
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The color ofa roundabout is
always black.

<< ROAD >> Press SPACE lo change size. .
Mova cursor to start position and press RETUWRN.

ot 1 H 2 H 3 H 4

; N
|

> To draw a Roundabout:
1. Press MENU, then select roundabout from the Map menu. The

Jollowing screen appears:
<< AOUNDABQOUT >> FPrass SPACE to change size.
Mova cursor to slart pasition and prass RETWURN.
pC 1 H 2 1 3 1 4 H 5 H -] ] 7 ]
[
! k

2. To create a roundabout, move the arrow to the start position
(upper-left corner) for the roundabout; press RETURN. 7bhe previous
message is replaced with:

Press SPACE to change size.

Move cursor to end position and press RETURN.
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After the start position is set and the cursor is moved, a + sign appears at
that positon.

You can set the width of the roundabout by pressing SPACEBAR.
The status line indicator changes cyclically.

m Narrow Road

m Medium Road

Wide Road
o
Pressing DELETE just after 3. Use the arrow keys to move to the end position (right-bottom
pressing RETURN erases the corner) for the roundabout; press RETURN.
current roundabout.
The following cursor movements create the roundabout shown
below:
T -
L
' -
: R
h
Pressing CANCEL allows you to 4. Repeat steps 2 and 3 to draw all roundabouts.
retum to the previous screen. If . . . .
CANCEL is pressed in the start If the roundabout is smaller than the minimum size, the following
position set mode, you can retum message appears:

to the normal Input/Edit screen.

The abject is too small to draw!
Press any key ta continua.

The maximum size of a roundabout is 2"2. If the roundabout is
bigger than this maximum size, the following message appears:

The cbject is too big to draw!
Press any key to continue.
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If the roundabout is written on the road, the roundabout will be
created automatically as shown below.

[oRw P DREAMPLE Press NMENU ta select function.

po 1 : 2 : <] : a

D> To draw the train track:

The color of a train track cannot 1. Press MENU; then select Train Track from the Map menu. The

be changed; it is always biack. fo lowin g screen appears:
ERALWAY TRASK >> :dl::: f:fof?n‘:t:‘:l‘:ags.ili-:::\.;nd press RETURMN,
o 1 i 2 ] 3 H 4 3 s ] [-] 1 3 ]
! 3

2. To draw a train track, move the arrow to the starting position for the
line; press RETURN. The previous message is replaced with:

Press SPACE to change size.

Move cursor to end position and press RETURN.
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After the start position is set and the cursor is moved, a + sign appears at
that positon. ’

Press SPACEBAR to set the width of the train track. The status line
indicator changes cyclically.

IIT 1| Narrow Train Track
[T 11 ] Medium Train
Track
Wide Train
Track
Pressing CANCEL always aliows 3. Use the arrow keys to move to the end position for the train track,
g:‘e'i:ﬁ’:r:;”’:f’g ﬂfc""gffs pressed press RETURN. If you press the period key instead of RETURN, the
in the start position set mode, you Desktop Publisher draws the train track from the starting position (or
can return to the nomal the position where you press the period key) but still asks you to
Input/Edit window. draw the train track from that position. Using the period key is
Pressing DELETE just after useful when you wish to draw the train track continuously.
pressing RETURN or period 4. Repeat steps 2 and 3 to draw all train tracks.
erases the current train track. E!_N__ﬂ DRSAMPLZ Press MENU to select function.
fall) H 1 1 2 H 3 ! 4

| LS
—@/ | |

pTo draw a river:

The color of the river cannot be 1. Press MENU and select Map; then select River from the Map menu.

changed, it prints only in cyan Press RETURN. 7he following screen appears:

when the color cartridge is used. . Je g screert appears:
R > e oy ?u‘:l::‘:ug:ll::::nd press AETURN.
oQ 1 2 3 1 3 3 4 1 5 1 8 [} i 1
1 L
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2. To draw a river, move the arrow to the starting position for the river;
press RETURN. The previous message is repiaced with:

Press SPACE to change size.
Move cursor to end position and press RETURN.

After the starting position is set and the cursor is moved, a + sign appears
at that positon.

Press SPACEBAR to set the width of the river. The status line
indicator changes cyclically.

------ Narrow River

Medium River

Wide River

PrestSf'ng CAI‘:CEL always allows 3. Use the arrow keys to move to the end position for the river; press
J;:Zr:ti; e:s”’;f gﬂfggﬁs RETURN. The river is shown on the screen with a dotted line. If you
pressed in the start position set press the period key instead of RETURN, the Desktop Publisher
mode, you can retum to the draws the river from the starting position (or the position where you
normal Input/Edit screen. press the period key) but still asks you toc draw the river from that
Pressing DELETE just after p_osmon. Usmg the period key helps when you wish to draw the
pressing RETURN or the period river continuously.
key erases the current river. [oBw g DRSAMPL3 Press MENLU to select function.

o 1 2 : 3 4

4. Repeat steps 2 and 3 to draw all rivers.
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Using the Draw Menu

Box
Eill Box
Circle

Fill Circle

Use the functions Line, Box, Fill Box, Circle, and Fill Circle to create
objects.

* Line: Draws a line
* Box: Creates a square or rectangle
* Fill Box: Creates a square or rectangle with a certain color

¢ Circle: Creates an ellipse or a perfect circle

* Fill Circle: Creates an ellipse or a perfect circle with a certain color

pTo create a line:

1. Press MENU; then select Line from the Draw menu. The following

screen appears:

<< LINE >> Prass SPACE to change line. Press COLOA lo change color.

Move cursor to start pesition and press AETURN.

od

1 L] 2 1 2 1 4 [ 5 ] -] ] 7 L]

2. To draw a line, move the arrow to the starting position for the line;

press RETURN. 7he previous message is replaced with:

Press SPACE to change line. Press COLOR to change color.

Move cursor to end position and press RETURN.

Pressing DELETE just after
pressing RETURN or the period
key erases the current line.

Pressing CANCEL always allows
you to return to the previous

operation. If CANCEL is pressed
in the start position set mode, you

4.

After the starting position is set and the cursor is moved, a + sign appears
at that positon.

Press SPACEBAR to change the style of the line. The status line indicator
changes cyclically. The default is a solid line. The following types of
lines can be selected.

You can change the color of the line by pressing CODE + COLOR.
The Color Change dialog box appears on the screen. Please refer to
the information on page 174 to change the color of an object.

Use the arrow keys to move to the end position for the line; press
RETURN. If you press the period key instead of RETURN, your
Desktop Publisher draws the line from the starting position (or the
position where you press the period key), but still asks you to draw
the line for that position. Using the period key helps when you wish
to draw the line continuously.

Repeat steps 2 and 3 to draw all lines.
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Pressing DELETE just after
pressing RETURN erases the
current box.

Pressing CANCEL always allows
you to returmn to the previous
operation. If CANCEL is pressed
in the start position set mode, you
can retum to the normal
Input/Edit screen.

€< LINE >> Frass SFACE to change lina. Press COLOR to changa color.
Move cursar to start posilion and press ARETURAM.

o 1 F] 2 ] 8 1 % 1 5 1 ] ] s 1

pTo draw a box:

1. Press MENU; then select Box from the Draw menu. The following
screen appears:

<< BOX >> Press SPACE la changs lina. Press COLORA to change color. ] o l m.l(l
Move cursor to start pasition sno prass RETURMN.
od a L] z 3 3 ] L] ] 5 ] a 1 irs 1

2. To draw a rectangle or a square, move the arrow to the starting
position (top left corner); press RETURN. The previous message is
replaced with:

Press SPACE to change line. Press COLOR to change ccolor.

Move cursor to end position and press RETURN.

After the starting position is set and the cursor is moved, a + sign appears

at that positon.

Press SPACEBAR to change the style of the line. The status line indicator

changes cyclically.

3. Use the arrow keys to move to the end position (bottom right
corner); press RETURN.

The following cursor movements create the box shown below:

4. Repeat steps 2 and 3 to draw all boxes.

The minimum width of the box is 1/1g”, and minimum height of the

box is 1/12". If the box is smaller than this minimum size, the
following message appears:
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Pressing DELETE just after
pressing RETURN erases the
current filfed box.

Pressing CANCEL always allows
you to retumn to the previots
operation. If CANCEL is pressed
in the start position set mode, you
can return to the nomal
Input/Edit screen.

The cbject is too small to draw!
Press any key to continue.

p-To draw a filled box:

1. Press MENU; then select Fill Box from the Draw menu. The following
screen appears:

<< FILL BOX >> Pruss COLOR to charge colar. -N_K
Move cursor to start position and press RETURN. -

o0 1 kl 1 2 3 3 ) a [ h-} [] -3 [] T [

2. To draw a rectangle or square with a colored fill, move the arrow to
the starting position (top left corner); press RETURN. The previous
message is replaced with:

Press COLOR to change color.

Move cursor to end position and press RETURN.

After the starting position is set and the cursor is moved, a + sign
appears at that positon.

You can change the color of the line by pressing CODE + COLOR,
The Color Change window appears. Please refer to the information
on page 174 to choose the color of the fill box.

3. Use the arrow keys to move to the ending position (bottom right
corner); press RETURN.

The following cursor movements create the filled boxes shown

~ DI

4. Repeat steps 2 and 3 to draw all filled boxes.
The minimum width of the fill box is 1/1g", and minimum height of
the fill box is 1/12". If the fill box is smaller than this minimum size,
the following message appears:

A mmmmd

Press any key to continue.

[ ~ The object is too small to draw! ]
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Pressing DELETE just after
pressing RETURN erases the
current circle or elipse.

Pressing CANCEL always allows
you to return fo the previous
operation. If CANCEL is pressed
in the start position set mode, you
can retum fo the normal
Input/Edit screen.

pTo draw a circle:

1. Press MENU, then select Circle from the Draw menu. The following
screen appears:

<< CIRCLE »>> Press SPACE to change line. Fress COLORA 1o change color.

Move oursor to start position and press RETURAN.

00,

1 I = 1 2 ] 4 1 B 1 -] ] 7 []

2. To draw a circle or an ellipse, move the arrow to the starting

position (top left corner) for the circle; press RETURN. The previous
message is replaced with:

Press SPACE to change line. Press COLOR to change color.

Move cursor to end position and press RETURN.

After the starting position is set and the cursor is moved, a + sign
appears at that positon. Press SPACEBAR to change the style of the
line. The status indicator changes cyclically.

You can change the color of the line by pressing CODE + COLOR.
Please refer to the information for changing color on page 174.

. Use the arrow keys to move to the end position (bottom right

corner); press RETURN.

The following cursor movement creates the circle or ellipse shown
below:

+
=

. Repeat steps 2 and 3 to draw all circles.

The minimum width of the circle is 1/1g", and minimum height of
the circle is 1/12". If the circle is smaller than this minimum size, the
following message appears:

The ohject is too small to draw!
FPraess any key to continue.
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The maximum size of the circle is 2". If the circle is bigger than this
maximum size, the following message appears:

The cbject is too big ta draw!
Press any key to continue.

P To draw a filled circle:

1. Press MENU; then select Fill Circle from the Draw menu. The
Jollowing screen appears:

<< FILL CIACLE >> Frass COLOH ta change oolor.

Mova cursor to start position anc preass AETURN.
0l 1 £) 2 z 3 ] a E - 1 (-3 [l rd

2. To draw a circle or an ellipse with a colored fill, move the arrow to
the starting position (top left corner) for the fill circle; press
RETURN. 7he previous message is replaced with:

Press COLOR to change color.
Move cursor to end position and press RETURN.

After the starting position is set and the cursor is moved, a + sign appears
at that positon.

You can change the color of the fill circle by pressing CODE +
COLOR. Please refer to the informationon on page 174 for changing
the color of a filled circle.

Pressing DELETE just after 3. Use the arrow keys to move to the end position (bottom right
pressing RETURN or the period . press RETURN.
key erases the current filled circle cornen); p ' '
or elipse. The following cursor movement creates the circle or ellipse shown
below:
o -
; -
.
1
U
k
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Pressing CANCEL always allows 4. Repeat steps 2 and 3 to draw all fill circles.

feirn f revi . . 3 s . . .
ﬁ:‘;::ti;iu;?cixg& i:’:‘:esssed The minimum width of the fill circle is 1/1g", and minimum height

in the start position set mode, you of the fill circle is 1/12". If the fill circle is smaller than this minimum
can retum to the normal size, the following message appears:
Input/Edit screen.

The okisct is too small to draw!
Press any key to continue.

The maximum size of the fill circle is 2"2. If the fill circle is bigger
than this maximum size, the following message appears:

The object is too kig to draw!
Press any key to continue.

Using the Edit Menu

Use these functions to edit, move, delete the objects, or copy and paste
the object to or from the clip board memory.

Maove
Copy to Clip Board
Paste from Clip Board

Delete .
Delete Al * Move: Moves the selected object

Edit: Edits a selected object

* Copy to Clip Board: Copies the object to the Clip Board memory

» Paste from Clip Board: Pastes the object in a position from the Clip
Board

» Delete: Deletes a selected object

» Delete All: Deletes all objects

p>To edit an object:
1. Press CODE + 1. The following screen appears:

<< EDIT »> Press TAB or SHIFT + TAB to seleot data and press RETURN.
Press CANCEL to exit.

a0 1 ' 2 : 3 ] 4 ! g

|7 M s R amEE RS SNESANAANS SRR NS NAERE NN T W]

2. Use TAB or SHIFT + TAB to select the information.
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TAB: Moves the cursor to the next object closest to the right

SHIFT + TAB: Moves the cursor to the previous object

RETURN: Selects the object

CANCEL: Cancels this operation and returns to the Input/Edit window

. Press RETURN to select the object.

For example, if the text object is selected, the following edit screen
appears:

K<TEXTS> Het[12 2 [8LK] (A} 2Y 2L FTETE ¥ ol 2H oK INS §) NLAd [BHIFT
o 1 H 2 3 3 z % 3 - H -] ] 7 3
[
1 ] l ABCD EFG
<<TERT >>
ABCD EFG
z J/C‘
e e e B Press T STYLE, FON R 10 change texl altributa_
3 [N | 51+ Lexl and press COD TURN. Fress CANCEL to exil. |
4

If Line, Road, Circle Road, Train Track, River, Box, Fill Box, Circle, or Fill
Circle is selected to be edited, you can change the position of the object.

4. Make any changes you would like. The operation to input or edit

information works the same as the operations described above.

If you select Road, Circle Road, Train Track, River, Line, Box, Fill Box,
Circle, or Fill Circle, the following message appears:

Move cursor to destination position and press RETURN. ]

If an arrow key is pressed, the object is moved in the direction of the
arrow on the keytop.

When the graphic object cannot fit on the page, this window
appears:

Data will be truncated!
Press any key to continue.

Press RETURN when finished. Repeat steps 2-4 to complete the
placement of the graphic object. Press CANCEL to return to the
Input/Edit screen.

Besides the arrow keys, you can use the following keys to move the
images, text, or graphic art quickly.

CODE + L
CODE +F

CODE +R

Cursor movement

Aligns the object to the left edge of printing area
Centers the object between left and right edges
of printing area

Aligns the object to the right edge of printing area
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pTo move an object:
1. Press CODE + E. The following screen appears:

<< MOVE >> Prass TAB or SHIFT + TAB to select data and press RETURN.
Press CANCEL to exit.

0g H i H 2 H 3 H % H 5

2. Use TAB or SHIFT + TAB to select an object and press RETURN. 7he
Jfollowing message appears:
<< MOVE >> Move cursor to destination position and press RETURMN.

1 1 2 1 3 ! 4 ]

a0

— O

3. Use the arrow keys to move the selected object to a position; press

RETURN.
Besides the arrow keys, you can use the following keys to move an
object quickly:

Keys _ Cursor key movement

CODE +L aligns the information to the left margin

CODE +F centers the information between margins

CODE +R aligns the information to the right margin

Pressing CANCEL allows you to return to the Input/det window
without moving the objects.
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pTo copy to the clip board:
1. Press C CLIP. The following screen appears:

<L COPY TO CLIP BOARD >> Press TAB or SHIFT + TAB to select dat o R
Press CANCEL lo exit. ata and prass RETURN.
o0 1 : 2 : 3 : 2 : g : =)

1. - |I aEcs=rs
| 25—
~T |

s ] | Y

2. Use TAB to select an object and press RETURN. The selected object
is stored in the Clip Board memory, and a message appears telling
you the data is stored in Clip Board.

Only the information created in Road, Circle Road, Train Track,
River, Line, Box, Fill Box, Circle, and Fill Circle can be stored in the
Clip Board memory. If other kinds of objects are selected, the
following error message appears:

Only ROAD, ROUNDABOUT, RAILWAY TRACK, RIVER,
LINE, BOX, FILL BOX, CIRCLE or FILL CIARCLE
can be stored in CLIP BOARD!
Press any key to continua.

The Drawing information in the Clip Board memory can be retrieved
in Drawing mode only.

When the Drawing mode is ended, the Clip Board memory is
cleared. The following screen appears when Close File is selected.

Press any key tob continue.

[[ DRAWING CLIP BOARD data will be delated! ]

p To paste from the clip board:

1. Press P CLIP. The information in the Clip Board memory is put at the
current cursor position.

When the information does not fit on a single page, this window
appears:

Data will be truncated!
Praess any key to continue.
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If the memory becomes full by pasting the Clip Board memory, the
following error message appears:

Mot enough memory remaining!
Press any key to continue.

P> To delete information:
1. Press CODE + D. The following message appears:

<< DELETE >> Prass TAB or SHIFT + TAB lo select dala and press RETURN.
Praas CANCEL to exit.

o0 b 2 2 ] 3 : 4 ] -] H -] : 7 L

2. Use TAB or SHIFT + TAB to select an object and press RETURN. 7he
Jfollowing message appears:

OMWK to delete this data?

Use cursor to select and press RETURRMN.
[TE=] [NO]

3. Select YES to delete the selected object, or NO to cancel this
function.
pTo delete all information:

1. Press MENU; then select Delete All from the Edit menu. The following
screen appears:

OK to delate all data? |

Use cursor to select and press RETURN.
["EZ] NO]

2. Select YES to delete all information or NO to cancel this function.
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Using the Style Menu

You can change the paper size in this menu.

Paper type: Sets the type of paper to be used

pTo select a paper type:

1. Press MENU; then select Paper Type from the Style menu. The
Jollowing screen appears:

Model DP-530CJ

<4 PAPER TYPE »»
PAPER TYPE: . 8.50
- -
ad PORTRAIT . ¢.50
45 PORTRAIT

10.00 | 11.00Q

f 0.50 |
0.50 |1 7.604| o.50

3
h )
F

Prezs 1t 4 to change seting and press RETLIRM.

Model DP-540CJ, DP-550CJ, DP-5040CJ

<< PARPER TYRE >>

PAPER TYPE: 28.%0

A4 PORTRAIT
AS PORTRAIT

10.00 |11.00

&.50

Q.50 7.50 ¢.50

Press t,4 to change setuing and press RE TURN.

2. Use P, | to select the type of paper; press RETURN to set.
When the information cannot fit on a single page, this error message

appears:
[ Data will be truncated! ]

Using the Print Menu

Use the Print functions from the function menu to preview and print your
drawing information.

* Print: Prints the current drawing information

* Layout: Shows how your drawing information appears on the page
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P To print a drawing:

<< DCRAWING PRINT MENU =>

NUMBER CF COPIES: . |
PRINT GUALITY: MEDIUM
CSOLOR PRINT: YES

3. Use 1T, | to move the cursor to a setting. Type in a value, or use
SPACEBAR to change the settings. Press RETURN when finished.

NUMBER OF COPIES: The number of times the document is to be
printed. (Maximum 999)
Selsct FINE or MEDIUM print ' PRINT QUALITY:
qualtty setting. FINE: For final quality printing
MEDIUM: For normal quality printing
DRAFT: For trials. With this setting, you save time and ink
Color PRINT: YES: The information prints in color when you have
a color ink cartridge installed on your machine.
Color PRINT: NO: The information prints in monochrome when
you have a color ink cartridge installed on your machine.
4. Press RETURN to print out your drawing. While printing, the
following message appears in the window:

lPrinting‘..press CANCEL to stop printing. J

If you insert a different size paper than that which your Paper Type
mode is set to, the following error message appears:

incorrect paper size!
Check page setup menu or insert correct paper.
OK to cancel printing?

ize cursar bo select and press RETUFRRM.

5 [NO]

Select YES to cancel printing or NO to continue printing.

If the color ink cartridge is not installed, or Color Print:No is
selected, when the drawing contains color clip art, the following
information appears:

COLOR GRAPHIC ART data will not print!
Cheack print menu and ink cartridge.
OK to continue printing?

Use cursor to select and press RETURDN.
7T ES [NO]
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Select YES to continue printing or NO to return to the Print Menu
window. If you select Yes, the color clip art does not print.

pTo see a drawing before printing:
1. Press CODE + LAYOUT. The preview screen appears on the screen:

: | P?@A@ RMIAP ﬁ;;z B
. =

: &R

_ o~¢—o

‘ | |

2. Press RETURN to return to the Input/Edit screen.
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7 GreetingCard

If you sefect a file to edit that has
already been created, the
Input/Edit screen appears
instead of the Paper Type
screen.

Greeting Card allows you to create many kinds of cards. This program
works much like it does in the Drawing mode. In Greeting Card, you can
create your own greeting card designs and print them on normal letter- or
A4- and AS-size paper. Your card prints on one side of the paper. Fold the
paper in quarters to mail it. We recommend that you wait a few minutes
for the ink to dry completely before folding the card.

pTo create a greeting card:
1. Turn on the power to show the Main Menu.

2. From the Main Menu, press 7. If you insert a diskette, the list of Card
files on the diskette appears. If you are not using a diskette, a screen
similar to the one below appears:

[T gsaine

AHENCRED

3. Use the arrow keys to highlight the file you want to retrieve and
press RETURN To start working with a new file, move the cursor to
the *NEWCARD file and press RETURN. The Paper Type screen
appears:

<< PAPER TYPE >>

PAPER TYPE: 8.50¢

o.50%

A4 PORTRAIT
A PORTRAIT

10.00 [11.00

¥ 0.5
o.60 | 7.50 lp 0.50

FPress 1.4 to change setting and press RETUURN.
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Set the type of paper to be used. Press 1 and |, to select the size of
paper and press RETURN. The Input/Edit screen appears:

(SR *NEWCARD a FRONT  Prass MENU to selecl funation.

00 3 2 P 2 : E) P a
3

[need a UK screenj

You cannot put any information in The Input/Edit screen is divided into two areas. The parts of the screen

the 0.5" 1.27cm area from each are described as follows:
edge of your paper.

Status Line: Gives the current setting of the status line indicators and
guide messages

Input/Edit Area: Covers the part of the screen not contained in the
Status Line Indicators. The Arrow Symbol shows the current cursor
position. The dotted line shows the “inside” card paper folding line.
Card Side Icon: You can design the Front Side, the Inside, and the
Back side of the card at the same time. In actual printing, the
information on both the front and back sides of the card is printed
out upside down. Your desktop publisher allows for this to happen
and prints the correct finished orientation of your card automatically.
Front: The front side of the card is generally used for eye-catching
art and opening messages.

Inside: The screen shows both portions of the inside fold. You can
place clip art or messages inside.

Back: The back side of the card is a good place to put a special note.

4. Use the arrow keys to move the \.

Keys Cursor Movement
ﬁ,\l, /17 inch

— — 1/4g inch

SHIFT + T+,J, /g0 inch

SHIFT + €<—,—> 1/50 inch

CODE + 1, ] ,¢—,— 1 inch

5. You can select a drawing tool from the menu.

Working with Drawing Information

When creating or editing a Greeting Card file, keep the following points in
mind.
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Your Desktop Publisher brings objects forward (to the front)
automatically in the following order when showing or printing them:

Obiject

— Text (BIock of Text) Forward (Front)
Graphic Art i
Box/Fill Box/Circle/Fill Circle/Line | Backward (Back)

Using Menu Functions

The file extension for Greeting The following functions are found under the menu bar at the top of the
Card files Is “CRD". screen. Press MENU to reach the menu bar.

Using the File Menu

Use the File functions to open, save, close, delete, or rename your files; to
initialize disks; and, to return to the Main Menu. These functions work
exactly like they do in Drawing mode.

Open File
Save File
Close File

Eile Managetnent

Using the Card Sides Menu

m This function allows you to switch the screens for the Front, Inside, and
Back side of the card. '

Fopseal:
Inside

Back

pTo change the card side screen:

1. Press MENU and select Card Sides; then select Front, Inside, or Back
from the function menu. The selected screen appears.

2. Press CODE + Q to switch the screen. The screen changes cyclically in
the following order:

Front —> Inside —» Back — Front

Using the Insert Menu

JE— Use these functions to insert various kinds of information at the current
cursor position. This procedure works the same as Drawing mode.

Sraphic Art

* Text. Inserts a block of text. The minimum width of the text in Greeting
Card mode is 1 inch. The maximum width of text is as follows:

Paper Size Card Inside Card Back/Card Front
AS/Portrait 4 Inches 2 inches
Others 6 inches 3 inches

» Graphic Art. Imports the Graphic Art information from the diskette.
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Using the Draw Menu

Use these functions to create images. These functions draw a line, a
rectangle, a square, an ellipse, and a perfect circle. They work the same as
those in the Drawing mode.

Box
Eill Box
Circle

Fill Circle

¢ Line. Draws a line

* Box. Creates a square or rectangle
* Fill Box. Creates a square or rectangle filled with a certain color
® Circle. Creates an ellipse or a perfect circle

¢ Fijll Circle. Creates an ellipse or perfect circle filled with a certain color

Using the Edit Menu

Use these functions to edit, move, delete objects, or copy or paste a
specified object to or from the clip board memory. These functions work
the same as those in the Drawing mode.

Move
Copy to Clip Board
Paste from Clip Board
Delete » Edit. Edits the selected object
Delete All

* Move. Moves the selected object

Copy to Clip Board. Copies the object to the Clip Board memory

* Paste from Clip Board. Pastes the object to a position from the Clip
Board

Delete. Deletes the selected object

Deletes All. Deletes all objects

Using the Style Menu
You can change the paper size in this menu.

¢ Paper Type. Sets the type of paper to be used
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You can select the paper size
only for a new file.

Using the Print Menu

-

P To select the paper size:

1. Press MENU and select Style; then select Paper Type from the
function menu. The following screett appears:

Model DP-530CJ

24 PAPER TYPE »»

PAPER TYPE: L, 8:50

550
Ad PORTRAIT T
A5 PORTRAIT

10.00 | 11.00
g3 o.50
n.50 || 7.50[ ©.50

{Pressz T4 bo change seting and presz RETLUIRT

Model DP-540CJ, DP-550CJ, & DP-5040CJ

<< PAFER TYPE 3>

PAPER TYPE: 8.50

LETTER £0FiT = T
A4 POCRTRAAIT
AS PORTRAIT

0.50

10.00 |11.00

0.50

0.50 7.50 0.50

Press t .4 Lq/ghange sething and press RETWURN.

2. Use 1 and | to select the kind of paper; press RETURN to set.

Use Print functions from the function menu to preview and print your card
information.

* Print: Prints your card information
* Layout: Previews your card information
p-To print the current card information:
1. Press PRINT. The Greeting Card Print Menu appears:

<< GREETING CARD FRINT MENU >>

NUMBER OF COPIES: 1
PRINT QUALITY: MED I
COLOR PRINT: YES

Type number and press RETURRMN.

2. Use 1" and | to move the cursor to a setting. Type in a value or use
SPACEBAR to change the settings. Press RETURN when finished.

Greeting Card 203



NUMBER OF COPIES: The number of times the document is to be
printed. (Maximum 999)

We recommend that you select PRINT QUALITY
FINE or MEDIUM in PRINT . .
QUALITY setting, Fine: For final quality printing

Medium: For normal quality printing

Draft: For trials. With this setting, you save time and ink.
COLOR PRINT: YES: The information prints in color when you have a
color ink cartridge installed on your machine.
COLOR PRINT: NO: The information prints in monochrome when
you have a color ink cartridge installed on your machine.

3. If you press RETURN, the Greeting Card information is printed out.
While printing is being carried out, the following message appears on
the screen:

Printing...press CANCEL to stop printing. |

The card information prints out as follows:

If you insert a different size paper than the one your Paper Type
mode is set to, the following error message appears:

Incorrect paper size!
Check page setup menu or insert correct paper.
OK to cancel printing?

rzar by sebact and press RETILIRN

[MO]

Select YES to cancel printing or NO to continue printing.

If the color ink cartridge is not installed, or Color Print:No is selected,
when the greeting card contains color clip art, the following message
appears: '

COLOR GRAPHIC ART data will not print!
Cheack print menu and ink cartricge.
G K to continue printing?

Use cursor o select and press RETURM.

YE= [MNC]
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Select YES to continue printing or NO to return to Print Menu. If YES is
selected, only the color clip art information is not printed.

pTo see a layout of the current card information before
printing:
1. Press CODE + LAYOUT. The preview screen of the current card side
appears:

<< LAYOUT >> Prass RETURN to end.

o 1 1 1 2 k] 3 3 2

Merry X'mas/

This Card was created fuse for vou!

Marry Xmas!

ek £ e i o e

= CHRSTREE

2. Press RETURN to return to the Input/Edit screen.
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8 Communication

About Modems

Before trying to access an
information or electronic mail
service, you must establish an
account with that service and
receive an ID name and
password. Refer {o the modem
documentation for setting the
Jumper connsctors and DIP
switches, If any. Usually, the
manufacturer’s settings do not
need to be changed.

The Communication program is used to communicate between your
Desktop Publisher and a personal computer or other word processor. This
communication is done with a modem and your telephone line. The most
popular use of this feature is to exchange messages and files with friends
and obtain access to commercial data bases and electronic mail services.
When you use the Communication program, the information is converted
at each end of the line to ensure compatibility.

In order to connect your Desktop Publisher to another machine via a
telephone line, you need a2 modem to connect your Desktop Publisher to
the telephone line. Not all external modems available on the market are
compatible with your machine. When you purchase 2 modem and a
modem cable (serial), make sure you consult your authorized service
center. You may use a HAYES AT-compatible modem.

Communication 207



Using Communication

* Setting up. Communicating through a modem is very similar to a
telephone conversation between two people. In order to make the
conversation possible, some rules must be observed. For example, both
persons agree to speak the same language and to speak one at a time.
When communicating through modems, some parameters like baud
rate and parity must have the same setting at each end of the line.

When you subscribe to an information service, you receive a list of
settings that you are required to use. If you use different settings, the
host computer cannot communicate with your Desktop Publisher.

Before you communicate with a friend, agree on the settings you will
use. For more information about the settings, see To Set Up a New
Communication Connection on page 211.

* Being dialed. The Communication screen of your system must be
shown on the screen when someone is dialing you. If you are working
with your system or if you are already communicating with someone,
your system cannot be dialed.

* Dialing. Your Desktop Publisher performs automatic dialing. This
means that you type the phone number on the screen instead of dialing
the phone number on the telephone.

An information service can usually be dialed at any time. The same is
not always true when transferring a file to the personal computer of a
friend. Before dialing a friend, call them to make sure that their
computer is ready.

For more information about dialing, see To Dial a Connection on page
215.

* Auto log-in. The log-in data contains the information that allows an
information service to identify you. Your Desktop Publisher records the
log-in data as you enter it on the screen when requested to do so by
the information service. Once the log-in data has been recorded, the
machine automatically transmits it after dialing.

* Transmitting/Receiving. Once you are connected, the text you type is
transmitted, and the text you receive appears on your screen.
Optionally, the text transmitted can be “echoed” back to your screen for
confirmation.

You can transmit the contents of a document file or store the
information received in a memory file. For more information about
sending and receiving files, see To Send WP Text on page 218 and To
Receive ASCII File on page 219.
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Using a Communication File

A Communication file stores the setting information necessary for
communicating. It stores the setup parameters and any log-in information
required for transmission or reception.

) To open a communication file:
1. Turn on the power to see the Main Menu.
You cannot start Communication if the modem is not connected. If you
select Communication without the modem connected, this error message
appears:

Maodem is not connected!
Press any key to continue.

If this happens, tum the machine OFF, connect the modem, and try
again.

2. To retrieve 2 Communication file from a diskette, insert the diskette into
the disk drive.

3. Press 8 to select the Communication icon.
" Communi
Y -cation

If you insert a diskette, the list of Communication files stored on the
diskette appears.

If you call an information servics, 4. Use the arrow keys to select the file you want to retrieve; press
g";'o';‘;fia’“ identiy yourself with RETURN. To start a blank file, select *NEWFILE; press RETURN, The

Jfollowing Communication screen appears:
WENFILE = Lo 2]

Erulating TTY tesminal,
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If you retrieve an existing Communication file and a telephone number
is already set up, a dialog box appears:

OK ta execute auto dialfaute log-in?

Use cursor to select and press RETURN.
= INOJ

If you select YES, auto dial begins and auto log-in starts if there is log-in
data. If you select NO, the Communication screen appears without starting
auto dial and auto log-in.

About Communication Files

Communication files are used to store the communication parameter
settings. The file currently in memory is active. You can edit it and use it
for automatic dialing. You can, however, have only one Communication
file in memory. The file is automatically updated in the memory as you edit
it.

If you need to work on a different Communication file, save the current file
on a diskette. For information, see To Save a File on page 214. The Desktop
Publisher asks you to enter a file name under which the file will be saved on
the diskette. After saving the current file, you can clear zall the information
and start creating a new file.

When you retrieve a Communication file from a diskette, the current file is
deleted and replaced with the file you load. For information, see To Open a
File on page 214.

The file name of the Communication file appears in the upper-left corner of the
Communication screen. The default file name of a new Communication file is
*NEWFILE. If the Communication file has been saved on diskette and then
loaded back into memory, the file name under which you saved the file on
diskette appears.
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Communication Functions

File Functions

Open File

Save File
Quit

This function allows you to set up

the telephone number and
communication parameters (o
execute log-in for
communication.

Use the File functions to open, save, or close your files and to return to the
Main Menu.

« New Set Up. To set up a telephone number and communication
parameters

« Open File. To load a communication file, which is already set up on a
diskette

« Save File. To save a2 communication file onto a diskette
« Quit. To exit the file without saving and return to the Main Menu

p-To set up a new communication connection:
1. Press MENU to show the menu bar; select New Set Up from the File

menu. The INFORMATION SET UP dialog box appears:

=< INFORMATIOMN SET UP >>

PHDN.E NUMBER:

DlAL MODE: TONE
BIT PER SECOND: 2400

[ LOG-IN DATA: NONE 1

XONIXCOFF CONTRCOL: ON
PARITY: EVEN SIGNAL LINE CONTROL: NONE
DATA BITS: 7 AUTO LINEFEED: ON
STOPBITS: 1 AUTO LINEFEED (SEND): ON
LOCAL ECHO: OFF MODEM: FX-144

Type telephone number and press RETIURM.

2. Use the arrow keys to move the cursor to a parameter. Enter the

telephone number you want to access or press the SPACEBAR to select
the setting,
« PHONE NUMBER: The phone number you want to access. You can
enter up to 40 numbers or characters.
* DIAL MODE:
TONE—For a push-button phone
PULSE—For a rotary dial phone

* LOG-IN DATA: For indicating whether log-in information exists.
This item cannot be set up.

« BIT PER SECOND (BAUD RATE):

300, 600, 1200, 2400, 4800, 9600—Determines the transmission
speed in bits per second. Text communication to or from your
unit can reach 9600 baud speed. If your modem is compatible
with a higher speed, it will automatically adjust to 9600 during
transmission.

* PARITY: Determines how the bits of each character are checked for
transmission errors. This Desktop Publisher does not perform Space
& Mark parity checks during reception.

NO—No parity bit is added to the characters.
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EVEN—The Desktop Publisher counts the number of nonzero
bits in a character. If this number is even, the parity bit is set to
zero; if odd, the parity bit is set to one. This way, all “words”
(character + parity bit) have an even number of nonzero bits. The
receiving unit must have the same parity setting and expects to
receive only words with an even number of nonzero bits. When
this number is odd, the receiving machine knows that something
is wrong (for example, one bit has been spoiled by noise on the
line).

ODD—Opposite of the EVEN parity. A parity bit is set so that the
total number of nonzero bits is odd.

SPACE—The parity bit is always zero (possible only when DATA

BITS = 7).
MARK—The parity bit is always one (possible only when DATA
BITS = 7).

» DATA BITS: (7,8)—Determines how many bits are necessary to
encode the characters. Standard ASCI characters use seven bits.
Accented letters and other special characters need eight bits.

« STOP BITS: (1,2)—Each word must be separated from the next one
with a special bit called a “stop bit.” This parameter specifies the
length of a stop bit (1 = single, 2 = doubile).

« LOCAL ECHO: (QN, OFF)—When local echo is on, transmitted data
appears on your screen.

« XON/XOFF CONTROL: (ON, OFF)—Determines whether to allow
flow control by the X parameter. If allowed, an XOFF code (13hex)
is transmitted by the receiving machine when the free area in the
reception buffer is less than 25%. As the information is processed
and removed from the buffer, the free area increases. When the free
area becomes greater than 75%, the receiving machine sends an
XON code (11hex) that allows the other machine to resume data
transmission. When the transmitting machine receives an XOFF
code, it enters a state in which it can transmit only XON/XOFF
codes. This state is terminated upon reception of an XON code.
Regardless of the flow control method, the data transmission is
possible only when the control signal lines DSR and CTS are active.

« SIGNAL LINE CONTROL: (NONE, DTR)—Determines whether to
allow flow control by the control line DTR. The DTR line allows

transmission only when active.

« AUTO LINEFEED: (ON, QFF)—Determines the effect a received
carriage return code (0Dhex) has on the cursor. If this selection is
ON, a carriage return automatically adds a line feed.

ON—The received data appears on the next line (cursor moves
to the next line).

OFF—The received data appears on the same line and
overwrites the previous message.

o AUTO LINEFEED (SEND): (ON, OFF)—Determines what is
transmitted when you press RETURN.

FX~144, FX-336, or MO-700 « MODEM: Determines the type of modem to be used in the

are shown on the Information Communication mode. In the Modem setting mode, if OTHER is
Setup dialog box when you use a selected, the following message appears:

US version of the Desktop

Publisher.
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iPress TAB to change setting and press RETURN. J

If you press RETURN without
pressing any key, you retum to
the Communication screern.

If the information that was sel up
in Dial function is stored in
memory, itis automatically
incorporated in the New Set Up
function. On the other hand, the
information entered in the New
Set Up function is incorporated in
the Dial function. This may
change any previous seitings you
have set in the Dial function.

The default initialize string is ATL1QOVIX3&C1&D2.
L1-switches the volume of the modem’s speaker to low
QO-gives the result code

V1-gives the result code by characters

X3-gives the result code, transmission speed, and busy signal
&C1-changes the DCD signal to On by data carrier

&D2-disconnects the line when the DTR signal is changed from On to
Off and switches to the Command mode.

Press CODE + R to restore the default setting.

Please refer to the manual of the modem that you use to change the
setting.

Up to 33 characters can be added to this string.

If CANCEL is pressed at the Initialize String screen, the system returns to
the Information Set Up screen without saving the modem setting.

If RETURN is pressed without typing in any information, the default

modem setting is stored in memory.

If RETURN is pressed after typing in the information, it is stored in the
memory and you return to the Information Set Up screen.

. Press RETURN at Information Set Up screen to finish setting up. A

dialog box appears:

Save this information?

Use cursor to select and press RETURNL

. Select YES to save the setup information (telephone number and

communication parameters) onto 2 diskette or NO to return to the
Communication screen without saving. If you select YES, this dialog box
appears

<< SAVE FiLE >>

FILENAME: || .CPF

—

COMFILEL1l.CPF

Exnisting File(s)

|

COMFILE2.CPF

;Type filemname and press RETURN.

Press t, + to scroll file directory.
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5. Enter the file name and press RETURN. 7he Communication screen
appears after saving the file.

pTo open a file:

This function aflows you to load a 1. Press CODE + O. The Communication file list appears:
communication parameter file on

a diskette. :
Communi
‘ ;‘ -cation

HHEWF ILE : COMFILEL.CPF COMFILE2.CPF

If you have not saved a parameter file when selecting Open File, a
“dialog box appears:

Change current setting?

\Use cursor to select and press RETURN. |

2. Select YES to see the communication file list or NO to stop this
function and return to the previous screen.

3. Select the file that you want to load; press RETURN. The parameter
settings in the selected file are loaded. If a telephone number is entered
in the selected file, a dialog box appears:

OK to execute auto dialfauto log-in?

Use cursor to select and press RETURN.
i ES] INOYJ

4. Select YES to execute auto dial and then to execute auto log-in if
log-in data exists. Select NO to return to the Communication screen
without executing auto dial and auto log-in.

pTo save a file:

This function allows you to save 1. Press CODE + S. The dialog box below appears and shows the

3:,(‘; ‘?{:’"ete' setiings fo a parameter settings curvently stored in memory:

<< INFORMATION SET UP >>

PHONlE NUMBER:

DlAL MODE: TONE [LOG-IN DATA: NONE 1

BIT PER SECOND: 2400 XKOMNIXOFF CONTROL: ON
PARITY: EVEN SIGNAL LINE CONTROL: NONE
DATA BITS: 7 AUTO LINEFEED: CON
STOP BITS: 1 AUTSO LINEFEED (SEND): ON

LOCAL ECHG: OFF MODERM: Fx-144

Type telephone number and press RETURPL

If you select YES, the following dialog box appears. If you select NO,
the communication screen appears.
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Phone Functions

I File m Transler

i Al

Dis connest

<< SAVE FILE >>

FILENAME: W .CPF

’ Existing File(s) \

COMFILE1.CPF COMFILEZ.CFF

Type filename and press RETURMN.

Press t, + to scroll file directory.

2. Type in the file name; press RETURN to save the parameter file.

pTo return to the Main Menu:
1. Press MENU to show the menu bar; choose Quit from the File menu.

If the telepbone line was not connected or if a parameter setting bas
not changed, the Main Menu appears. The dialog box below appears if
the telepbone line is connected:

OK lo exit?

‘Use cursor to select and press RETURN.
TEz) NQ]

. Select YES to exit from the Communication function and return to the

Main Menu or select NO to return to the Communication screen. The
dialog box below appears if a parameter setting is changed and is not
saved yet:

OK to abandan current file?

Use cursor to select and press RETURN.

. Select YES to exit from the Communication function and return to the

Main Menu. If you select NO, the Communication screen appears.

Use the Phone functions to dial or disconnect communication.

» Dial. For setting up the phone number, dialing the number, or recording
the auto log-in data.

* Disconnect. To stop communication.
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pTo dial a connection:

This function allows you to set up 1. Press CODE + D. A dialog box appears:
a phone number you want fo
access, dial the number, or << PHONE NUMBER »»
record auto log-in data.
|
DAL MODE: TONE
RECCRD LOG-N DATA: OFF

‘Type telephone number and press RETURN to execule.

2. Press 1" and | to move the cursor to a setting. Type the telephone
number you want to access or press the SPACEBAR to select the

setting.
« PHONE NUMBER: The phone number you want to access. You can enter
up to 40 numbers or characters.
 DIAL MODE:
TONE—For a push-button phone
PULSE—For a rotary dial phone
» RECORD LOG-IN DATA:
OFF—No log-in data required
ON—To record the log-in data so your next dialing is automatic

3. Press RETURN to dial. The Communication screen appears and the
Deskiop Publisher automatically dials the pbone number. While sending
the dala, the screen shows:

ATDTO52821570

Sending diai commarnd string. Press CANCEL 0 aborl

Auto log-in .
The first time you dial you enter the log-in data manually. However, log-in
data can be recorded automatically by selecting On from the Record Log-In
Data setting. The next time you dial the same number, auto log-in is
carried out automatically.
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pTo record an auto log-in:

1. If you press RETURN on the Dial screen, the Communication screen
appears, and the system automatically dials the phone number. If
Record Log-In Data is set to On, the system starts recording log-in
data as shown below:

[ WEWILE [ins Jram §

TOT0828215720

CONNECT 2400
USER ID: WPCOOOB
PASSWORD!

The log-in data cannot be edited 2. Press CODE + R to record the log-in data in memory. If log-in data is
'T’L”;:::";e”:: a}:’ ajn"g:!; da;i already recorded, delete by pressing CODE + R, and new log-in data is
must resgtan the ri.cording’ d recorded. If log-in data exceeds memory capacity, recording stops and a
procedure for new data. dialog box appears: '

Memory fulll
Stop recording. Keep log-in data in memory?

tJse cursor to select and press RETVURMN.
[ E =) INC]

Auto log-in data that Is recorded 3. Select YES to enter the log-in data that is already recorded into

in memoty is valid until exiting memory and then return to the Communication screen. Select NO to
from the Communication mode. If . o

you want to keep the aufo log-in delete it and retumn to the Communication screen.

data permanently, save it onio a

diskette.

P To execute an auto log-in:

1. If you press RETURN when log-in data is recorded in memory and
Record Log-In Data is set to OFF on the Dial dialog box, dialing starts
automatically.

2. Auto log-in starts after connection.

pTo disconnect communication:

This function allows you fo 1. During communicating, press MENU to show the menu bar; choose
disconnect commnication. Disconnect from the Phone menu. A dialog box appears:

Disconnecting?

Use cursor to select and press RETURRM.

[T E=] INO]
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2. Select YES to disconnect communication and return to the
Communication screen. Select NO to cancel and return to the
Communication screen.

Transfer Functions
Use the Transfer functions to transmit Word Processing text or receive an
ASCII file.

Prone O Send WP TEXT. Converts Word Processing text to an ASCII file and

. D
Receive ASCI| FILE . . . .
= » Receive ASCII FILE. Receives an ASCII file, converts it to Word Processing

text, and saves it to a diskette.

pTo send WP TEXT:

This function transmits Word 1. Press MENU to show the menu bar; choose Send WP Text from the
Processing text after transferving Transfer menu. This screen appears:

to ASCIl without protocol.
<< SEND WP TEXT >> M

T LETTER10.WPT LETTERLL.WPT
LETTERZ .WPT LETTER3 .WPT LETTER4 .WPT
LETTERS WPT LETTERE .WPT LETTERE .WPT
LETTERS .WPT

Select a hle and press RETURN.

2. Select a word processing text file you want to send; press RETURN.
This message appears during sending:
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<< SEND WP TEXT >> SENT:  XX.XK [ins ] e flrerr]

ATDT0528215720

ICONNECT 2400
USER ID: WPODOOB
PASSWORD:

cnding word processing text...press CANCEL lo slap sending.

When sending is complete, 2 buzzer sounds and this message
appears:

!Completed. J

3. Press any key to return to the Communication screen.

pTo receive an ASCII FILE:

This function allows you to , 1. Press MENU to show the menu bar; choose Receive ASCII File from the
recsive ASCIl data and save it as Transfer menu. You start receiving the file and the received data appears

Word Processing text to a
diskette. as shown below:

<< RECEIVE ASCII FILE >> [RECEIVED: xx.x«][FREE AREA: XX.xXK] fover] mn fuiF)

ONNECT 2400
une 15, 19XX

, Richard H. Unimant
Branch Manager

Andrews Cppy Service

i2 Sandiego Drive
onderland, New Jersey 08020

Dear Mr. Unimant:

¢ do not plan to renew our contract for the use of a Copier 14X40 copying machine. The contract
expires June 20, 18XX

he copying machine is located at pur downtown offlce in Melrose. e would like to have the machi
@ removed at your earliest possible conwenience.

Sincerely,

Phlange A. Indelible
Receiving ASCH file....press CANCEL to stop receivin

q.

If you press CANCEL during receiving, a dialog box appears:

Save recaived file?

Use cursor to select and press RETURM.
[NO] [CANCEL]
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Select YES to save the file that is already received. Select CANCEL or
press CANCEL (o restart receiving. If you select NO, a dialog box
appears:

OK to abandon recaived fila?

Use cursor to select and press RETURRNL

[VEZ] INO]

Select YES to abandon the file. Select NO or press CANCEL (o restart
receiving. If memory becomes full during receiving, a dialog box
appears:

Memory full!
Save received fila?

Use cursor to select and press RETURRMN.

TES [NG1

Select YES to save the file that is already received. If you select NO
or press CANCEL, the dialog box at the top of this page appears.

2. When receiving 1A HEX, which means the end of the ASCII data, a
buzzer sounds and the dialog box below appears:

<< RECEIVE ASCI FILE >> [RecEIVED: xx.xk][FREE AREA: xx.xK ] @m;

ONNECT 2400

<< SAVEFILE »>
June 15, 19%XX

FILENAME: WPT

Mr. Richard H. Unima
Branch Manager
Andrews Copy Service

412 Sandiago Drive { Existing File{s) \
plonderland, New Jers

i LETTERO .WPT LETTER1 .WPT
[Pear Mr. Unimant: LETTERLO.WPT LETTER11,.WPT
LETTER2 .WPT LETTERS .WPT
We do not plan to. re hine., The contract
awpires June 20, 19X LETTER4 .WPT LETTERS .WPT
LETTERE .WPT LETTER? .WPT
iThe copying machine ike to have the

chine removed at y

i Type fiename and press RETURN.

‘Press 1, } lo scroll file directory.

incerely,

hlange A. Indelible

If you press CANCEL, the file is abandoned and this message
appears:

Canceled.

Press any key to return to the Communication screen.

3. Type the file name and press RETURN to save the file onto a diskette
and to return to the Communication screen.

If memory becomes full by converting ASCII file to Word Processing text
while saving, the file is saved as much as possible and this message
appears:

lConvert resulted in data loss.
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Screen Function

Use the Screen function to view the previous page of the received text.

* View Previous Page.

p-To return to the previous page:

1. Press 1. The previous screen appears with the following prompt
message:

[Press 1, J to view previous/next page. Press CANCEL to end.

In this case, the Page indicator appears on the status line, which shows
how many windows have been scrolled through since the original
position.

If either 1+ or CODE + PRE S is pressed once, the Page indicator is
changed to Page -1.

If either 1 or CODE + PRE S is pressed again, the Page indicator is
changed to Page 2.

Up to 3 windows can be scrolled through.

If either 1> or CODE + PRE S is pressed more than 4 times, the following
message appears:

!Screen buffer empty. J
If any next screen information no longer exists, the same message
appears:

1Screen buffer empty. J

Press J or CODE + NEXT S to go back to the next screen.
If CANCEL is pressed, the cursor returns to the original position.
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Character Code Table

The numbers in the top row and the first row on the left are ASCII control
codes. They can be entered from the keyboard and transmitted in
Communication mode. For example: Code 26(HEX) gives you “&.” See
Transmitting Control Codes on the next page for a list of input keys.

ol1]2|3|a4|5]|6]|7]|81]°¢9 A|B|CI|DIJE|F
0 |ni|oelssjO]@|P ] |P|C El|a al=
1 |sonjocif ! |1 ]A]|Q|ajqli|=]|i Bl=
2 ls|ocz{ " |2 |B[R|{Db|x |6 |&E]|S r
3 leloca | # 13 |Cf[S|lcis|a]od]u n
4 leot{oce} $|4|D|T|d]t|&]|6]n |
5 lea|wc|% |5 [E|JU|e|ujafs|N y
6 lak|sw|& |6 |F|V|f]|v]|a]a]? T
7 leecfem]| | 7i|G{Wlgjiw|e¢gjul?® T
8|les|eawn] ( |8|H|[X|hix|& |V |¢ b jo
o lwlem|[) O |Y|i]y]e]lO e
Alwlse|*]:{dtZ}|jlz]e|U Q1 -
Bivifesc|+]; |{KJI{lki{]|T]o|% 8 |V
Clelrms|, |<JL{VITI]]]|1T]|£]|% oo
D]cales|=-|=|M|]1 |m|} i |B]i ¢ |2
E | so|ms >IN|2|n| JA|x]« E
Fls |uws]/71210]_1o0 loeelA fi»
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Transmitting Control Codes

The following keys can be used in the terminal mode to transmit ASCII
control codes. For example: Code 1SHEX(NAK) transmits the character.

Keys CODE ASCII Control Name (Hexadecimal)
CODE +SHIFT +0| 00 NUL
CODE +SHIFT +A| 01 SOH
CODE + SHIFT+B| 02 STX
CODE + SHIFT+C| 03 ETX
CODE + SHIFT +D| 04 EOT
CODE +SHIFT+E| 05 ENQ
CODE + SHIFT+F| 06 ACK
CODE + SHIFT+ G| 07 BEL
CODE + SHIFT +H| 08 BS
CODE + SHIFT +1 | 09 HT
CODE + SHIFT+J | OA LF
CODE + SHIFT +K | 0B vT
CODE +SHIFT+L | 0C FF
CODE + SHIFT+ M| 0D CR
CODE + SHIFT+N| OE SO
CODE+SHIFT+0| OF S|
CODE + SHIFT+P | 10 DLE
CODE +SHIFT+Q| 11 DC1(XON)
CODE + SHIFT+R| 12 DC2
CODE +SHIFT+S| 13 DC3(XOFF)
CODE +SHIFT+T| 14 DC4a
CODE + SHIFT+U | 15 NAK
CODE +SHIFT+V| 16 SYN
CODE +SHIFT +W | 17 ETB
CODE +SHIFT + X | 18 CAN
CODE + SHIFT+Y | 19 EM
CODE +SHIFT+Z| 1A SUB
CODE +SHIFT+1 | 1B ESC
CODE +SHIFT+2| 1C FS
CODE +SHIFT+3| 1D GS
CODE + SHIFT +4 | 1E RS
CODE + SHIFT+5 | 1F us
BACKSPACE 08 BS
TAB 09 HT
SPACEBAR 20 SPACE
CODE + 7F DEL
BACKSPACE
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Keys

CODE

ASCIl Control Name (Hexadecimal)

RETURN

AUTOLF
(SEND)ON:
oD + OA

CR+LF

AUTOLF
(SEND)OFF:
oD

CR

CODE + RETURN

AUTOLF
(SEND)ON:
oD

CR

AUTOLF
{SEND)OFF:
oD + 0A

CR +LF
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9 Auto Letter Layout

Only the first page of a file can
be automatically reformatied with
the Auto Letter Layout program.

Creating the Letter

The Auto Letter Layout program can automatically apply standard letter
formats to an existing Word Processing file. Five different single page letter
formats are available:

Full Block
Block

Semi-block

Hanging-indented
Official Style

The Auto Letter Layout program identifies parts of a single page letter
(date, salutation, etc.) and formats these parts separately. To make sure the
patts of the letter are correctly identified, you must follow a few rules
when typing a letter using the Word Processing program.

While creating your letter using the Word Processing program, remember
the following procedures:

* Do not use formats like centering, paragraph indent, or right margin
flush. These are overwritten by the Auto Letter Layout formats.

* The Auto Letter Layout program overwrites tabs. If you need a table in

your letter, create the table after you have formatted the letter using
Auto Letter Layout.

When typing a letter that you want to format using Auto Letter Layout,
remember that the application applies different formats to different parts of
the letter. The program must therefore be able to identify those parts of the
letter. The parts are identified as follows:

Date line. The program first looks for a line containing a fully spelled out
month and identifies that line as the date line.

If you have some text before the date line, that text is not reformatted. To
make sure the program finds your date line, spell out the month fully (e.g.,
April). If you do not spell out the month fully (you use an abbreviation or
a number instead), the program is not able to identify a date line in your
letter and it will not format.

Address block. All information between the date line and the salutation
(defined on the next page) is identified as the address block.
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Salutation line. The program identifies the salutation line as a line that
starts with only “Dear” or “Ladies and Gentlemen.”

Body block. Everything between the salutation line and the
complimentary close (defined below) is identified as the body of the letter.

Complimentary close. A line of more than five, and up to 30, characters
followed by a comma and return code [¢] is identified as the
complimentary close.

Signature block. Everything between the complimentary close and the
identification line (defined below) is identified as the signature block.

Identification line. The identification line is used to identify the person
who dictates or writes the letter and the person who types the letter. The
first set of initials identifies the letter writer, and the second set of initials
identifies the typist. The identification line must contain one set of initials
or two sets of initials separated with a slash [ /] or colon [ : ]. Blank spaces
are not accepted, for example: /mnée,

Enclosure notation. The enclosure notation block must start with
“enclosure(s)”, “enc.(s),” or “encl.” You can use either lower- or upper-case
letters. Anything between the line starting with those characters and the
first line containing only a return symbol is identified as the enclosure
notation. Make a line containing only a return symbol to mark the end of
the enclosure notation.

The following illustration shows how you should type the information for
your letter:

[Date ¢ ]

o
[salutation o

Body

d
{complinentary close .dy |
d

Signature

qJ

[1dentification ]
d

LEnclosure notation j
Py
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Applying Auto Letter Layout

You can start the Auto Letter Layout program from the Word Processing
program. (If you use the DP-540C], DP-550C], or DP-5040(], you can also
start from the Main Menu.)

P To create a letter from Word Processing:
1. After typing the text of your letter, press MENU to show the menu
bar; choose Auto Letter Layout from the Option menu. The Aufo
Letter Layout Format dialog box appears:

<< AUTQLETTERLAYOUT FORMAT >>

r
]

om
o " Hj
[+]
= |mn |

*r

HANGING- OFFICIAL-
INDCENTED STYLE

[
Use cursor to select and press RETURN.

Five formats are available:

 Full-Block. A single format is used for all parts of the letter.
Everything is aligned with the left margin.

* Block. Everything is aligned with the left margin except for the
date line, complimentary close, and signature block, which are
indented.

¢ Semi-Block. Same as the block format, but the first line of each
body paragraph is indented.

* Hanging-Indented. Same as the block format, but each body
paragraph is indented (except the first line, which starts from the
left margin).

* Official-Style. Same as the semi-block format, but the address
block is transferred between the signature block and the
identification line.

After =’JIPJ!-"IJ/1‘H?‘4 a fol!-m;t k;. afile, 2. Press « and — to select a format. Press RETURN to start automatic
you can use Auto Letter Layout . . ]

to apply another format to the file formatting of the file. This message appears.

except after applying )

Official-style format. This is Working....

because the Official-style format
moves the address block to a

place where it cannot be The formatted letter appears on the screen. You can save the letter,

ﬂj{,’,',-‘;"'f,’;’,"” the Desktop print it, or edit it as you would with a normal document.

Auto Letter Layout 227



B To begin from the Main Menu (DP-540CJ, DP-550CJ, &
DP-5040CJ only):
1. Turn the power on to show the Main Menu.
2. Insert the diskette that contains the Word Processing file you want to
format.
3. Press 9 to select the Auto Letter Layout icon. The list of the Word
Processing files stored on the diskette appears:

: Word
! Processing

LETTERL .MFT LETTER1O . WPT LETTER1L. WPT
LETTERZ .WPT LETTER3 .WPT LETTERA .WPT
LETTERS WPT LETTERE .WPT LETTER? .WPT
LETTERE .WPT LETTERS .WPT

4. Press the arrow keys to select the file you want to format; press
RETURN. The Aulo Letter Layout Format dialog box appears:

<< AUTO LETTERLAYOUT FORMAT »>

= = = = ==
P _ == _
= = = =_— -
= _ = _ = = ;E
BLOCK SEMI- HANGING- OFFICIAL-
-BLOCK INDENTED STYLE

\Use cursor to select and press RETURN.

5. Press « and — to select a format; press RETURN to start
automatically formatting the file. This message appears:

Working.... I

The formatted letter appears on the screen. You are now in the
Input/Edit screen of the Word Processing program. You can save the
letter, print it, or edit it as you would a normal document.

Press CANCEL instead of RETURN to return to the screen you had
before starting the program. However, if the program was begun
from the Main Menu, you return to the edit screen of the chosen file.

The Auto Letter Layout program fails in the following cases:

e If the Line/Chart/Image code or Multi-Columns are set at the first page
of the selected file, this error message appears:

Press any key to continue.

[ Multicolumn, chart, lineframing or image data are not allowed! ]
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If there are more than two format marks in the first page of the selected
page, this error message appears:

More than two FORMAT marks are not allowed!
Press any key to continue.

If the Date line cannot be identified, this error message appears:

Date line cdoes not exist in this file!
Press any key to continua.

If the Salutation line cannot be identified, this message appears:

Salutation line does not exist in this file!
Press any key to continue.

If the Complimentary close cannot be identified, this message appears:

Complimentary close line does not exist in this file!
Press any key to continue.

If the Signature block or Identification line cannot be identified when
Official-style is selected, this error message appears:

.

Signature block or ldentification line does not axist!
Press any key to continua.
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1 0 Des ktOp Reference(np_mca, DP-550, & DP-5040CJ only)

The Desktop Reference program gives you access to the built-in dictionary
or to a user dictionary and provides powerful search tools.

pTo start Desktop Reference:
1. Turn on the power to show the Main Menu.

2. Press 0 to select the Desktop Reference icon. The Desktop Reference
screen appears:

Il Desktop | =
Reference II i

Lisar Dictionary
Malntenance
frisnational CorredlSpall ™ spalling coiredion system @1 991 H |
and Fogat's 1| € Th p 1988 [l
by INSO Corpasstion. HIB

1980
Houghton Miilin € 3mpany. Al rights raseived, Aturn to

Main Manu

Use t, + to select function.

3. Select one of the functions with the arrow keys; press RETURN.

* Word Reference. Gives the definition, hyphenation, and
synonyms for a specified word.

* Jumble. Gives a list of words made by rearranging the characters
of a specified word.

¢ User Dictionary Maintenance. Edits your user dictionaries.
* Return to Main Menu. Returns to the Main Menu.
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Word Reference

This function allows you to find information on a specified word. The
information includes definitions, hyphenation, and synonyms. If the
specified word is misspelled or includes a wild card character, a list of
possibilities displays.

When you start Word Reference, this screen appears:

WORD: MERNINGIS):

¥ and ? for WILD CARD

<HYPHENATION »

SYNONYM(S):

To search for a word, type the word in the entry field WORD; press
RETURN. The information shown next depends on the specified word.

If the specified word is spelled correctly, the input/edit screen
appears:

WORD: MEANING(S):
enclose veeh: Tooconfioe witrin 2 linizsd s
* and 7 far WILD CARD Verb: To shut in en all sides.
Verb: To surround and advance upon.
< HYPHENATION >
en-close
SYNONYM(S):

i pen i
shut in

fence

hem

wall

Coop

cage

immure

To confine within a limited area.
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To choose another function,
press MENU to show the menu
bar and make your selection from
the Index menu.

Jumbie
Lser Diclionary Maintenance
Relurn lo Main Menu

e HYPHENATION: Shows all the possible hyphenation positions.

* MEANING(S): Lists the possible parts of speech for the specified
word and gives a short definition of the specified word. Press T
and { to select each meaning. As each meaning is selected, the
synonyms box gives synonyms for the word with that meaning.

* SYNONYM(S): Gives synonyms of the word that belong to the
selected definition.

Press « to move the cursor to the SYNONYM(S) box; then select a word

by pressing T and {.

Press RETURN to copy the selected word to the WORD entry field. Press

— or TAB twice to send the cursor back to the MEANINGS box.

If the specified word is not spelled correctly, this screen appears:
- [

By rord Fetererce BB

MEANINGIS):

g3
s 8

*and ? for WILD CARD

Spelling mistaka!

[} suasEsTIoNS):

1By | betty

The Desktop Publisher tells you there is a spelling mistake. The
SUGGESTION(S) box gives a list of correct words that resemble the
misspelled word.

Use the arrow keys to move from word to word. Press RETURN to copy
the selected word to the WORD entry field. Press RETURN 2 second time
to show information about the word.

If you are unsure of the spelling of a word, you can enter 2 word that
contains wild cards (characters that represent any character). Insert the
wild card symbols { *] or [ ?] in the word, and the Desktop Publisher tries
to find words that match your word by substituting characters or strings of
characters for the wild card character. Use [ *] to substitute for a string of
characters of any length and [ ? ] to substitute for a single character.

Example:
If you enter inti*, the Desktop Publisher searches for words starting with
inti, followed by any combination of characters. Examples are intimacies

and intimate.
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WORD: MEANING{E):

intik

*and ? lor WILD CARD

<HYPHENATION »

SUGSESTIONIS):

H ’ intimacy
i | intimacy's
Il | intimate

intinate's
intinated
intimataly
intimates
intimating
intigation
intimation's
intimations

If you type br?wn, the Desktop Publisher searches for words that are
identical to br’wn except for the third character. An example of such a
match is brown.

* Use the arrow keys to move from word to word. Press RETURN to copy
the selected word to the WORD entry field.

Press MENU and make a selection from the Index menu to switch to
another tool or to return to the Main Menu.

Jumble

With Jumble you can search for words that resemble the word you are
looking for when characters are rearranged. The Desktop Publisher
assembles all possible strings (of a specified length) that contain characters
from the specified word. The strings that make actual words are shown.

When you start Jumble, this screen appears:

of MV LENGTH; JUMBLE(SE

< HOW TO FIND JUMBLES >

1. Typa word Ihal you wanl to Jumble and
ress AETUARN.
2. Press 1, § to select MIN, LENGETH for
Jumbie and prass RETURN.
3. For olher options, press MENU.
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To choose another function,
press MENU to show the menu
bar and make your selection from
the Index menu.

User Dictionary Maintenance
Raturn to Maln Manu

A maximum of 20 words appears
in the JUMBLE(S) box.

pTo use Jumble:
1. Type a word in the entry field WORD and press RETURN.

2. Use the arrow keys to specify the minimum character length of the
words; press RETURN. 7his screen appears:

i apple
A MIN.LENGTH: JMBLE(SY

Lapp
lear
pale
peal
plea

o~

<HOW TC FIND JUMBLES >

1. Typa word thal you want to Jumbla and
prass RETURN.

2. Press 1, 4 o saleot MIN. LENGTH far
Jumble and press RETURN.

3. For other oplions, press MENU.

A list of words appears in the JUMBLE(S) box. Scroll up and down the list
of words using the arrow keys. Use these keys to choose and change the
minimum number of characters. When the cursor is in the JUMBLE(S) box,
press TAB and the cursor moves to the WORD entry field.

Example:

The specified word is apple, and the specified minimum length is four.
The word apple contains one a, two p's, one I, and one e. Using only
those letters, the Desktop Publisher lists all the possible combinations of
four or more characters and displays those that are actual words (e.g.,

apple, Lapp).

Press MENU and make a selection from the Index menu to choose another
tool or to return to the Main Menu.
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User Dictionary Maintenance

When User Dictionary
Maintenance is opened from
Desktop Reference, there is no
Exit in the Operate menu. To exit
User Dictionary Maintenance,
you must go to another mode
using the Index menu or choose
Returmn to Main Menu.

You may reach this tool from other programs. When you start User
Dictionary Maintenance and there are no entries to the user dictionary, the
following screen appears. For more information, see User Dictionary
Maintenance in Word Processing on page 75.

i@l woRD: TOTAL:
2 AL 0 ward(s}

<MESSAGE >

< HOW TO EDIT USER DICTIONARY >

To add, lypa word and press RETURN.
Prass MENU lor other options.

Press MENU and make a selection from the Index menu to choose
another tool or to return to the Main Menu.
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11 Clip Board

When you cut or copy text, Clip Board holds it in temporary memory and allows you to paste it in
another file. This makes it possible to transfer information between files and between programs (Word
Processing, Spreadsheet, Addressbook).

Each time you copy new information to the Clip Board, the new information overwrites the old
information. The Clip Board clears when the power is turned off. You can use Clip Board in Drawing or
Greeting Card mode, but the memory in the Clip Board stored in these modes cannot be transferred to
the other mode.

Copying Information to the Clip Board

You can copy information to the clip board from Word Processing,
Spreadsheet, or Addressbook. You cannot, however, paste in any
information created in the Drawing or Greeting Card modes into Word
Processing, Spreadsheet, or Addressbook. Please refer to the instructions
for each mode.

p-To copy information to the Clip Board:
1. Move the cursor on the first character of the block you want to copy.
2. Press CODE + C CLIP.

This message appears for Spreadsheet or Addressbook:

lidove cursor to end of block and press RETURN.

This message appears for Word Processing:

Move cursor to end of block and press RETURN.
To jump to paragraph end, press SHIFT + ¢, SHIFT + —.

3. Move the cursor to the end of the block; press RETURN. This
message appears:

IData is stored in CLIP BOARD. l

* If there is not enough free memory to store the information, the clip
board clears and this message appears:

Nat enough memory remaining!
Press any key to continue.
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Pasting Information from the Clip Board

The contents of the clip board remain unchanged until you overwrite
them or switch the power off. This means that you are able to paste the
contents of the clip board more than once.

You can paste the contents of the clip board into the same file, in which
case the operation is equivalent to copying a block of text, except that
you can copy the same information many times in the same document.

You can also paste the contents of the clip board into another file. To do
this, you must open the target file after copying the information from the
source file into the clip board. The target file can be opened in Normal or
Dual mode.

pTo paste from Clip Board:
1. Move the cursor where you want to paste the information.
2. Press CODE + P CLIP.
This dialog box appears:

<< PASTE FROM CLIP BOARD »>
Do you want to paste this in file?

The quick brown fox jumps over the lazy dogd ]

DATA FROM: WORD PROCESSING

\Use cursor ta seiect and press RETURN.

3. Select YES or NO; then press RETURN.
* NO. Cancels the function
* YES. Inserts the clip board contents at the cursor’s position.

When you paste a Spreadsheet range into a Word Processing file, YES is
replaced with YES AS TEXT and YES AS TABLE. Select YES AS TEXT
when you want to paste the text only. Select YES AS TABLE when you
want the range to format automatically as a table with a frame.

If there is not enough free memory to store the clip board information
into the file, this message appears:

Nol enough memory remaining!
Press any key to conlinue.

However, for Spreadsheet, this message appears:

Press any key lo conlinue.

[ Paste CLIP BOARD incomplete. Memory fulll ]
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Copy/Paste from Word Processing to Word Processing

Information is inserted at the cursor position and formatted the same way
as in the Block Copy option.

Copy/Paste from Spreadsheet to Word Processing

If you select YES AS TEXT, the information is inserted as a block of text,
the way it appears on the Paste From Clip Board dialog box. Type style,
font, color, and size are reset to the values at the cursor position.

If you select YES AS TABLE, the information and table are inserted starting
from the cursor position. The font is automatically set to Brougham, and
the point size of the font is set to match the point size set at the cursor
position. Color is reset to the color at the cursor position. (Frame of cell
should be black.)

If the table cannot fit between the margins, this dialog box appears:

Table will be truncaled!
OK lo cancel table insert?

Use cursor o select and press RETURN.

NO]

Select YES to CANCEL the table insert and return to the previous screen. If
you select NO, the table is cut off (some of the table is cut off to make the
table fit). If one cell is too large to fit between the margins, this message

appears:
Cannol insert table!
Prass any key to continue.

Press any key to return to the previous screen without inserting the table.

A frame cannot contain more than 22 rows or more than 30 columns. If
the clip board information exceeds that limit, this message appears:

[Crossed positions full. Cannot insert table lines.

In that case, the information is inserted without the table lines.

Copy/Paste from Addressbook to Word Processing

Information is inserted as a block of text, the way it appears on the Paste
From Clip Board dialog box. Type style, font, color, and size are reset to
the values at the cursor.
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Copy/Paste from Word Processing or Addressbook to Spreadsheet

The pasted information overwrites existing information in the Spreadsheet.
All information is considered alphanumeric and is left aligned in the cells.
A line in the Word Processing file or a record in the Addressbook file
becomes a single cell in the Spreadsheet file (in the column that you

selected as the pasting position).

If information longer than 238 characters is found, the additional
characters are ignored and this message appears:

‘Truncated data exists.

Copy/Paste from Spreadsheet to Spreadsheet

Information from the clip board overwrites the target range as when you
use the Block Copy (A Range of Cells) option.

Copy/Paste from Word Processing or Spreadsheet to Addressbook

Pasted information is inserted into existing information in the
Addressbook. A line in the Word Processing file or a row in the
Spreadsheet file becomes a single record in the Addressbook file. The
record is divided into different items according to the width of the
columns in the Addressbook file.

If information longer than the length of a record is found, the remaining
characters are ignored, and this message appears:

lTruncated data exists.

Copy/Paste from Addressbook to Addressbook

Pasted information is inserted into existing information at the cursor. The
Addressbook pastes the first column of the clip board information into the
first column of the destination file and so on. If a label width in the clip
board is larger than the label width of the destination file or when the
number of labels in the destination file is insufficient, the information in
that label is cut off, and this message appears:

ITruncated data exists.
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12 calculator

Your Desktop Publisher comes with a calculator for basic arithmetic. You can insert the results in Word
Processing, Spreadsheet, or Addressbook.

pTo start the calculator:
1. Press CODE + 8 from any of the following screens:

* Main Menu
s Word Processing

¢ Spreadsheet Input/Edit screen

* Addressbook (Data Input screen)
* Drawing
* Greeting Card
When you use the calculator, this message appears:

Press CODE + 7 to change NUM-L on/off, R to enter +/-, F to
finish. )

Using Numeric Lock (NUM-L)

You can use part of the keyboard like the numeric keypad of a pocket
calculator. Press CODE + 7 to turn numeric lock on or off. (The NUM
indicator at the top of the screen is highlighted when NUM-L is on.) See
Numeric Lock mode on page 25 in Getting Started for more information.

Entering Information

Use these keys to enter numbers and do calculations while in another

program:
Display I Key Used for
1-0 Numeric keys 1 — 0 or their To enter numbers
equivalent in Number Lock
mode
Period Decimal point
+— %/ + — x [ or their equivalent The four operations: add,
in Number Lock mode subtract, multiply, and divide
+/- R To change the sign
C C or DELETE To clear the current entry
AC A ’ To clear all
= = or RETURN To get the result
W w To exit Calculator and paste
F the result at the cursor posi-
tion
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Display | Key Used for
|-+ O F or CANCEL To exit Calculator
BACKSPACE To delete a digit

Order of Calculation

The Desktop Publisher multiplies and divides first; then adds and
subtracts.

Example: To calculate 1+2 x3=7,use 1 +2x3 =
You can change the order of operation by calculating temporary results.

Example: To calculate (1 +2) %3 =% usel +2=x%3=

Maximum Length of Numbers and Precision
The maximum length of a number you can enter is 10 digits. If you enter
more digits, they are ignored.

Example: 1234567890 or 0.123456789 are accepted.
12345678901 (11 digits) is cut off to 1234567890 (10 digits,
1 is ignored).

Storing a Constant

If you enter the same operation If you enter the same operation twice consecutively, the letter K appears
gg';:g":;;g:p‘:;:;c:ﬁ;e’” on the screen, and the previous result is stored in a temporary memory.
reappears with each additional That result is automatically used again if you neglect to enter an operation
entry. before a number.

Example: 5 + + (K appears and 5 is stored) 2 = gives 7.
Then, 3 = 8 appears on the screen.

Clearing

When an error occurs during Press the letter € on the keyboard to clear the last entered number or
calculation, the letter E appears. operation
To delete this, clear the whole )

mathematical equation by . . .
pressing A. Example: 1+ 2 C 3 gives 4 (2 is cleared).

To clear an operation and replace it with another, you can also enter the
second operation. When you enter two or more different operations in a
row, only the last operation is used.

Example: 1 % + 2 gives 3.

Press the letter A on the keyboard to clear all operations and numbers.

Returning to the Program
To quit the Calculator, press CANCEL or F.

If you started the Calculator in Word Processing, Spreadsheet, or
Addressbook, you can also press W to return to that program and insert
the last result from the Calculator at the cursor in the program.
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13 About Template Files

A template is a file that contains a predefined format for a type of document. Some example templates
include purchase order forms, fax cover sheet forms, and party invitations.

To use a template, open the template file, make any changes you would like, and then save the revised
file under a new file name. You cannot change the original template file. You can use these templates
over and over again. »

The first template file is named README. You can print this file for a complete list of all template files
contained on your diskette.

P> To open a template file:
1. Turn on the power to see the Main Menu.
2. Insert the Template diskette into the disk drive.

3. Select the mode that you wish to use and press RETURN. The File
Index screen shows the list of template files.

The template file name extensions are:

When a template file is opened, ‘ s WP1—Word Processing
the file name extension is
replaced, and the file canbe * SP1—Spreadsheet
edited in the same way as a ¢ MR1—Addressbook
normal WPT, MRG, SPR, DRW, .
or CRD file. When saving, save * DR1—Drawing
the file with a new file name. * CR1—Greeting Card
Files with different file name extensions do not appear in the File index
dialog dialoguebox. '
4. Press the arrow keys to select a template and press RETURN. 7he file
Open and read the template file opens and you can start editing.

named README first. This file is
a list of all template files on
disketts.
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Appendix

Black and White Graphic Art Images and Color Graphic

Art Images

There are 40 black and white (monochrome) graphic art images and 40
color graphic art images stored on the Graphic Art Images diskette. These
images allow you to createpersonalized such special items as letterheads,
fancy invitations, and newsletters. The 40 black and white graphic art
images and 40 colorcolor graphic art images are shown on the following
pages. The file number of each border or graphic appears at the bottom
of each graphic.

i

)

o

B

-

Appendix 245



Black & White Graphic Art Images

BNNGUNCINGIN I

MBORDER3

MBUNNY

MCAR

i

i

MCHURCH

MANNOUNC MB-DAY MBABY JIBALOONS MBAREFEE
T e
MBIGEVEN MBILL MBORDERT MBORDER2
LIJ BABY

Congratulations!

MCONGRAT

MEASTER

MFIST

MFOOTBAL

FREE!

MFREE

MGOLF

MGRAD
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——_ NEW!

——

rJIT ROPHY

Sicsns G| M
RAMD OPENING nge| SR\ 2/W§
MGRAND MGREET MHANDSHK MNEW MNEWBURS
MSALE MSUNDUDE MTHANK
MVALENTN MWAITER MWREATH MYOU
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Color Graphic Art Images

CAIRC

CBDRTC

CBDRTC07

CCBOOK

CCHRCH

CCLICH

CCLICHOS

CDANCE

CDECORO06

CDINOO02

CDOG03

CFLWRC02

CFOOD

CFOOTB

CFOOTBO2

CGOALSO05

CCGRAD

CHALLW

CHBALN

CHOUSE

CMPHON
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CNEWYR1

CNEWYR2

CRDUNC2

CSAILo2

CSANTA

CSCHMS

CSCHMS05

CSOCCR

CSTPAT

CTENNS

CTHEAT

CWINTRO06

CXMAS

CXMSTX
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Extra Character Table

d4E — B0 H S 8D
=B —H R DR D
m @~ o) d R T e
w0 @< o M E ) D
o RO wsv B0 P K
QAW w0 sl sH A ) B
oA 00wz
i Y= |dEHeA0nxE
(T S | Bt e S« B @ B ST T I
HW o v mM X
B e s D O 0 TS
™ B o~ F o DD O O

ot I v UOHM O O 3
CHegs- 1w DEFOL D@
el ~+ @ QW g B3 N

s w4 e @MY g B b Bl

Symbol Table

D@ ¥
| - O
4 59—
4%+ B
N
@ O B &

(R =

=ou R
e R J = o
H vl X B
Hal -5 2
L@
OosxE o @
Hw ke
O i Jro
® =Mt
A SN $ o
* G gt
*» QE O >m
> iKW < w
o B £ 9 | -
€ 6 8 T e

X e p

® - D>
@ kN —
® wasg
@ w0 ED
@<= 8
® ~0
™ un 3
@ A G
=2 0 > o
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Troubleshooting

Your Desktop Publisher has been manufactured to give you years of trouble-free use. In the rare
instance that problems occur, you may find the solution in the table below. If you cannot, do not
attempt to repair the Desktop Publisher yourself. Instead, please contact your local Brother Service
Center. (For a list of Brother Service Centers, refer to the Brother Authorized Service Center booklet that
comes with your Desktop Publisher.)

Problem

Solution

Nothing works after the
Desktop Publisher has
been turned on.

Check that the word processor is plugged into a power source.

Printout is impossible or
difficult to read.

Check that the inkjet cartridge is installed correctly. (Please refer to installing/Re-
placing an cartridge on page 16.)

Check that there is ink in the cartridge.

Press CODE + SHIFT + INK CHG to clean the print head. If printout is still difficult
to read, press CODE + INK CHG. After the print head moves to the left, replace
the inkjet cartridge. Then press RETURN to clean the print head. Repeat this
operation several times if necessary.

Back of paper is stained
with ink.

The main roller is stained. Feed two or three sheets of paper through the printer to
clean the roller.

Ink runs on the paper.

Try printing on the other side of the paper. If this does not solve the problem, try
other types of paper.

White horizontal lines
appear in the printed text.

The printer and the print head on the cartridge are not propetly connected. Remove
and reinsert the cartridge. (See Replacing the Inkjet Cartridge for more informa-
tion.)

Paper jams.

There are two ways to remove jammed paper.

1. Remove the jammed paper manually.
2. Press CODE + SHIFT + CANCEL or CODE + SHIFT + HELP to eject
the papers.

All seems normal after the
word processor has been
turned on, but nothing
appears.

Model DP-550CJ or DP-5040CJ—Adjust the brightness control.

Model DP-780CJ—Adjust the brightness and contrast control. Check that the
signal cable is firmly connected to the monitor.

Disk drive operation is not
possible.

The diskette has been damaged, or a television set ot the monitor is located too
close to the disk drive. Try with another diskette and/or move the word processor.
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Error Messages

Please consult the following table when an error message appears:

Message

Cause

Solution

Check printer! Press
any key to continue.

Malfunction of the
printer mechanism
detected.

Verify that the ink cartridge is firmly installed. Press any key to
erase the message, turn the power off, then on again, and
check to see if the printer moves cotrectly. If the error
message appears again, press any key to erase the message,
turn the power off, then on again, and check whether the
printer moved correctly. If the error message appears again,
consult your local Brother Service Center*.

in your machine’s
Random Access
Memory (RAM).

Incorrect spec! Malfunction at a Turn off the power and consult your local Brother Service
soldering point Center* immediately.
detected.

RAM down! Malifunction detected | Turn the power off and consult your local Brother Service

Center* immediately.

Ink cartridge is not
installed.

The ink cartridge is
not installed on the
machine.

Press CODE + INK CHG and install the ink cartridge. You can
input/edit/save/load the data even if the ink cartridge is not
installed.

*For a list of authorized Brother Service Centers, refer to the Brother Authorized Service Center booklet
that comes with your Desktop Publisher.
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Specifications

Display: LCD (DP-530C]J) 480 x 128 dot
Display: LCD (DP-550C]) 640 X 480 dot
Display: CRT (DP-780C]) 800 x 324 dot

Keyboard: 65 keys

Printer: Built-in colorcolour inkjet printer
Print method: 300 x 300 dpi inkjet printing
Print speed: 160 cps (for regular & fine quality printing)
Paper capacity: 9.5 inches
Print capacity: 8.1 inches
Inkjet Cartridge: Approximately 1,000,000 characters

(inkjet cartridge in regular print mode¥)
Font type (DP-530C)):  Helsinki, Tennessee, Brougham

Font type (DP-550C) & DP-780C)):
Tennessee, Helsinki, Brougham, US, Calgary

Font size (DP-530C)): 10, 12, 14, 18, 36 point

Font size (DP-550C] & DP-780CJ):
10, 12, 14, 18, 36 point

Memory:

Text memory: 70 kb

External memory: 1.44 Mb/720 kb (formatted) 3.5" diskette
Paper Specification:

Cut sheet coated paper: A4, Letter, Legal, Executive

Transparencies A4, Letter

Glossy paper A4, Letter

Envelopes DL, COM-10, C4

Feeder Capacity A4. Letter, Executive — 30 sheets of 20 Ib.

Legal — 1 sheet of 20 Ib.

Transparencies £'1 sheet of 20 Ib.

Glossy Paper - 1 sheet of 20 Ib.
Envelopes (DL, cOM-10) — 5 sheets of 20 Ib.
Envelopes (c4) — 1 sheet of 20 Ib.
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Paper Selection Lever

Front

Back

Paper Capacity in Feeder

Sheet Feeder

Output Stacker

Paper Weight

Print Width

Line Feed Speed

Printing Direction

Monochrome

Color

Printable Area — Paper

Transparencies
Envelopes

Cut Sheet Coated Paper
Glossy Pape

approximately 30 sheets of 20 Ib.
approximately 30 sheets of 20 Ib.
16 to 24 lb.

8.1 inches maximum

2.0 inch/second

1/6 inch line feeds

Bidirectional in text
Unidirectional in Block Graphic Character
Unidirectional in Image

Unidirectional

b

N

\
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Recommended Printable Area - Paper

Letter a = 8.5 inches
b = 0.2 inches
¢ = 11.0 inches
d = 0.5 inches
e = 1.0 inch

Legal a = 8.5 inches
b = 0.2 inches
¢ = 14.0 inches
d = 0.5 inches
e = 1.0 inch

Ad a=210 mm
b=51mm
c =297 mm
d=127 mm

e = 25.4 mm

Possible Printable Area — Paper

Letter a = 8.5 inches
b = 0.2 inches
¢ = 11.0 inches
d = 0.5 inches
e = 0.5 inch

Legal a = 8.5 inches
b = 0.2 inches
¢ = 14.0 inches
d = 0.5 inches
e =0.5 inch

A4 a =210 mm
b =5.08 mm
c =297 mm
d =127 mm

e=12.7 mm
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Printable Area — Envelope

L
b

C

’
,

e L_‘\l

Recommended Printable Area — Envelope
U.S. Commercial Number 10

a = 9.5 inches

b = 0.2 inches
¢ = 1.2 inches
d = 4.1 inches
e =0.5 inch

f =1.0 inch

European DL

a =220 mm

b =5.1mm
c=92mm

d =110 mm

e =12.7 mm
f =254 mm

Possible Printable Area ~ Envelope
~ U.S. Commercial Number 10
a =95 inches
b = 0.2 inches
¢ = 1.2 inches
d = 4.1 inches
e ={0.5 inch
f =05 inch
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European DL

a =220 mm

b=51mm
c=92mm
d =110 mm

e = 12.7 mm
f =127 mm
Resident Printer Control Modes
Epson LQ mode Epson LQ printer emulation
BJ mode IBM Proprinter X24E emulaiton
Cannon Extended Mode

* Estimated by using standard text in 12 point, Brougham font.
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G

lossary

Abbreviated pbrase: A function that allows you to enter phrases you use frequently by typing an abbreviation
rather than the entire phrase.

Absolute address: A spreadsheet cell address specified in a formula that is not updated if you change the
layout of your spreadsheet.

Accelerator keys: The underlined letters on function menus or pull-down menus that can be used as short-cut
keys by pressing the same letter on the keyboard to activate that function on the menu.

Addpress: The position of a spreadsheet cell, designated by its column letter and row number.
Address block: In a letter, the area in which the address of the recipient is shown.
Alpbanumeric data: Data entered into a spreadsheet that cannot be calculated.
Application: A program such as Word Processing, Spreadsheet, or Addressbook.

Argument: The information such as a value or cell address that you must supply when using a math function in
the Spreadsheet application.

ASCII file: A text file consisting of only ASCII codes (all special formatting has been eliminated).

Backup: A copy of your data on a separate diskette that you keep in case your original data and/or diskette is
damaged.

Baud Rate: A measure of the speed of transmission of data—how many times the frequency changes in one
second.

Block: An area of text that you can copy, delete, or move to another part of that document or to another
document in Word Processing, Spreadsheet, or Addressbook programs.

Body block: In a letter, the main body of text.

Bold: Characters that are thicker than normal, or to make characters that are thicker than normal.
Calculator: A program that enables calculations to be made on the screen.

Center tab: A tab used to center text at that tab position.

Cell: The area on a spreadsheet located at the intersection of a row and column where one piece of data is
stored.

Centering: A Word Processing function that centers text between margins.

Change screen: A function used with the dual display mode to change the active file, that is, to move the
cursor between the two files displayed on the screen.

Character keys: Keys that produce a letter or symbol.
Chart symbol: A symbol that indicates that there is a chart beginning from that line.
Clip Board: Memory for temporarily storing data that you want to put at another location.

Column: In Addressbook, a vertical group of information that represents one category, such as names or
addresses. In Spreadsheet, a vertical group of cells extending from the top of the worksheet area to the
bottom that is one cell wide.

Comomand mode: The mode in which you can access the function menu by pressing MENU in the Spreadsheet
program.

Complimentary close line: In a letter, a line containing ending words and phrases such as “Sincerely” or
“Yours truly.” In the Auto Letter Layout program, the complimentary close line must contain more than five
characters (and can contain up to 30) and is followed by a comma and RETURN.
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Conversion: Changing computer data into a form that can be used by a different computer system or program.
The Desktop Publisher allows you to convert a Word Processing file into an ASCII file and vice versa, as

well as a Spreadsheet file into a Lotus® 123® file and vice versa.

Cursor: (1) A small blinking box used to select a position on the screen.
(2) A long illuminated block used to select menu items by highlighting them.

Cursor keys: The four keys with arows on them. When you press a cursor key, the cursor moves in the
direction of the arrow on the key.

Date line: In a letter, a line showing the date of the letter.

Decimal tab: A special tab used to align numbers in a column by their decimal point rather than by the first
character.

Denominator: The bottom half of a fraction or equation.

Direct number: Spreadsheet data consisting of digits and possibly a decimal point that can be used in
calculations.

Disk Drive: The mechanism that writes data to and reads data from diskettes.

Diskettes: A thin, magnetic-coated disk on which computer data can be stored. The Desktop Publisher uses a
3.5-inch diskette.

Double sort: Rearranges data according to two specified conditions.

Dual display: Displaying two files (not necessarily from the same program) on the screen.
Enclosure notation: In a leter, a line containing information about any attachments to the leter.
Entry field: On the Data Input screen in the Addressbook program, each data entry area.

Exponentiation: A notation that indicates the number of times a number is 10 be multiplied by iself. In the
Spreadsheet application, 2:is displayed like 2#3 and means 2 x 2 x 2.

Extension: Characters added to the end of a file name and separated from it by a period. These characters
identify the program that created the file. These extensions contain a period and three letters. Example:
WPT

Extra Character: Forcign language characters, special marks, and common symbols available for use in your
files.

File: The unit in which data is stored on the diskette, for example, a single Word Processing document,
Spreadsheet, or Addressbook file.

Floppy diskette: See Diskettes.

Font: A specific typeface style assigned to the characters. You may use one font or a combination of fonts
within one file. (Tennessee, Helsinki, etc.)

Font Size: The height and width of a character determined by the selected point size (the vertical measurement
of the characters).

Font & Size: Dialog box that allows you to select both the font and the size of the font for typed characters.
Footer: A line of text that prints at the bottom of every page in a document.

Format: The visual arrangement of text on a page, determined by such factors as margin and tab settings,
justification, and centering.

Format cbange symbol: A symbol indicating that there was a format change, such as Justify on/off.
Formatting: See Initializing.

Format mark: Symbols that designate spreadsheet data as alphanumeric data. Format marks can also be used
to place data flush right or flush left in cells.
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Formula: Numeric data entered on a spreadsheet consisting of operators, operands, and parentheses that direct
the system to perform a calculation.

Frame: A set of horizontal and/or vertical lines such as those used in forms and tables.
Function key: A key that initiates a specific operation. The MENU key is an example of a function key.

Function menu bar: A bar that appears across the top of the screen that contains pull-down menu names. You
can access it by pressing MENU.

Grapbhbics: Any non-alpha/numeric image that you add to your document, such as vertical/horizontal lines,
charts, and graphs.

Header: A line of text that prints at the top of every page in Word Processing files.
Help window: A window that shows a list of short-cut keys.

Hypben scan: A Word Processing function that scans your document for lines of text with long blank spaces
caused by the word wrap function.

Identification line: In a letter, the line containing the name of the sender.

Initializing: A process by which the system divides a diskette into sections that organize the storage of your
files. If the diskette contains data, the system will delete it during formatting.

Ink-jet cartridge: An accessory needed to supply ink for printing.
Input area: In the Spreadsheet program, the upper row where the cursor moves when typing in information.

Input/Edit screen: In the Word Processing and Addressbook programs, the screen where you type in
information.

Insert mode: The mode in which you can insert text at the cursor while “pushing” other text further on.
Integer: A whole number (without any fraction or decimal places).

Justify: A Word Processing function used to adjust the spacing in each line of text so that left and right margins
are evenly aligned.

Label: A string of characters that identifies each category of information in an Addressbook file.

Label printing: A method for printing Addressbook records on envelope labels.

Leader tab: A tab used to enter a line of dots from the position where TAB is pressed up to the next tab stop.
Line framing symbol: A symbol indicating that there is a frame beginning on that line.

Line out: A function that quickly erases all characters before the cursor on the current line.

List printing: A method for printing Addressbook records as a list.

Memory: A part of the Desktop Publisher that temporarily stores information. The contents of the memory are
cleared when you turn off the Desktop Publisher.

Merge printing: A function for printing a Word Processing document incorporating Addressbook records (such
as addresses) in desired positions.

Modem: Changes the electronic signals that come through telephone lines into digital signals that your Desktop
Publisher can understand; it also reverses this process and converts the digital signals created by the
Desktop Publisher to analog signals sent through telephone lines.

Non-character key: Keys that do not provide letters or symbols. Non-character keys activate the functions
indicated on their respective key tops.

Normal tab: A tab stop used to left-align text with that tab position.

Numeric data: Data entered in a spreadsheet that can be used in calculations.
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Operand: The data in a spreadsheet formula on which a mathematical operation will be performed. In a
spreadsheet formula, an operand can be a number, address, function, or formula enclosed in parentheses.

Operator: The character in a spreadsheet formula that specifies the mathematical operation to be performed
(+, -, # % and /).

Overwrite mode: The mode in which inserting text at the current cursor position deletes the text at that
position.
Page break symbol: A symbol that ends a page and starts a new page.

Paragraph break: The end of a paragraph formed by pressing RETURN. The paragraph break symbol [.J]
appears.

Parity: The number of bits in a data packet (group of data), which may contain a parity bit for checking errors.
Both sender and receiver must agree to use the same parity.

Permanent bypben: A hyphen to protect words from being separated on two lines. Words with a permanent
hyphen between them are treated as one word.

Permanent space: A space to protect words from being separated on two lines. Words with a permanent
space between them are treated as one word.

Point: The unit used to express the size of characters. 72 points = 1 inch.

Print Preview: A screen illustration that gives you an overall idea of the format layout of your document
before printing..

Prompt: A message or format displayed on the screen that requires a response from the user.
Pull-down menu: A list of functions that appears below the menu name when the menu name is selected.
Recalculation: Redetermines the results of all formulas in a spreadsheet to incorporate new or changed data.

Record: One listing in an Addressbook file, for example, the name, address, and telephone number of one
individual.

Relative address: A spreadsheet cell address that gives the location of a cell in relation to another cell. This
address changes automatically when the layout of the spreadsheet document changes.

Right margin flusb: The text is aligned with the right margin.

Root directory: The original file directory of a tree structured file system. The root directory exists even if the
user does not make any other directories.

Row: On a spreadsheet, a horizontal line of cells that extends from the extreme left of the worksheet area to
the extreme right.

Salutation line: In a letter, the line before the body of the letter, containing a phrase beginning with a greeting
such as “Dear” or “Ladies and Gentlemen.”

Scale: The line at the top of the screen that shows the horizontal position of the cursor as well as the position
of the right and left margins and tab settings.

Scroll: To move quickly through the data entry area when all the data cannot fit on the screen. As old data
disappears from one edge of the screen, new data appears at the opposite edge,

Search: A Word Processing, Spreadsheet, and Addressbook function that finds a specified string of characters.
Select: A Spreadsheet and Addressbook function that lists data that match specified conditions.

Self-demo: A program that shows you examples of Spreadsheet, Word Processing, and Addressbook
documents.

Sbort-cut keys: A combination of keys that activates a function without selecting the function from the
function menus.

Signature block: 1n a letter, an area where the sender signs his or her name.
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Soft bypben: A hyphen entered with CODE + S or inserted with hyphen scan function.

Soft space: A normal space produced by pressing SPACEBAR.

Sort: Reorganizes Spreadsheet or Addressbook data in either alphabetic or numeric order (or reverse order).
Spell check: A function that checks your text for misspelled words and gives a list of possible corrections.

Split size: A function used to adjust the ratio of the displayed portion of files when two are shown on the
screen.

Status line: The area at the top of the screen showing the name of the file you are working on and other
current settings.

Subdirectory: Directories created by the user that appear below a root file directory or other file directories.
Subscript: Characters printed slightly lower than normal characters.

Superscript: Characters printed slightly higher than normal characters.

Symbols: Special characters that can be included in your documents.

Tab: A key that moves the cursor (and text) to the next preset tab stop. Tabs can align text in various ways. For
example, decimal tab aligns numbers by their decimal points.

Text area: In the Word Processing Input/Edit screen, the range over which you can move the cursor and enter
data.

Truncated: In Spreadsheet Importing, information that is deleted when the cell range is exceeded or the file
size is too large.

Tutorial: A program that shows how to use the Word Processing program.
Type style: An atiribute, such as underlining, that is given to your typed text to add effect.

User dictionary: A list of words not in the standard dictionary of Spell Check that are typed in by the user.
The Spell Checker consults this when checking spelling in your document.

Word out: A function that quickly allows you to delete the word immediately before the current cursor
position.

Word wrap: Allows you to type a paragraph without continuously pressing RETURN. When a word goes
beyond the right margin, the word moves to the next line automatically.

Write protection: Protects a diskette from accidental erasure. This is done by setting the write-protection
switch on a diskette in the Read Only position.

Wild card cbaracter: A character included in a character string to represent one or more unknown characters
when searching for a character string. With the Desktop Publisher, “?” is used to represent one unknown
character in a string, and * is used to represent one or more characters.

Worksbeet area: The area in the Spreadsheet program where the data is typed in and manipulated. This area
is divided into cells.
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INDEX

A move, 130

paste from Clip Board, 130, 131

abbreviated phrase, in Spreadsheeat, 122 screen functions
abbreviated phrase data input screen
adding a new phrase, 71 change screen, 140
creating afile, 71 return to view screen, 140, 141
description of, 70 split size, 141
editing afile, 71 view screen
editing a line, 71 change screen, 134
exiting, 73 split size, 134
in Word Processing, 70 screens
loading, 72 data input screen, 128
memory, 70 view screen, 128
printing, 72 aligning
saving, 72 charts, 61
absolute address, 111 headers/footers, 47
accelerator keys, 27 in Spreadsheet
address block, in Auto Letter Layout, 225 left aligned information, 101, 102
Addressbook. 127 right aligned information, 101
description of, 27 right alignment of data, 102
edit functions in Word Processing, 44
select, 133 tables, 54
sort, 133 text, 47
file functions, 129 dligning information, in cells, 92
input functions all off, in Spreadshest, 106
bottom record, 129, 130 all off, in Spreadsheet, 110
new record, 129 alphanumeric information
top record, 129 dsfinition of, 91
jump functions, 139 in Spreadsheet, entering, 91
boftom record, 139 appendix, 245
new record, 139 error messages, 252
search, 140 extra character table, 250
top record, 139 graphic art images, 245
label functions black and white, 246
data input screen color, 248
change label name & width, 140 specifications, 253
delete label, 140 symbol table, 250
insert label, 140 troubleshooting, 251
view screen application, descriptions of, 27
change label name & width, 131, 132 arrow keys, 37
delete label, 131, 132 moving in window, in Word Processing, 36
insert label, 131 ASCII, 218, 219
label settings, 136 attribute color, in Word Processing, 32
labels, 135 Auto Letter Layout, 225
option functions, 140 address block, 225
print functions applying, 227
print, 134, 136 body block, 226
print record on/off, 134 complimentary close, 226
record functions, 130 date line, 225
copy. 130 description of, 27
copy to Clip Board, 130, 131 enclosure notation, 226
delete, 130, 131 identification line, 226
insert, 130, 131 salutation line, 226



signature block, 226
auto lefter iayout, in Word Processing, 70, 77
auto linefeed, 212
auto log-in, in Communication
recording, 217
starting, 217
auto log-in . in Communication, starting, 216
auto log-in (Communication), 208
auto page numbering, 47, 48
auto redial, FAX, sending a, 168

backup copy of diskettes, 144
Black Jack games, 163
block functions
in Spreadsheet, 111
in Word Processing, 59
body block, in Auto Letter, 226
bold
in Spreadsheet, 106, 107
in Word Processing. 32, 51
bofttom record
data input screen, 139
view screen, 129, 130
box, in Drawing, Draw functions, 202
box, drawing a, in Drawing, drawing function, 186, 187
boxes, filled, in Drawing, drawing function, 186, 188
brightness (screen)
adjusting CRT, 9
adjusting LCD, 8

C

caleulation method, in Spreadsheet, 114, 120
caleulations, performing, in Spreadsheet, 93
Calculator, 241
clearing the calculator, 242
entfering information, 241
maximum length of numbers, 242
number lock mode, 241
order of calculation, 242
quitting the calculator, 242
starting the calculator, 241
storing a constant, 242
calculator starting the, in Calculator, 241
cancel key, 25
caps lock mode, 24
card side icon, in Drawing, 200
card sides, in Drawing, greeting card, 201
center tabs, 54
centering
headers/footers, 47
text in Spreadsheet cells, 101, 102
text in Word Processing, 44
with format marks, 92
change screen
in Addressbook
data input screen, 140
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view screen, 134
in Spreadsheet, 122
in Word Processing, 81
character code table, 222
character keys, 24
characters, different, typing, 35
characters, extra
description of, 36
table, 250
charts, examples, 63
circle, in Drawing, draw functions, 202
circle, drawing a. in Drawing, drawing function, 186, 189
circles, filled, in Drawing, drawing function, 186, 190
cleaning
bracket contacts in printer, 20
print head, 19
clearing, a block of cells, 111, 113
clearing information, in Calculator, 242
clip art
black and white, 246
color, 248
Clip Board, 28, 237
copying information to Clip Board, 237
pasting data from Clip Board, 238
close file command, 42
code key, 26
color
changing a block of text, 59, 60
filled circles, in Drawing, 202
frame color, 67
graphic art images, 248
headers/footers, 48
in Drawing, 174
in Word Processing, 51
label name, 50
search color function, 37
with copy/paste, 239
color print, in Word Processing, 83
color printing, in Drawing, 204
column width, in Spreadsheet, 114
command mode, in Spreadsheet, 89
Communication, 207
auto log-in, 208, 216
dialing, 208
file functions, 211
new set up, 211
open file, 211, 214
quif, 211, 215, 221
save file, 211, 214
files, about, 210
modem, 207
opening a file, 209
phone functions, 215
dial, 216
disconnect, 215, 217
receiving, 208
seftting up modem, 208



transfer functions, 218, 221
receive ASCII file, 218, 219
send WP text, 218, 221
transmitting, 208
complimentary close, in Auto Letter Layout, 226
control codes, transmitting, 223
cenversion (on a PC), description of, 29
converting
ASCIl file into Brother Word Processing file, 150
Brother Spreadsheset file into Lotus 123 format, 150
Brother Word Processing file into ASCII file, 149
Brother Word Processing files to PC format, 150
Lotus 123 file into Brother Spreadsheet file, 154
PC text file to Brother Word Processing file, 151
Brother Spreadsheet file into Lotus 123, 1563
copy format, 51, 56

copy object (to Clip Board), in Drawing, editing function,

202
copy to Clip Board, edit functions, in Drawing, 191, 194
copying
a block of records, 130
arange of cells, 111, 112
in Clip Board, 237
from Addressbook o Addressbook, 240 -
from Addressbook to Spreadsheet, 240
from Addressbook to Word Processing, 239
from Spreadsheet fo Addressbook, 240
from Spreadsheet to Spreadsheet, 240
from Spreadsheet to Word Processing, 239
from Word Processing to Addressbook, 240
from Word Processing to Spreadsheet, 240
from Word Processing to Word Processing. 239
one cell to other cells, 111, 112
to Clip Board
from Addressbook, 130, 131
from Spreadshest, 111, 113
copying
a block of text, 59
a graphic, 61, 68
to Clip Board, from Word Processing, 59
create, new file, in Drawing, 171
creating
a 100% stacked bar chart, 61
a bar chart, 61, 62
a letter, 225
aline chart, 61, 62
anew chart, 61
anew file, 31
a pie charat, 63
a stacked bar chart, 61, 62
currency symbol, 106, 108
cursotr moving around window, in Spreadsheet, 89
Cursor key movement, in Drawing, 174, 179, 192
cursor key movement, in Drawing, 173, 175, 193
cursor keys, 24, 25
cursor movement, in Drawing, 200

date line, in Auto Letter Layout, 225
decimal tabs, 54
delete, in Drawing, edit functions, 191, 195
delete all, 148

in Drawing. edif functions, 191, 195
delete objects, in Drawing, editing functions, 202
deletes all objects, in Drawing, editing functions, 202
deleting

a block of records, 130, 131

a block of text, 38, 59, 60

a character, 38

a format change symbol, 51

a graphic, 61, 69

a label

data input screen, 140
view screen, 131, 132

a line of text, 38

aword, 38

data from a chart, 65

in Spreadsheet, 114, 118

lines in a frame, 67, 68

text, 38
Desktop Reference, 231

description of, 27

jumble, 231, 234

return to main menu, 231

user dictionary maintenance, 231, 236

word reference, 231, 232
dialing. in Communication, 216
dialing (Communication)

automatic, 208

description of, being dialed, 208
direct numbers, in Spreadshest, 93
directory read, 148, 149
disconnect (Communication), 215

in Communication, 217
Disk Application, 157

description of, 27

FAX number, 168

FAX, sending q, 166

frame print, 160

printing graphic art, 157
diskettes, 21

backing up, 23

description of, 21

initializing (formatting), 22

inserting, 21

making a backup copy, 144

removing, 21

size and type, 21

write-protecting, 23
*Drawing, delete objects, editing functions, 202
Drawing, 171

box, draw functions, 202

box, drawing a, box function, 184, 187
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boxes, filed, drawing function, 186, 188
card side icon, 200

card sides, greeting card, 201

circle, draw functions, 202

circle, drawing a, circle function, 186, 189
circles, filled, drawing function, 190
colour printing, 197

copy objects (fo Clip Board), editing functions, 202

copy to Clip Board, edit functions, 191, 194
creating new file, 171

delete, edit functions, 191, 195
delete all, edit functions, 191, 195
drawing functions, 186

edit object, editing function, 202
editing in, edit fuctions, 191

file functions, 201

fill box. draw functions, 202

fill circle, draw functions, 202
graphic art, 173

graphic art function, inserted in, 201
images, 173-176

in graphic art, 178

Input/Edit areq, 171

input/edit area, 200

insert, menu functions, 173

layout, 196, 198

layout of card information, print function, 203
line, draw functions, 202

map, making a, 180-188

move object, editing function, 202
moving in, edit functions, 191, 193
objects brought forward, 172, 201
paper type, style function, 196

paste object (from Clip Board), editing functions, 202

print quality, 204

printing, 196

printing card information, printing function, 203

Status line, 171

status line, 200

style function, paper type, 202

text, 173, 175

text function, inserted in, 201
drawing functions, in Drawing, 186

box, 202

circle, 202

fill box, 202

filt circle, 202

line , 202
drawing fools, in Drawing, 172
dual display, 28

edit functions, 44
edit object, in Drawing, editing function, 202
edit thesaurus, in Word Processing, 70, 79
editing

achart, 61, 65
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a frame, 67
color, 67
enlarging/reducing, 67
an abbreviated phrase file, 71
an existing file, 31
edit functions, in Drawing, 191
headers/footers, 47
centering, 47
right margin flush, 47
in Spreadsheet, 101
user dictionary, 76
editing information, in Spreadsheet, 90
enclosure notation, in Auto Letter Layout, 226
enlarging. a frame, 67
entering information
in Calculator, 241
in Spreadsheet, 90
error messages, 252
exiting
a frame, 68
abbreviate phrase, 73
spell check, 73
user dictionary, 77
extra characters
description of, 36
table, 250

F

FAX number, in Disk Application, 168
FAX. sending a
auto redial, 168
in Disk Application, 166
file, in Drawing, 172
menu functions, 172
file copy, 145
file delete, 145, 146
file functions, in Drawing, 201
File Management, 143
convert functions, 149
description of, 27
disk functions, 148
delete all, 148
directory read, 148, 149
initialize disk. 148
initialize diskette, 148
list print, 148, 149
file functions, 145
file copy. 145
file delete, 145, 146
rename, 145, 147
return to main menu, 145, 147
fle management, 38
file name
conventions, 43
extensions, 143, 243
fill in Spreadsheet, 101, 102
fill box, in Drawing, draw functions, 202



fill circle, in Drawing, draw functions, 202
fixed

commas, 106, 108

decimal places, 106, 108
font & size

changing a block of text, 59, 60

headers/footers, 48

in Word Processing. 51
font colot. in Word Processing, 32
footers, 44, 47

auto page numbering, 48

editing, 47

exiting, 48

font & size, 48

margins & tabs, 48

style functions, 48

type style change, 48

format change symbol, deleting, 51
format mark, 91, 92
formulas, 94

order of calculation, 95

text, 110

in Spreadsheet, 106

frame

deleting all lines, 67

enlarging or reducing, 67
frame print, 29
function, in Spreadshest, 96
function keys, 25

in Drawing, 176

function mark on/off, in Word Processing, 81

function menus, 27
accelerator keys, 27
short cut keys, 28

G
games, 29
Black Jack, 163
graphic art
in Drawing, 178
inserted, in Drawing, 173

graphic art function, in Drawing, inserted, 201

graphic art print, 29
graphics
black & white clip art, 246
clip art, 157
color clip art, 248
copying graphics, 61, 68
creating a new chart, 61, 62
deleting graphics, 61, 69
editing charts, 61, 65
line framing, 61
graphics functions, 61
Greeting Card, description of, 27
greeting card
card sides, 201

in Drawing, creating, 199

H
headers, 44, 47
auto page numbering, 48
editing, 47
exiting, 48
font & size, 48
margins & tabs, 48
style functions, 48
type style change, 48
headers and footers, color, 48
Help Menu, using the , 31
help windows, 28
hot zone, hyphenation, 49
hyphen scan, 44, 49
hyphen, types of, 34
normal hyphen, 34
permanent hyphen, 34
soft hyphen, 34
hyphenation hot zone, 49

IBM PC code 850, 155
identification line, in Auto Letter Layout, 226
images, inserted, in Drawing, 173-176
indent

paragraph indent, 35

tab indent, 35
initialize diskette, 148
ink-jet cartridge

description of, 15

installing, 16

replacing, 17
input areq, input/edit window, in Spreadsheet, 89
input area. in Spreadsheet, 89
input/edit

mode, 89

screen, text area (Word Processing), 33
Input/Edit areq, in Drawing, 171
input/edit areq, in Drawing, 200
input/edit screen

in Word Processing, 32

scale (Word Processing), 33
Input/Edit window, in Drawing, 171
input/edit window

in Spreadsheet, worksheet area, 89

Spreadsheet, 89
insert

in Addressbook, 130, 131

in Drawing, menu function, 173

in Spreadsheet, 114, 116
insert label

data input screen, 140

view screen, 131
insert mode, 38
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inserfing text, 38 in Spreadsheet, 96
maximum length of numbers, in Calculator, 242

J menu functions
jumble, in Desktop Reference, 231, 234 # Dr;\:lr;%ln
justify, text in Word Processing, 44, 45 nsort. 173
K in Spreadsheet, 101
menu key, 26
keyboard, 24 merge code, 44, 50
keypad. 25 merge printing
keys in Addressbook, 139
arrow keys, 37 in Word Processing. 84, 86
cancel, 25 modem
character keys. 24 connecting to the system, 10
code, 26 setfting up, 208
cursor keys, 24 monitor
function keys. 25 connecting to the main unit, ¢
letter keys, 24 setting up, 8
menu key, 26 move object, in Drawing, editing function, 202
return key. 25 moving
I- a block of records, 130
a block of text, §9
label settings, in Addressbook, 136 arange of cells, 111
labels edif functions, in Drawing, 191, 193
change name & width, 132, 140 multi-column
change name and width, 131 in Word Processing, 51
change print settings, 138 typing text, 56
changing page setup, 137
in Addressbook. 135 N
merge printing, selecting records, 139 new record
layout data input screen, 139

in Drawing, print function, 196, 198
in Word Processing. 83
previewing a document, 86
layout of card information, in Drawing, printing function,
203
leader tabs, 54
legend (in charts), 62
letter keys, 24
letter layout, parts of the letter, 225
line, Draw functions, In Drawing, 202
line framing, 61, 65

view screen, 129
new set up (Communication), 211
no display, in Spreadsheet, 106
normal hyphen, 34
normal tabs, 54
number lock mode, 25

in Calculator, 241
numeric information

definition of, 91

in Spreadshest, entering, 91

line indent, 54 o
line spacing, in Word Processing, 51
line, drawing a, in Drawing, drawing function, 186 objects brought forward, in Drawing, 172, 201
lines, deleting in a frame, 68 open file command
list print, 148, 149 in Communication, 211, 214
local echo, 212 in Word Processing, 38
open file for dual command, in Word Processing, 38
M order of calculation

in Calculator, 242
in Spreadsheet, 95
overwrite mode, 38

main menu, 26
map, making a, in Drawing, 180-188
margins & tabs

headers/footers, 48 P
in Word Processing, 51

math functions page break, 35
function, 96 page numbering, 47, 48
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page setup Q
in Spreadsheet, 124
in Word Processing, 51. 57 quit
paper, recommended paper quaiity, 12
paper feedet 11

from Calculator 242
frorn Communication, 211, 215, 221

paper type, in Drawing, style function, 196, 202
paragraph break. 35 R
paragraph indent, 35, 54 railroad track, map tool, in Drawing, 180-187
paste from Clip Board, edit functions, in Drawing, 191, 194 range of cells, in Spreadsheet, 96
paste objects (from Clip Board), in Drawing. editing range protect, in Spreadsheet, 114, 119
functions, 202 tecale, in Spreadsheet, 114, 118
pasting receive ASClIfile, 218, 219
from Clip Board, 238 reducing, a frame, 67
info Addressbook, 130, 131 reducing a frams, 67
info Spreadsheet, 111, 113 relative address, 111
in Clip Board rename file, 145, 147
from Addressbook to Addressbook, 240 replace
from Addressbook to Spreadsheet, 240 in Spreadsheet, 101, 102
from Addressbook to Word Processing, 239 in Word Processing. 44, 46
from Spreadsheet to Addressbook. 240 roturn key, 25
from Spreadsheet to Spreadsheet, 240 return to main menu, in File Management, 145, 147
from Spreadshest fo Word Processing, 239 return o view screen, in Addressbook, 141
from Word Processing to Addressbook, 240 right margin flush, in Word Processing, 44
from Word Processing to Spreadsheet, 240 river, map tool, in Drawing, 180-188
from Word Processing to Word Processing, 239 road, map tool, in Drawing, 180
pasting from Clip Board, into Word Processing, 59 Roundabout, map tool, in Drawing, 180-182
percent symbol, 109
in Spreadsheset, 106 s

permanent hyphen, 34
permanent spaces, 35
previewing a document, 86
print, in Drawing, print function, 196
print areq, in Spreadsheet, 123
print frozen fitle, in Spreadsheet, 124
print function
Drawing, printing card information, 203
in Drawing, layout of card information, 203
print head, cleaning, 19
print point, in Spreadsheet, 123
print quality
in Drawing, 204
in Spreadsheet, 124

salutation line, in Auto Letter Layout, 226
save file

in Communication, 211, 214

in Word Processing, 38
scale line on/off, in Word Processing. 81
search

in Addressbook, 140

in Spreadsheet, 101, 102

in Word Pracessing, 44, 45
search color function, 37
select

in Addressbook. 133

in Spreadsheet, 101, 104

in Word Processing, 83 Self Demo, 28
print record on/off. in Addressbook, 134 send WP text, 218, 221
setup, 7

printing
a list, in Addressbook, 136
abbreviated phrase, 72

connecting the equipment (LCD model), 7
connecting to power, 9

all file names on diskette, 148, 149 modem. 10
in Addressbook, 134 monitor stand, 8, 9
shift key, 24

in Spreadsheet, 123, 125
in Word Processing, 83
labels, in Addressbook, 134
merge printing, 86
Printing all file names. on diskette, 148
printing card information. in Drawing, prinfing function, 203

shiff lock mode, 24
short cut keys, 28
signal line control, 212
signature block, in Aufo Lefter Layout, 226
soft hyphen, 34
soft spaces, 34
sort
in Addressbook, 133



in Spreadsheet, 101, 103
spacebar 24
spaces, types of, 34
permanent spaces, 35
soft spaces, 34
special characters, 35
specifications, 2563
spell check
capitalization mistakes, 75
during typing, 70, 75
in Spreadshest, 122
in Word Processing, 70, 73
misspelled words, 73
split size
in Addressbook
data input screen, 141
View screen, 134
in Spreadsheet, 122, 123
in Word Processing, 81, 82
Spreadsheet, 87
absolute address, 111
block functions, 111
clear, 111, 113
copy (arange of cells), 111, 112
copy (one cell fo other cells), 111, 112
copy fo Clip Board, 111, 113
move, 111
paste from Clip Board, 111, 113
command mode, 89
description of, 87
direct numbers, 93
edit functions
center, 101, 102
fil, 101, 102
left alignment, 101, 102
replace, 101, 102
right alignment, 101, 102
search, 101, 102
select, 101, 104
sort, 101, 103
editing information, 90
entering alphanumeric information, 91
entering information, 90
entering numeric information, 91
format marks, 92
formulas, 94
operands, 94
operators, 94
pairs of parentheses, 94
functions, 98
using multiple arguments, 99
using one or two arguments, 98
input area, 89
input/edit mode, 89
input/edit window, status line, 89
math functions, 96
menu functions, 101
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edit, 101
file, 101
option functions, 122
abbreviated phrase maintenance, 122
spell check all, 122
user dictionary maintenance, 122
order of calculation of a formula, 95
performing calculations, 93
print functions, 123
range of cells, 96
relative addresses, 111
screen functions, 122
change screen, 122
split size, 122, 123
setting the print options
page setup, 124
print areq, 123
print frozen title, 124
print point, 123
print quality, 124
sheet functions, 114
calculation method, 114, 120
column width, 114
delete, 114, 118
insert, 114, 116
range protect, 114, 119
recalc, 114, 118
title, 114, 115
worksheet protect, 114, 120
starting, 88
style functions, 106
all off, 106, 110
bold, 106, 107
currency, 106, 108
fixed, 106, 108
formula text, 106, 110
no display, 106
percent, 106, 109
style notes, 106
underline, 106, 107
worksheet areq, 89
starting an application, 27
Status line, in Drawing, 171
status line
in Drawing, 200
in Spreadsheet, 89
in Word Processing, 32
storing a constant, in Calculator, 242
style function, in Drawing, paper type, 202
style functions, in Spreadsheset, 106
style notes, in Spreadsheet, 106
supplemental programs, 29
conversion, 29
frame print, 29
graphic art print, 2¢
tutorial, 29
symbol table, 250



symbols, 35
table, 250

T

tab indent, 35
tabs
center tabs, 54
creating a line indent, 54
creating a paragraph indent, 54
creating a fable, 54
decimal tabs, 54
leader tabs, 54
normal fabs, 54
Template, 243
fle name extensions, 243
opening a femplate file, 243
text
delefing, 38
inserted, in Drawing, 173, 175
inserting, 38
text areq, 33
text function, in Drawing, inserted , 201

Thesaurus, in Word Processing, 80

title, in Spreadsheet, 114, 115
top record

data input screen, 139

view screen, 129
Total Word Count, in Word Processing, 80
troubleshooting, 251
tutorial, 29
type style add, changing a block of text, 59, 60
type style change

changing a block of text, §9, 60

in Word Processing, 51
type thesaurus, in Word Processing, 70, 78
fyping

basic, 34

different characters, 35

in Spreadsheet, 90

text in multi-column pages, 56
typing different characters, 35

underlining. in Spreadshest, 106, 107
user dictionary

adding a word, 76

deleting a word, 76

loading a file, 77

editing, 76

exiting, 77

in Desktop Reference, 231, 236

in Spreadsheet, 122

in Word Processing, 75

saving, 77

user dictionary maintenance, in Word Processing, 70

w

word count, in Word Processing, 79
Word Processing, 31
abbreviated phrase, creating & editing, 71
auto page numbering, 48
block functions, 59
color, 59
copy. 59
copy to Clip Board, 59. 60
delefe, §9, 60
font & size, 59
move, 59
paste from Clip Board, 59, 60
fype style add, 59, 60
type style change, 59, 60
color printing, 83
description of, 27
adit functions
centering, 44
footer, 44, 47
header, 44, 47
hyphen scan. 44, 49
justify, 44, 45
merge code, 44, 50
replace, 44, 46
right margin flush, 44
search, 44, 45
editing a frame
color, 67
delete all, 67
exit, 67, 68
example charts, 63
file functions, 38
close file, 42
file management, 38, 43
open file for dual, 38, 40
save file, 38
file menu, open file, 38
graphics functions, 61
copying a graphic, 61, 68
create new chart, 61
deleting a graphic, 61, 49
deleting data from a chart, 65
edit chart, 61, 65
line framing, 61, 65
input/edit screen, 32
scale, 33
status line, 32
line framing, editing a frame, 67
merge prinfing, 84, 86
option functions, 70
abbreviated phrase maintenance, 70
auto letter layout, 70, 77
check during typing on/off, 70, 75
edit thesaurus, 70, 79
speli check all, 70
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Thesaurus, 80
type thesaurus, 70, 78
user dictionary maintenance, 70, 75
word count, 79
print functions, 83
layout, 83
print, 83
print quality, 83
screen functions, 81
change screen, 81
function mark on/off, 81
scale line on/off, 81
split size, 81, 82
style functions, 51
color, 51
copy format, 51, 56
delete format, 51
font & size, 51
line spacing, 51
margins & tabs, 51
mulfi-column, 51
page setup, 51, 57
type style change, 51
total word count, 80
word reference, in Desktop Reference, 231, 232
word wrap, 34
worksheet, protect, in Spreadshest, 114
worksheet areq, Input/edit screen, in Spreadsheet, 89
worksheet protect, in Spreadsheet, 120

X
X-axis, 62

xon/xoff control, 212

Y

y-axis, 62
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